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Legal Disclaimer
The information in this presentation is confidential and proprietary to SAP SE or an
SAP affiliate company and may not be disclosed without the permission of SAP SE or
the respective SAP affiliate company. This presentation is not subject to your license
agreement or any other service or subscription agreement with SAP SE or its
affiliated companies. SAP SE and its affiliated companies have no obligation to
pursue any course of business outlined in this document or any related presentation,
or to develop or release any functionality mentioned therein. This document, or any
related presentation and SAP SE or an SAP affiliate company’s strategy and possible
future developments, products and or platforms directions and functionality are all
subject to change and may be changed by SAP SE and its affiliated companies at any
time for any reason without notice. The information in this document is not a
commitment, promise or legal obligation to deliver any material, code or
functionality. This document is provided without a warranty of any kind, either
express or implied, including but not limited to, the implied warranties of
merchantability, fitness for a particular purpose, or non-infringement. This document
is for informational purposes and may not be incorporated into a contract. SAP SE
and its affiliated companies assume no responsibility for errors or omissions in this
document, except if such damages were caused by SAP SE or an SAP affiliate
company’s willful misconduct or gross negligence.
All forward-looking statements are subject to various risks and uncertainties that
could cause actual results to differ materially from expectations. Readers are
cautioned not to place undue reliance on these forward-looking statements, which
speak only as of their dates, and they should not be relied upon in making
purchasing decisions.

SAP Concur Release Notes
Release Date: January 22, 2022
Initial Post: Friday, January 21, 2022

Page iii

Expense Professional / Premium
SAP Concur Client FINAL

Release Notes: File Transfer Updates

Release Notes
This document contains the release notes for Concur Expense professional edition.
NOTE: Features and changes that apply to SAP Concur site-wide or to multiple
products/services are documented in the Shared Changes Release Notes. For
information about site-wide or shared changes in this release that might
impact your SAP Concur solutions, refer to the Shared Changes Release
Notes.

File Transfer Updates
**Ongoing** SAP Concur Legacy File Move Migration
This feature is now documented in the Shared Changes Release Notes.



For more information, refer to Shared Planned Changes Moving to New
Shared Changes Release Notes in this document.

Rotating PGP Key Available for File Transfers
This feature is now documented in the Shared Changes Release Notes.



For more information, refer to Shared Planned Changes Moving to New
Shared Changes Release Notes in this document.

Miscellaneous
**Ongoing ** SAP Concur Homepage Changes
This feature is now documented in the Shared Changes Release Notes.



For more information, refer to Shared Planned Changes Moving to New
Shared Changes Release Notes in this document.

Profile Menu Functional Changes Under Fiori Light Theme
This feature is now documented in the Shared Changes Release Notes.



For more information, refer to Shared Planned Changes Moving to New
Shared Changes Release Notes in this document.
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Release Notes: NextGen UI

NextGen UI
**Ongoing** Updated User Interface (UI) for Concur Expense End
Users
Information First Published

Information Last Modified

Automatic Transition Date

March 2018

Sep 17, 2020

Oct 1, 2022

Any changes since the previous monthly release are highlighted in yellow in this release note.

Overview
The continued evolution of the Concur Expense solution user interface experience is
the result of thoughtful design and research that provides a modern, intuitive, and
streamlined experience for creating and submitting expense reports.
Concur Expense customers are now strongly encouraged to preview and then move
to the NextGen UI well before the automatic transition date of October 1, 2022.
BUSINESS PURPOSE / CLIENT BENEFIT
The result is the next generation of the Concur Expense user interface designed to
provide a modern, consistent, and streamlined user experience. This technology not
only provides an enhanced user interface, but also allows us to react more quickly to
customer requests to meet changing needs as they happen.
Products and Users Affected
To take advantage of these improvements, Concur Expense customers who do not
move before October 1, 2022 will be automatically transitioned to the NextGen UI for
Concur Expense. The following provides information about the timeline and resources
available to ensure this process is smooth and efficient for all users.
These UI changes apply to:
•

Concur Expense (Professional/Premium and Standard) end users only
NOTE: There are no changes for approvers, processors, or admins.

IMPORTANT: Timeline and Milestones
There are four important milestones for Concur Expense customers as they transition
from the existing UI to the NextGen UI.
1. Early Access Period: March 2018 – July 2020

During this time, the updated UI was available to preview for customers
worldwide. We encouraged administrators/power users to use the Early
Access Period to preview the refreshed interface, update internal training
materials, and prepare the organization for the transition.
SAP Concur Release Notes
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Release Notes: NextGen UI
2. Opt-In Period: July 2020 – September 2021

Following the Early Access Period was an open Opt-In Period. This milestone
was marked by the delivery of most planned features as well as further
overall product quality and stability.
Customers should use this period to plan their transition and move to the
NextGen UI for Concur Expense when it is right for your business priorities.
Some remaining features will become available throughout this period, so
customers should plan their roll out accordingly.
3. Active Move Period: October 2021 – September 2022

This is the 12-month notice period we committed to for customers to
complete the transition at their own pace before the automatic transition
date.
Customers are strongly encouraged to complete the tasks necessary to
ensure a smooth transition for their organization and then transition during
the Active Move Period.
4. Automatic Transition Date: October 1, 2022

All customers will be automatically transitioned to the NextGen UI.
This ensures that we continue to offer a consistent user experience for all
customers and allows for superior product innovation and support.
Transition Materials – Guides and Other Resources
We offer several guides, FAQs, release notes, and other resources to help in the
transition. All the information that an organization needs to get started is available
here:
•

Professional Edition

•

Standard Edition

The links above provide access to the following:
•

Admin guides, FAQs, transition resources: The admin guide provides
information about accessing the NextGen UI for Concur Expense and the
roles/permissions required.
Along with the admin guide, there are FAQs, other resources (such as e-mail
templates and other training materials), and a list of features that are not yet
available in the NextGen UI for Concur Expense. All of these materials can be
used to help customers prepare their users.
NOTE: To help with training needs, customers can use the admin guide and
end-user guide "as is" or they can use any part of them to create
training materials. Customers can cut, copy, paste, delete, or edit
either guide at will.

•

End-User guide: This guide compares the existing UI to the NextGen UI for
Concur Expense to help users become comfortable with the new experience.
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Release Notes: Receipts
This guide will be updated as needed during the Opt-In Period as the NextGen
UI is being enhanced. Admins should review the guide often.
NOTE: Like the admin guide, the organization can cut, copy, paste, delete, or
edit this guide at will.
•

Release information: During the Active Move Period, the release of
enhancements will not be on the regular release schedule. Instead, we will
provide special release notes and information about features and
enhancements that are nearing release.

Get Started
Customers are encouraged to use the transition materials described above and
develop a plan for the transition.

Receipts
Support for Open Fixed-Layout Document (OFD) Receipt Format
(December 2021)
Overview
The Fapiao Receipt Integration feature was released in the 2021 calendar year. This
feature supports the capture and upload of fapiao to an expense according to
Chinese regulatory and/or government authorities. A fapiao is issued by the State
Taxation Administration of the People's Republic of China but provided by the
merchant.
On December 20th, 2021, support for the Open Fixed-Layout Document (OFD) receipt
file format was released. This format provides support for all legal receipt
requirements including business transactions, employee reimbursement, and VAT
deduction as applicable.
The feature is available to new and existing clients based in China and deployed to
the China datacenter. Other datacenters are not included at this time.



For more information, refer to the State Taxation Administration of the
People's Republic of China.

BUSINESS PURPOSE / CLIENT BENEFIT
This feature supports the ongoing effort to include authorized receipt file formats for
China fapiao.
Configuration / Feature Activation
The feature is automatically available; there are no additional configuration or
activation steps.
SAP Concur Release Notes
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Release Notes: Release Notes



For general information about this functionality, refer to the Fapiao Receipt
Integration for China release note in the January 2021 SAP Concur Release
Notes – Expense Professional / Premium.



For more information, refer to the SAP Concur Fapiao Capture Mobile App
User Guide (English; Chinese) and the Concur Expense: Receipt Handling –
Digital Receipts Setup Guide.

Release Notes
Shared Planned Changes Moving to New Shared Changes Release
Notes
Overview
Beginning with the January 2022 draft release notes, shared (SAP Concur crossproduct) changes, shared planned changes, and changes to SAP Concur core
technologies are published in a new document, Shared Changes Release Notes. This
document replaces the current Shared Planned Changes Release Notes.
Shared and core technology features and changes include, but are not limited to:
•

Security-related changes—for example, annual security certificate renewals,
changes to support for security ciphers, changes in support for security
protocols, and changes to username and password requirements.

•

UI design changes that impact all products—for example, changes to the
functionality or appearance of the SAP Concur home page, the addition or
removal of links from the site header or footer, changes to the user profile.
page, and theme changes that impact the overall look and feel of the SAP
Concur site.

•

Sign-in process changes—for example, the addition or removal of sign-in
features, URL changes, domain-name changes, and changes to verified email.

•

Changes to production or test environments.

•

Changes that impact site-wide settings, changes to global settings, and
changes to pages for configuring site-wide or global settings—for example,
changes to the User Administration page, changes to Product Settings for
Standard Edition, and the introduction of new administration tools.

Previous Process
SAP Concur User Assistance published the Shared Planned Changes Release Notes in
coordination with each monthly release. This document included shared and core
features and changes that SAP Concur plans to implement in the future. When those
changes were officially released, the release or implementation of the change was
distributed and documented in the product-specific release notes—for example, the
Concur Expense, Concur Invoice, Concur Request, or Concur Travel release notes.
SAP Concur Release Notes
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Release Notes: Site Settings
New Process
Beginning in January 2022, the implementation of shared and core features, and
changes to existing shared and core features are now documented in the new Shared
Changes Release Notes. This applies both when the features and changes are
planned changes and when they are officially released. The shared/core release
notes will no longer be distributed to product-specific release notes.
Changes that are specific to one product and that impact that product's functionality
or UI for admins or for end users will continue to be documented in that product's
release notes.
BUSINESS PURPOSE / CLIENT BENEFIT
This change reduces duplication of information, ensures that the product-specific
release notes contain product-specific information, and provides a single source for
SAP Concur shared changes and changes to core technologies.
Configuration / Feature Activation
This process change occurred automatically.



For more information and for information about the implementation of shared
and core features, changes to existing shared and core features, and planned
changes to shared and core features, refer to the SAP Concur Shared
Changes Release Notes.

Site Settings
**Ongoing** Enable Report Number in Concur Expense Accounting
Extracts (March 2022)
Information First Published

Information Last Modified

Feature Target Release Date

November 2021

January 2022

March 2022

Any changes since the previous monthly release are highlighted in yellow in this release note.

Overview
A new site setting, Enable Report Number for Expense Accounting Extracts,
will be available in an upcoming release in Q1 of 2022 for all Concur Expense
accounting extract file types. This setting lets the client elect to extract the Report
Number field data instead of the Report Key field data by changing the extract
output to include one and not the other. This change is reversible and can affect up
to no more than 5 same-type extracts at the client site.
The result of this change is to extract the report number data in preference to the
report key data, benefiting the client by including more meaningful output and
aligning the extract process with future release improvements.
SAP Concur Release Notes
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NOTE: At this time, no change is planned to the Report Key field's availability or
functionality in any way. It is anticipated that this field will eventually be
deprecated, with information and timelines shared with clients late in 2022
after all clients are alerted and prepared.
This functionality supports different accounting extracts, for example:
•

Standard Accounting extract v.2

•

Standard Accounting extract v.3

•

Expense Pay / Employee Reimbursement extract

•

Informational extract

•

Any customized accounting extract that incorporates the Report Key field

BUSINESS PURPOSE / CLIENT BENEFIT
This feature prepares the client who is using accounting extracts for a change to field
availability and supports future feature enhancements for extracts.
Configuration / Feature Activation
The Concur Expense admin role is required to access Site Settings and enable this
functionality.



For more information, refer to the April edition of the SAP Concur Release
Notes Expense Professional / Premium and the Concur Expense: Site Settings
Setup Guide.

Test Entities
Test Entity Data Maintenance and Entity Deletion (Dec 6)
This feature is now documented in the Shared Changes Release Notes.



For more information, refer to Shared Planned Changes Moving to New
Shared Changes Release Notes in this document.

Web Services Admin
**Ongoing** Application Connector Username and Password
Length Req Updated
This feature is now documented in the Shared Changes Release Notes.



For more information, refer to Shared Planned Changes Moving to New
Shared Changes Release Notes in this document.
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Planned Changes: Web Services Admin

Planned Changes
The items in this section are targeted for future releases. SAP Concur reserves the
right to postpone implementation of – or completely remove – any
enhancement/change mentioned here.
NOTE:

The planned changes listed in this document are specific to this product.
For information about planned site-wide or shared changes that might impact
your SAP Concur solutions, refer to the Shared Changes Release Notes.

There are no planned changes this month.
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Client Notifications
Accessibility
Accessibility Updates
SAP implements changes to better meet current Web Content Accessibility Guidelines
(WCAG). Information about accessibility-related changes made to SAP Concur
solutions is published on a quarterly basis. You can review the quarterly updates on
the Accessibility Updates page.

Subprocessors
SAP Concur Non-Affiliated Subprocessors
The list of non-affiliated subprocessors is available here: SAP Concur list of
Subprocessors
If you have questions or comments, please reach out to: PrivacyRequest@Concur.com

Supported Browsers
Supported Browsers and Changes to Support
For information about supported browsers and planned changes to supported
browsers, refer to the Concur Travel & Expense Supported Configurations guide.
When changes to browser support are planned, information about those changes will
also appear in the Shared Changes Release Notes.
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Additional Release Notes and Other Technical Documentation: Online Help

Additional Release Notes and Other Technical
Documentation
Online Help
Any user can access release notes, setup guides, user guides, admin summaries,
monthly browser certifications, supported configurations, and other resources via
online Help or directly on the SAP Help Portal.
Use the links in the Help menu in the app, or search for your SAP Concur product
(Concur Expense, Concur Invoice, Concur Request, or Concur Travel) on the SAP
Help Portal (https://help.sap.com) to view the full set of documentation for your
product.

SAP Concur Support Portal – Selected Users
Access release notes, webinars, and other technical documentation on the SAP
Concur support portal.
If you have the proper permissions, Contact Support appears on the Help menu.
Click to access the SAP Concur support portal, then click Resources.
•

Click Release/Tech Info for release notes, technical documents, etc.

•

Click Webinars for recorded and live webinars.
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Cases: Check Support Case Status

Cases
Check Support Case Status
The steps in this procedure provide instructions for checking whether a case is
resolved.

 To check the status of a submitted case
1. Log on to https://concursolutions.com/portal.asp.
2. Click Help > Contact Support.

NOTE: If you do not have the option to contact SAP Concur support under the Help
menu, then your company has chosen to support the SAP Concur service
internally. Please contact your internal support desk for assistance.
3. Click Support > View Cases.
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Cases: Check Support Case Status
4. In the table, view the desired type of cases based on the View list selection.

Search results are limited to each company's own cases.
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© 2022 SAP SE or an SAP affiliate company. All rights
reserved.
No part of this publication may be reproduced or transmitted in any form or for any
purpose without the express permission of SAP SE or an SAP affiliate company.
SAP and other SAP products and services mentioned herein as well as their
respective logos are trademarks or registered trademarks of SAP SE (or an SAP
affiliate company) in Germany and other countries. Please see
http://global12.sap.com/corporate-en/legal/copyright/index.epx for additional
trademark information and notices.
Some software products marketed by SAP SE and its distributors contain proprietary
software components of other software vendors.
National product specifications may vary.
These materials are provided by SAP SE or an SAP affiliate company for
informational purposes only, without representation or warranty of any kind, and
SAP SE or its affiliated companies shall not be liable for errors or omissions with
respect to the materials. The only warranties for SAP SE or SAP affiliate company
products and services are those that are set forth in the express warranty
statements accompanying such products and services, if any. Nothing herein should
be construed as constituting an additional warranty.
In particular, SAP SE or its affiliated companies have no obligation to pursue any
course of business outlined in this document or any related presentation, or to
develop or release any functionality mentioned therein. This document, or any
related presentation, and SAP SE’s or its affiliated companies’ strategy and possible
future developments, products, and/or platform directions and functionality are all
subject to change and may be changed by SAP SE or its affiliated companies at any
time for any reason without notice. The information in this document is not a
commitment, promise, or legal obligation to deliver any material, code, or
functionality. All forward-looking statements are subject to various risks and
uncertainties that could cause actual results to differ materially from expectations.
Readers are cautioned not to place undue reliance on these forward-looking
statements, which speak only as of their dates, and they should not be relied upon in
making purchasing decisions.
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Legal Disclaimer
The information in this presentation is confidential and proprietary to SAP SE or an
SAP affiliate company and may not be disclosed without the permission of SAP SE or
the respective SAP affiliate company. This presentation is not subject to your license
agreement or any other service or subscription agreement with SAP SE or its
affiliated companies. SAP SE and its affiliated companies have no obligation to
pursue any course of business outlined in this document or any related presentation,
or to develop or release any functionality mentioned therein. This document, or any
related presentation and SAP SE or an SAP affiliate company’s strategy and possible
future developments, products and or platforms directions and functionality are all
subject to change and may be changed by SAP SE and its affiliated companies at any
time for any reason without notice. The information in this document is not a
commitment, promise or legal obligation to deliver any material, code or
functionality. This document is provided without a warranty of any kind, either
express or implied, including but not limited to, the implied warranties of
merchantability, fitness for a particular purpose, or non-infringement. This document
is for informational purposes and may not be incorporated into a contract. SAP SE
and its affiliated companies assume no responsibility for errors or omissions in this
document, except if such damages were caused by SAP SE or an SAP affiliate
company’s willful misconduct or gross negligence.
All forward-looking statements are subject to various risks and uncertainties that
could cause actual results to differ materially from expectations. Readers are
cautioned not to place undue reliance on these forward-looking statements, which
speak only as of their dates, and they should not be relied upon in making
purchasing decisions.
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Release Notes: Cards

Release Notes
This document contains the release notes for Concur Expense professional edition.
NOTE: Features and changes that apply to SAP Concur site-wide or to multiple
products/services are documented in the Shared Changes Release Notes. For
information about site-wide or shared changes in this release that might
impact your SAP Concur solutions, refer to the Shared Changes Release
Notes.

Cards
New Look for Envestnet Yodlee FastLink Personal Card Sign Up
Overview
Clients using Envestnet Yodlee FastLink to link their personal card account from
within any of the Expense service editions will now see a new look when doing so.
Yodlee's FastLink version 4 is now available, and its intuitive user interface will guide
the client through the process of connecting their financial account to their Expense
Profile quickly and securely.
The account linking experience provided by FastLink includes the following features:
•

Ability to search for sites

•

Ability to enter the credentials required to access accounts, including user
name, password, and provide responses to authentication mechanisms such
as security questions and tokens

•

Help messages and tips to assist in entering credentials

•

Success page on completion of site linking

•

Continuous updates to capture any changes in authentication requirements at
the end sites

•

Ability to remove accounts from the linking process

BUSINESS PURPOSE / CLIENT BENEFIT
This feature brings the latest Envestnet Yodlee FastLink version to all Expense
editions, ensuring a quick and easy account linking experience that is secure as well.
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Release Notes: Cards
What the User Sees
The user first opens their Profile to access Expense Credit Cards and the Add a New
Personal Card link that initiates the Yodlee FastLink process (Expense Professional
shown below).

The link opens the Concur Card Data Access User Agreement which, on
acceptance, alerts the user they are leaving the Expense service. With that action,
the first FastLink screen appears.
The user may select a bank, or type in the bank of their choice.
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Release Notes: Cards
Next, the user signs in to their bank.

The offered credentials must be accurate or FastLink will refuse the login while
offering helpful tips for successful retry.
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Release Notes: Cards
On successful login to the bank, the user next logs in to Yodlee.
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Release Notes: Cards
When working within Yodlee the user may choose and exclude accounts as needed
before linking these accounts for viewing from within their Profile screen.

Click Save and Finish to end the session. The user is then redirected to the
Expense Credit Card screen where, after refreshing, the user will see their newly
linked accounts.
Configuration / Feature Activation
The feature is automatically available; there are no additional configuration or
activation steps.
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Release Notes: NextGen UI

NextGen UI
**Ongoing** Updated User Interface (UI) for Concur Expense End
Users
Information First Published

Information Last Modified

Automatic Transition Date

March 2018

Sep 17, 2020

Oct 1, 2022

Any changes since the previous monthly release are highlighted in yellow in this release note.

Overview
The continued evolution of the Concur Expense solution user interface experience is
the result of thoughtful design and research that provides a modern, intuitive, and
streamlined experience for creating and submitting expense reports.
Concur Expense customers are now strongly encouraged to preview and then move
to the NextGen UI well before the automatic transition date of October 1, 2022.
BUSINESS PURPOSE / CLIENT BENEFIT
The result is the next generation of the Concur Expense user interface designed to
provide a modern, consistent, and streamlined user experience. This technology not
only provides an enhanced user interface, but also allows us to react more quickly to
customer requests to meet changing needs as they happen.
Products and Users Affected
To take advantage of these improvements, Concur Expense customers who do not
move before October 1, 2022 will be automatically transitioned to the NextGen UI for
Concur Expense. The following provides information about the timeline and resources
available to ensure this process is smooth and efficient for all users.
These UI changes apply to:
•

Concur Expense (Professional/Premium and Standard) end users only
NOTE: There are no changes for approvers, processors, or admins.

IMPORTANT: Timeline and Milestones
There are four important milestones for Concur Expense customers as they transition
from the existing UI to the NextGen UI.
1. Early Access Period: March 2018 – July 2020

During this time, the updated UI was available to preview for customers
worldwide. We encouraged administrators/power users to use the Early
Access Period to preview the refreshed interface, update internal training
materials, and prepare the organization for the transition.
SAP Concur Release Notes
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2. Opt-In Period: July 2020 – September 2021

Following the Early Access Period was an open Opt-In Period. This milestone
was marked by the delivery of most planned features as well as further
overall product quality and stability.
Customers should use this period to plan their transition and move to the
NextGen UI for Concur Expense when it is right for your business priorities.
Some remaining features will become available throughout this period, so
customers should plan their roll out accordingly.
3. Active Move Period: October 2021 – September 2022

This is the 12-month notice period we committed to for customers to
complete the transition at their own pace before the automatic transition
date.
Customers are strongly encouraged to complete the tasks necessary to
ensure a smooth transition for their organization and then transition during
the Active Move Period.
4. Automatic Transition Date: October 1, 2022

All customers will be automatically transitioned to the NextGen UI.
This ensures that we continue to offer a consistent user experience for all
customers and allows for superior product innovation and support.
Transition Materials – Guides and Other Resources
We offer several guides, FAQs, release notes, and other resources to help in the
transition. All the information that an organization needs to get started is available
here:
•

Professional Edition

•

Standard Edition

The links above provide access to the following:
•

Admin guides, FAQs, transition resources: The admin guide provides
information about accessing the NextGen UI for Concur Expense and the
roles/permissions required.
Along with the admin guide, there are FAQs, other resources (such as e-mail
templates and other training materials), and a list of features that are not yet
available in the NextGen UI for Concur Expense. All of these materials can be
used to help customers prepare their users.
NOTE: To help with training needs, customers can use the admin guide and
end-user guide "as is" or they can use any part of them to create
training materials. Customers can cut, copy, paste, delete, or edit
either guide at will.

•

End-User guide: This guide compares the existing UI to the NextGen UI for
Concur Expense to help users become comfortable with the new experience.
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This guide will be updated as needed during the Opt-In Period as the NextGen
UI is being enhanced. Admins should review the guide often.
NOTE: Like the admin guide, the organization can cut, copy, paste, delete, or
edit this guide at will.
•

Release information: During the Active Move Period, the release of
enhancements will not be on the regular release schedule. Instead, we will
provide special release notes and information about features and
enhancements that are nearing release.

Get Started
Customers are encouraged to use the transition materials described above and
develop a plan for the transition.

Favorites Feature now Available for JPT on NextGen UI
Information First Published

Information Last Modified

Feature Target Release Date

February 2022

--

February 2022

Any changes since the previous monthly release are highlighted in yellow in this release note.

This change is part of the NextGen UI experience.
Overview
The Favorites feature for Japan Public Transport (JPT) on NextGen UI is now
available. JPT on NextGen UI users can create, edit, save, and select a route from
Favorites in Concur Expense. In addition, a Save and Add Another button is
available on an expense report, giving users the ability to add additional expenses.
Japan Public Transport on NextGen UI is the only service that enables users to
expense rail and bus travel in Japan using the NextGen UI. The ability to request and
expense public transport is critical to the Japan market. A typical Japanese citizen
makes multiple journeys per day and, in total, public transport represents 55% of all
expenses in Japan.
BUSINESS PURPOSE / CLIENT BENEFIT
JPT on NextGen UI users now can access the Favorites feature in Concur Expense.
What the User Sees
Users can add a favorite route to use when creating a JPT expense in Concur
Expense.
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ADDING A FAVORITE ROUTE
Users can configure a route they regularly use (for example, from home to work) and
add it to their favorites. When they create a future JPT expense, they can then select
the route from the Favorite Routes tab.
NOTE: Currently, there is no limit to the number of routes you can add to the
Favorite Routes tab.
From the Route Search window, a user can create a route and mark it as a favorite
from the Route Search tab.
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Once the user clicks the star icon, the route is favorited (the star changes from clear
to blue) and added to the Favorite Routes tab.
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NOTE: Users can click the Show Details toggle button to display the favorite route’s
details.

Users can then click the Hide Details toggle button to hide the favorite
route’s details.
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ADDING A JPT EXPENSE FROM A FAVORITE ROUTE
Users can create a JPT expense and select a favorite route (noted by the star icon).

In the expense report, the departure station and arrival station will pre-populate with
the data provided from the favorite route selected.

Users can then save the expense or save the current JPT expense and add another
JPT expense.
SAP Concur Release Notes
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SAVING AND ADDING ANOTHER JPT EXPENSE
Users can save a JPT expense and then add another JPT expense (to the same
expense report) by clicking the Save and Add Another button.

SAP Concur Release Notes
Release Date: February 19, 2022
Initial Post: Friday, February 18, 2022

Page 13

Expense Professional / Premium
SAP Concur Client FINAL
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The JPT expense is saved and the New Expense window opens.

Users can select any expense, but in this case, they select Japan Public
Transportation.
Users can select a route using a route search OR select a favorite route on the
Favorite Routes tab.
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The JPT expense report reflects the newest JPT expense added using the Favorites
Route tab.
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Users can choose (again) whether to save the JPT expense or clicking Save and Add
Another to save another expense to the expense report.
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DELETING A FAVORITE ROUTE FROM THE ROUTE SEARCH
Users can delete a favorite route from the Route Search tab by clicking the star
icon to remove it as a favorite.
NOTE: The favorite route will also be deleted from the Favorite Routes tab.
Deleting a favorite route does NOT affect any previous JPT expenses
submitted using a favorite route.
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DELETING A FAVORITE ROUTE FROM THE FAVORITE ROUTES TAB
Users can delete a favorite route from the Favorite Routes tab by clicking the star
icon to remove it as a favorite.
NOTE: Deleting a favorite route does NOT affect any previous JPT expenses
submitted using a favorite route.

The route is removed and the Favorite Routes list tab is updated.
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ADDING AN EXPENSE FROM A FAVORITE ROUTE FOR THE REQUESTED TRIP DATE AND
TIME
Users can create a JPT expense using the same route, but the route’s date and time
changes based on the date and time traveled. Users can save time by providing
route stations and route search conditions (such as seat type), and then select the
target route. They want to reuse these route search conditions and route (same
departure and arrival stations and lines) to create a new JPT expense.
When providing the date and time, the user may not know the precise time of the
departure or arrival, for example. However, when adding a JPT expense from a
favorite route for the requested trip date and time, Concur Expense will
automatically update the expense report using your favorite route’s adjusted date
and time.
On the Favorite Routes tab, users can configure the trip date and time. In this
example, the user selects the date.
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Once the user selects the date, they then provide an approximate time for when they
think took the favorite route.

The user selects the route from the Favorite Routes tab, with the trip date and
time (they provided) applied.
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On the expense report page, the user can view the route details that have been prepopulated from the route search then click Route Details at the top of the report to
view the selected route’s details.
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If the trip’s departure date and time are different than the favorite route’s date and
time specified by the user, Concur Expense will automatically adjust the time in the
Route Details window. In the previous example, the user had entered a 2:00 a.m.
departure date, but Concur Expense updated the departure time to the correct time
(of 4:55) from the actual route data.

SAP Concur Release Notes
Release Date: February 19, 2022
Initial Post: Friday, February 18, 2022

Page 22

Expense Professional / Premium
SAP Concur Client FINAL

Release Notes: NextGen UI

NOTE: If the favorite route is associated with a commuter pass, you will see
Commuter Pass Deduction for the Pass information.

ADDING A FAVORITE VIA STATION ROUTE
Users can add a favorite via station route using the same method for adding a
favorite route by clicking the star icon.
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Once added, the favorite via station route will be added to the Favorite Routes tab.
You can expand the route by clicking the Show Details button to display the route’s
details, which contains the favorite via station.

ADDING A COMMUTER PASS
From Profile Settings > Commuter Pass Routes, users can add a commuter pass
to their profile that can be applied to a favorite route for a JPT expense.
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NOTE: Users will only be available to store one commuter pass at a time.
Only one commuter pass is allowed in a date period; a user cannot use
multiple commuter passes for the same period. For example, if they use one
route on Monday, Wednesday, and Friday, but use another route on Tuesday
and Thursday, they cannot use separate passes for the two unique routes.

NOTE: If a user tries to add an additional commuter pass (when one is already
stored), they will see this warning:
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NOTE: If a favorite route is added to a commuter pass that is no longer valid, the
user will see this warning:

The user must click Cancel to return to the Favorite Routes window and
click Proceed.
They can then save their expense and remain in Concur Expense or log out.

Configuration / Feature Activation
The feature is automatically available; there are no additional configuration or
activation steps.
NOTE: This feature will only appear for users if the JPT on NextGen UI is activated in
the customer’s environment.



For more information, refer to the Concur Expense: JPT on NextGen UI Setup
Guide for Professional Edition or the Concur Expense: JPT on NextGen UI
Setup Guide for Standard Edition.
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Additional Release for JPT on NextGen UI
Admins can export commuter pass information in Concur Expense.
What the Admin Sees
Admins can export all commuter pass information from Administration >
Company > Tools > Commuter Pass Admin.

On the Commuter Pass Administrator page, an admin clicks the Export All
button to export the commuter pass information to an Excel spreadsheet.

An Excel spreadsheet is downloaded to the admin’s default downloads location and
then opens to show commuter pass information, such as the Employee ID, from and
to station names, and so forth, for all users with a commuter pass.
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EXAMPLE

Site Settings
**Ongoing** Enable Report Number in Concur Expense Accounting
Extracts (March 2022)
Information First Published

Information Last Modified

Feature Target Release Date

November 2021

January 2022

March 2022

Any changes since the previous monthly release are highlighted in yellow in this release note.

Overview
A new site setting, Enable Report Number for Expense Accounting Extracts,
will be available in an upcoming release in Q1 of 2022 for all Concur Expense
accounting extract file types. This setting lets the client elect to extract the Report
Number field data instead of the Report Key field data by changing the extract
output to include one and not the other. This change is reversible and can affect up
to no more than 5 same-type extracts at the client site.
The result of this change is to extract the report number data in preference to the
report key data, benefiting the client by including more meaningful output and
aligning the extract process with future release improvements.
NOTE: At this time, no change is planned to the Report Key field's availability or
functionality in any way. It is anticipated that this field will eventually be
deprecated, with information and timelines shared with clients late in 2022
after all clients are alerted and prepared.
This functionality supports different accounting extracts, for example:
•

Standard Accounting extract v.2

•

Standard Accounting extract v.3
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•

Expense Pay / Employee Reimbursement extract

•

Informational extract

•

Any customized accounting extract that incorporates the Report Key field

BUSINESS PURPOSE / CLIENT BENEFIT
This feature prepares the client who is using accounting extracts for a change to field
availability and supports future feature enhancements for extracts.
Configuration / Feature Activation
The Concur Expense admin role is required to access Site Settings and enable this
functionality.



For more information, refer to the April edition of the SAP Concur Release
Notes Expense Professional / Premium and the Concur Expense: Site Settings
Setup Guide.

Travel Allowance Service
(Poland) Updated Border Crossing Calculation
This change is part of the NextGen UI experience.
Overview
SAP Concur has developed a new strategy for calculating border crossing location for
foreign rate determination. This location determination strategy uses border crossing
times and considers the appropriate time zone. The default border crossing
date/time is adopted from the start or departure date/time at your start or departure
location for outbound legs, and from the arrival or end date/time at your arrival or
end location for inbound legs (coming back to home country).
This configuration is applicable for meals and incidentals.
BUSINESS PURPOSE / CLIENT BENEFIT
This configuration maintains best practices for statutory configuration.
What the Admin Sees
On the View Rate Bundle page, for the rule Location for rate determination,
foreign, a new option Based On Border Crossing Or Arrival Time Modifying
Time Zones First Stop At Departure Location Last Stop At Arrival Location is
displayed for both meals and incidentals.
Configuration / Feature Activation
SAP Concur Release Notes
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The bundle is automatically updated; there are no configuration or activation steps.



For more information, refer to the Concur Expense: Travel Allowance Poland
Statutory Bundle Setup Guide.
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Planned Changes
The items in this section are targeted for future releases. SAP Concur reserves the
right to postpone implementation of – or completely remove – any
enhancement/change mentioned here.
NOTE: The planned changes listed in this document are specific to this product. For
information about planned site-wide or shared changes that might impact
your SAP Concur solutions, refer to the Shared Changes Release Notes.

NextGen UI
**Planned Changes** JPT on NextGen UI Migration for JPT 1.0
Users
Information First Published

Information Last Modified

Feature Target Release Date

February 2022

--

March-April 2022

Any changes since the previous monthly release are highlighted in yellow in this release note.

This change is part of the NextGen UI experience.
Overview
Japan Public Transport (JPT) on NextGen UI is the only service that enables users to
expense rail and bus travel in Japan using the NextGen UI. The ability to request and
expense public transport is critical to the Japan market. A typical Japanese citizen
makes multiple journeys per day and, in total, public transport represents 55% of all
expenses in Japan.
Existing (legacy) JPT 1.0 clients will now be able to transition to JPT on NextGen UI,
the new version of JPT 1.0. Global customers can anticipate migrating to JPT on
NextGen UI in March 2022; the tentative date for Japan clients is April 2022.
BUSINESS PURPOSE / CLIENT BENEFIT
Existing (legacy) JPT 1.0 users will be able to migrate to JPT on NextGen UI to reap
the benefits of the latest version.
Configuration / Feature Activation
Global customers can anticipate migrating to JPT on NextGen UI in March 2022; the
tentative date for Japan clients is April 2022.

!

IMPORTANT! Clients who want to opt-in for the transition to JPT on NextGen UI
must create a change request case. For further assistance, contact SAP Concur
support or your SAP implementation coach.
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For more information on the steps required before and after the migration,
refer to the Concur Expense: Japan Public Transport (JPT) on NextGen UI
Migration Guide for both the Professional and Standard Edition.
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Client Notifications
Accessibility
Accessibility Updates
SAP implements changes to better meet current Web Content Accessibility Guidelines
(WCAG). Information about accessibility-related changes made to SAP Concur
solutions is published on a quarterly basis. You can review the quarterly updates on
the Accessibility Updates page.

Subprocessors
SAP Concur Non-Affiliated Subprocessors
The list of non-affiliated subprocessors is available here: SAP Concur list of
Subprocessors
If you have questions or comments, please reach out to: PrivacyRequest@Concur.com

Supported Browsers
Supported Browsers and Changes to Support
For information about supported browsers and planned changes to supported
browsers, refer to the Concur Travel & Expense Supported Configurations guide.
When changes to browser support are planned, information about those changes will
also appear in the Shared Changes Release Notes.
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Additional Release Notes and Other Technical
Documentation
Online Help
Any user can access release notes, setup guides, user guides, admin summaries,
monthly browser certifications, supported configurations, and other resources via
online Help or directly on the SAP Help Portal.
Use the links in the Help menu in the app, or search for your SAP Concur product
(Concur Expense, Concur Invoice, Concur Request, or Concur Travel) on the SAP
Help Portal (https://help.sap.com) to view the full set of documentation for your
product.

SAP Concur Support Portal – Selected Users
Access release notes, webinars, and other technical documentation on the SAP
Concur support portal.
If you have the proper permissions, Contact Support appears on the Help menu.
Click to access the SAP Concur support portal, then click Resources.
•

Click Release/Tech Info for release notes, technical documents, etc.

•

Click Webinars for recorded and live webinars.
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Cases
Check Support Case Status
The steps in this procedure provide instructions for checking whether a case is
resolved.

 To check the status of a submitted case
1. Log on to https://concursolutions.com/portal.asp.
2. Click Help > Contact Support.

NOTE: If you do not have the option to contact SAP Concur support under the Help
menu, then your company has chosen to support the SAP Concur service
internally. Please contact your internal support desk for assistance.
3. Click Support > View Cases.
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4. In the table, view the desired type of cases based on the View list selection.

Search results are limited to each company's own cases.
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© 2022 SAP SE or an SAP affiliate company. All rights
reserved.
No part of this publication may be reproduced or transmitted in any form or for any
purpose without the express permission of SAP SE or an SAP affiliate company.
SAP and other SAP products and services mentioned herein as well as their
respective logos are trademarks or registered trademarks of SAP SE (or an SAP
affiliate company) in Germany and other countries. Please see
http://global12.sap.com/corporate-en/legal/copyright/index.epx for additional
trademark information and notices.
Some software products marketed by SAP SE and its distributors contain proprietary
software components of other software vendors.
National product specifications may vary.
These materials are provided by SAP SE or an SAP affiliate company for
informational purposes only, without representation or warranty of any kind, and
SAP SE or its affiliated companies shall not be liable for errors or omissions with
respect to the materials. The only warranties for SAP SE or SAP affiliate company
products and services are those that are set forth in the express warranty
statements accompanying such products and services, if any. Nothing herein should
be construed as constituting an additional warranty.
In particular, SAP SE or its affiliated companies have no obligation to pursue any
course of business outlined in this document or any related presentation, or to
develop or release any functionality mentioned therein. This document, or any
related presentation, and SAP SE’s or its affiliated companies’ strategy and possible
future developments, products, and/or platform directions and functionality are all
subject to change and may be changed by SAP SE or its affiliated companies at any
time for any reason without notice. The information in this document is not a
commitment, promise, or legal obligation to deliver any material, code, or
functionality. All forward-looking statements are subject to various risks and
uncertainties that could cause actual results to differ materially from expectations.
Readers are cautioned not to place undue reliance on these forward-looking
statements, which speak only as of their dates, and they should not be relied upon in
making purchasing decisions.
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Legal Disclaimer
The information in this presentation is confidential and proprietary to SAP SE or an
SAP affiliate company and may not be disclosed without the permission of SAP SE or
the respective SAP affiliate company. This presentation is not subject to your license
agreement or any other service or subscription agreement with SAP SE or its
affiliated companies. SAP SE and its affiliated companies have no obligation to
pursue any course of business outlined in this document or any related presentation,
or to develop or release any functionality mentioned therein. This document, or any
related presentation and SAP SE or an SAP affiliate company’s strategy and possible
future developments, products and or platforms directions and functionality are all
subject to change and may be changed by SAP SE and its affiliated companies at any
time for any reason without notice. The information in this document is not a
commitment, promise or legal obligation to deliver any material, code or
functionality. This document is provided without a warranty of any kind, either
express or implied, including but not limited to, the implied warranties of
merchantability, fitness for a particular purpose, or non-infringement. This document
is for informational purposes and may not be incorporated into a contract. SAP SE
and its affiliated companies assume no responsibility for errors or omissions in this
document, except if such damages were caused by SAP SE or an SAP affiliate
company’s willful misconduct or gross negligence.
All forward-looking statements are subject to various risks and uncertainties that
could cause actual results to differ materially from expectations. Readers are
cautioned not to place undue reliance on these forward-looking statements, which
speak only as of their dates, and they should not be relied upon in making
purchasing decisions.
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Release Notes
This document contains the release notes for Concur Expense professional edition.
NOTE: Features and changes that apply to SAP Concur site-wide or to multiple
products/services are documented in the Shared Changes Release Notes. For
information about site-wide or shared changes in this release that might
impact your SAP Concur solutions, refer to the Shared Changes Release
Notes.

Expense Pay – Flex Edition
Bank Account Number for SGD Currency
Overview
To better support SGD (Singapore Dollar) currency now and for the future, the bank
account number field length has increased from a maximum of 11 digits to 14 digits.
BUSINESS PURPOSE / CLIENT BENEFIT
This change supports new beneficiary bank requirements for 12 to 14 digit account
numbers.
What the Admin Sees
When the user enters the bank account number, they can enter up to 14 digits. This
allows them to include a 3 digit branch code with an 11 digit account number in the
Bank Account Number field if required by the payment provider.
NOTE: Some beneficiaries who use OCBC Bank may need to change how they store
their account number. The payment provider or SAP Concur will provide
additional information if your employees are required to change how they
enter their OCBC bank account number in SAP Concur.
NOTE: The employee import record type 820 will now support the new account
number field length of up to 14 characters.
Configuration / Feature Activation
The feature is automatically available; there are no configuration or activation steps.



For general information about this functionality, refer to the Concur Expense:
Expense Pay Flex Edition User Guide for Concur Professional/Premium.
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Mileage
New Mileage Service Features
Information First Published

Information Last Modified

Feature Target Release Date

March 2022

--

March 8, 2022

Any changes since the previous monthly release are highlighted in yellow in this release note.

These changes are part of the NextGen UI experience.
Overview
On March 8, 2022, SAP Concur Expense released functionality and UI updates to
clients using the Mileage Service.

!

IMPORTANT: These changes are available to new Mileage Service clients only.
Mileage Service clients cannot implement a mixture of the original mileage
offering with the new Mileage Service; they must use the new Mileage Service to
reap the benefits described.

These updates provide clients with automatic best practice government mileage
rates, support for mileage-expected expenses, mileage calculator integration with
Concur Request, and improved user interfaces and end-to-end user experience.

!

IMPORTANT: Your company must be using the NextGen UI for Concur Expense
user interface (UI). Because of the mileage calculator integration with Concur
Request, your company must also use the NextGen UI for Concur Request.

BUSINESS PURPOSE / CLIENT BENEFIT
These updates enhance the mileage functionality by providing:
•

Automatic best practice government mileage rates

•

Latest government and company rates available to the clients


For a client paying the government rates, the mileage service will keep
these rates updated. This results in reduced rate administration (on the
client’s part) to maintain and manage the rates – no more manual
updates. As a result, the latest rates are available in real time.



For taxability purposes, the system will record the claimed amount
difference between the amount paid using the client rate versus the
amount based on the government rate.

•

Both Company and Personal car are available as an expected expense into
Request and have a link to mileage calculator.

•

Support for mileage expected expenses and mileage calculator integration
with Concur Request (Concur Expense Professional edition only)
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•

Enhanced regulatory support


Support for all vehicle types and corresponding distance bands

•

Simplified vehicle registration process

•

Improved compliance

•

Additional rates and regional rates support

•

Improved user experience

What the Admin Sees
The Mileage Configuration page (Administration > Expense > Expense Admin
>Mileage Configuration) displays the automated mileage rates for both a personal
and company car. You can also configure custom rates for both a personal car and
company car.
NOTE: Vehicles and modes of transportation listed for a personal car on both the
Automatic Rates tab and Company Car tab differ based on country.
For example, one country may only have one default personal car criteria, but
another country may list multiple modes of transportation for its personal car
criteria. For example, the United States has a flat rate for a personal car, but
Germany lists rates for a motorbike, car, moped, and cycle.
Mileage Configuration
AUTOMATIC RATES
On the Mileage Configuration page, the Automatic Rates tab opens to display
the Personal Car tab by default.
NOTE: Previously, you had to manually change the mileage rate when the
government updated its rates every year. Clients now see the latest statutory
rates (updated by SAP Concur) as often as governments make new rates
available.
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Admins can also view a history of historic rates by clicking Show Historic Rates.
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AUTOMATIC RATES – PERSONAL CAR EXAMPLE (UNITED STATES)

AUTOMATIC RATES – PERSONAL CAR EXAMPLE (UNITED KINGDOM)
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On the Automatic Rates tab, admins can also view the automatic rates for a
company car on the Company Car tab.

CUSTOM RATES
Admins can configure custom rates on the Custom Rates tab. When the Custom
Rates tab is clicked, you are prompted to click OK to turn off automatic rate
updates.
NOTE: You can opt to turn (back) on automatic rate updates by clicking the
Automatic Rates tab.
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On the Custom Rates tab, you can create a new custom rate for a personal car:
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or for a company car:

Once a mileage configuration (for a personal or company car) is added to the
Custom Rates tab, admins can edit or delete the mileage configuration.
MILEAGE (CONFIGURATION) TAB FOR TAXABILITY
The Mileage Configuration page (Administration > Expense > Expense Admin
>Employee Taxability and Corporate Deductibility > Mileage) features the
Mileage tab, which displays the mileage configuration.
The Mileage tab displays the mileage configuration.

Admins can add a new mileage configuration by clicking New to open the Add
Mileage Configuration page.
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NOTE: The ability to add a new mileage configuration requires a Mileage
Configuration in a country supported with Concur-managed Automatic Rates
with higher Custom rates configured.

Once a mileage configuration is added, admins can edit or delete the mileage
configuration.
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What the User Sees
When the user logs in to their entity to report mileage for a new or existing vehicle,
the government rate will be automatically applied when the expense report is
created.
EXAMPLE (UNITED STATES)
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EXAMPLE (UNITED KINGDOM)

Configuration / Feature Activation
The Mileage Service update is deployed automatically ONLY to net new customer
entities being created from March 8, 2022, and onward. The Mileage Service is not
currently available to customers with existing legacy car mileage configurations in
use. This update released on March 8, 2022.



For more information, refer to Concur Expense: Car Configuration Setup
Guide for Professional edition, or the Concur Expense: Mileage Rates Setup
Guide for Standard Edition.
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NextGen UI
**Ongoing** Updated User Interface (UI) for Concur Expense End
Users
Information First Published

Information Last Modified

Automatic Transition Date

March 2018

Sep 17, 2020

Oct 1, 2022

Any changes since the previous monthly release are highlighted in yellow in this release note.

Overview
The continued evolution of the Concur Expense solution user interface experience is
the result of thoughtful design and research that provides a modern, intuitive, and
streamlined experience for creating and submitting expense reports.
Concur Expense customers are now strongly encouraged to preview and then move
to the NextGen UI well before the automatic transition date of October 1, 2022.
BUSINESS PURPOSE / CLIENT BENEFIT
The result is the next generation of the Concur Expense user interface designed to
provide a modern, consistent, and streamlined user experience. This technology not
only provides an enhanced user interface, but also allows us to react more quickly to
customer requests to meet changing needs as they happen.
Products and Users Affected
To take advantage of these improvements, Concur Expense customers who do not
move before October 1, 2022 will be automatically transitioned to the NextGen UI for
Concur Expense. The following provides information about the timeline and resources
available to ensure this process is smooth and efficient for all users.
These UI changes apply to:
•

Concur Expense (Professional/Premium and Standard) end users only
NOTE: There are no changes for approvers, processors, or admins.

IMPORTANT: Timeline and Milestones
There are four important milestones for Concur Expense customers as they transition
from the existing UI to the NextGen UI.
1. Early Access Period: March 2018 – July 2020

During this time, the updated UI was available to preview for customers
worldwide. We encouraged administrators/power users to use the Early
Access Period to preview the refreshed interface, update internal training
materials, and prepare the organization for the transition.
SAP Concur Release Notes
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2. Opt-In Period: July 2020 – September 2021

Following the Early Access Period was an open Opt-In Period. This milestone
was marked by the delivery of most planned features as well as further
overall product quality and stability.
Customers should use this period to plan their transition and move to the
NextGen UI for Concur Expense when it is right for your business priorities.
Some remaining features will become available throughout this period, so
customers should plan their roll out accordingly.
3. Active Move Period: October 2021 – September 2022

This is the 12-month notice period we committed to for customers to
complete the transition at their own pace before the automatic transition
date.
Customers are strongly encouraged to complete the tasks necessary to
ensure a smooth transition for their organization and then transition during
the Active Move Period.
4. Automatic Transition Date: October 1, 2022

All customers will be automatically transitioned to the NextGen UI.
This ensures that we continue to offer a consistent user experience for all
customers and allows for superior product innovation and support.
Transition Materials – Guides and Other Resources
We offer several guides, FAQs, release notes, and other resources to help in the
transition. All the information that an organization needs to get started is available
here:
•

Professional Edition

•

Standard Edition

The links above provide access to the following:
•

Admin guides, FAQs, transition resources: The admin guide provides
information about accessing the NextGen UI for Concur Expense and the
roles/permissions required.
Along with the admin guide, there are FAQs, other resources (such as e-mail
templates and other training materials), and a list of features that are not yet
available in the NextGen UI for Concur Expense. All of these materials can be
used to help customers prepare their users.
NOTE: To help with training needs, customers can use the admin guide and
end-user guide "as is" or they can use any part of them to create
training materials. Customers can cut, copy, paste, delete, or edit
either guide at will.

•

End-User guide: This guide compares the existing UI to the NextGen UI for
Concur Expense to help users become comfortable with the new experience.
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This guide will be updated as needed during the Opt-In Period as the NextGen
UI is being enhanced. Admins should review the guide often.
NOTE: Like the admin guide, the organization can cut, copy, paste, delete, or
edit this guide at will.
•

Release information: During the Active Move Period, the release of
enhancements will not be on the regular release schedule. Instead, we will
provide special release notes and information about features and
enhancements that are nearing release.

Get Started
Customers are encouraged to use the transition materials described above and
develop a plan for the transition.

JPT on NextGen UI Migration for JPT 1.0 Users
Information First Published

Information Last Modified

Feature Target Release Date

March 2022

March 18, 2022

April 2022

Any changes since the previous monthly release are highlighted in yellow in this release note.

This change is part of the NextGen UI experience.
Overview
Japan Public Transport (JPT) on NextGen UI is the only service that enables users to
expense rail and bus travel in Japan using the NextGen UI. The ability to request and
expense public transport is critical to the Japan market. A typical Japanese citizen
makes multiple journeys per day and, in total, public transport represents 55% of all
expenses in Japan.
Existing (legacy) JPT 1.0 clients will now be able to transition to JPT on NextGen UI,
the new version of JPT 1.0. Global clients can anticipate the option to migrate to JPT
on NextGen UI starting in April 2022; the tentative date for Concur Japan clients
starts in April 2022. Clients must plan to transition to both JPT and the NextGen UI
at the same time.
BUSINESS PURPOSE / CLIENT BENEFIT
Existing (legacy) JPT 1.0 users will be able to migrate to JPT on NextGen UI to reap
the benefits of the latest version.
•

A change to Ekispert as the route search engine provider extends the types of
public transportation to include bus stations

•

The expense form has been simplified to remove the dedicated route detail
tabs and use an individual expense per trip that encompasses single or
combined journey legs for overall transit
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•

New commuter pass administrator is added for Standard clients, providing
central administration by the organization in addition to the individual user
access to maintain commuter pass routes

Configuration / Feature Activation
Global clients can anticipate the option to migrate to JPT on NextGen UI starting in
April 2022; the tentative date for Japan clients starts in April 2022.
Clients must plan to activate both the NextGen UI and JPT on the NextGen UI at the
same time.
•

!

JPT on NextGen UI will NOT work for the legacy UI

IMPORTANT! JPT 1.0 (legacy) will NOT work for users on the NextGen UI.
IMPORTANT! During the opt-in period from April 2022 through
September 2022, clients who want to opt-in for the transition to JPT on
NextGen UI must create a change request case. For further assistance,
contact SAP Concur support or your SAP implementation coach.

!



WARNING! If clients do not take any action, they will automatically be moved to
both NextGen UI + JPT on NextGen UI on the mandatory cutover date, October
1, 2022. More information about this cutover date will be provided in a future
release note.
For more information on the steps required before and after the migration,
refer to the Concur Expense: Japan Public Transport (JPT) on NextGen UI
Migration Guide for both the Professional and Standard Edition.

Site Settings
Enable Report Number in Concur Expense Accounting Extracts
Overview
A new site setting, Enable Report Number for Expense Accounting Extracts, is
now available for all Concur Expense accounting extract file types. This change is for
clients using the Report Key value in their expense accounting extracts who would
benefit from extracting the Report Number field data instead.
WHY THIS CHANGE?
The Report Number is a six-character, alpha-numeric value which is intended to be
ERP-friendly and eventually replace the Report Key up to six-digit integer value
which some customers utilize as part of their extract file and financial integration
process. By extracting the report number data in preference to the report key data,
SAP Concur Release Notes
Release Date: March 19, 2022
Initial Post: Friday, March 18, 2022

Page 16

Expense Professional / Premium
SAP Concur Client FINAL

Release Notes: Site Settings
the client will see more meaningful output data and align their extract process with
future release improvements.
The Report Number is displayed to end users in the NextGen user interface for
Concur Expense, so can provide a meaningful tie-back to the user when this
reference is used in downstream processes.
HOW IT WORKS
When this site setting is selected, the Report Number field is positioned in the
same column where Report Key is currently configured, replacing it. Now, report
number data replaces the report key data by changing the extract output to include
one and not the other.
This functionality is fully reversible and applies to several different accounting
extracts, for example:
•

Standard Accounting extract v.2

•

Standard Accounting extract v.3

•

Informational extracts such as the Attendee Detail extract which contain
Report Key and can now inherit the adopted Report Number field

•

Any customized accounting extract that incorporates the Report Key field

Customers who do not use the Report Key value do not need to take any action.
This also includes customers using the newer SAE version 4, which already contains
the preferred functionality of the Report Number field.
NOTE: SAP Concur is currently in the “Opt-in” period to adopt the preferred Report
Number value. At this time, no change is planned to the Report Key field's
availability for Cognos Intelligence reports or Processor UI. All clients will be
alerted and prepared for the post-2022 retirement of the Report Key field.
Notification about retirement plans will be shared with a minimum of 1 year
notice to allow customers to plan financial integration projects within their
organizations.
BUSINESS PURPOSE / CLIENT BENEFIT
This feature prepares the client who is using accounting extracts for a change to field
availability, lets the client control the adoption schedule for the new, preferred
Report Number value without need of a Support ticket to reconfigure the SAE, and
finally supports future feature enhancements for extracts.
Configuration / Feature Activation
The Concur Expense admin role is required to access Site Settings and enable this
functionality. Customers should also confirm with their own organization’s internal IT
Support team that their financial integration posting logic supports the alphanumeric format of the new Report Number value.
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For more information, refer to the April edition of the SAP Concur Release
Notes Expense Professional / Premium and the Concur Expense: Site Settings
Setup Guide.

SAP Concur Release Notes
Release Date: March 19, 2022
Initial Post: Friday, March 18, 2022

Page 18

Expense Professional / Premium
SAP Concur Client FINAL

Planned Changes: Email Notifications

Planned Changes
The items in this section are targeted for future releases. SAP Concur reserves the
right to postpone implementation of – or completely remove – any
enhancement/change mentioned here.
NOTE: The planned changes listed in this document are specific to this product. For
information about planned site-wide or shared changes that might impact
your SAP Concur solutions, refer to the Shared Changes Release Notes.

Email Notifications
**Planned Changes** Update to Expense Report Link in Workflow
Notifications Email
Information First Published

Information Last Modified

Feature Target Release Date

February 2022

--

February 2022

Any changes since the previous monthly release are highlighted in yellow in this release note.

Overview
The URL link to Concur Expense within the workflow email notifications will be
updated to a new format. The new link format will allow any Concur Expense user
who has access to the expense report (via the normal UI path) to click the link to go
directly to that report. The new URL format will also provide improved handling for
Single Sign-On (SSO) configurations and allows customers using SSO (under SAML
2.0) to benefit from this direct link.
BUSINESS PURPOSE / CLIENT BENEFIT
This will allow any user who is viewing the email to also use the link to access the
report IF they have authorization to view that report. The older style link is not
functional for delegates that might receive a copy of the same email.
For customers using SAML 2.0 SSO, this will provide better access and support for
users to go directly to the expense report rather than to the home page.
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What the Approver Sees
When approvers open their workflow email to approve an expense report, they will
see the same information as previously, and click View Report to access and
approve the employee’s expense report directly.

What the User Sees
When users open their workflow email, they will see the same information as
previously, but can now click the link to access their expense report directly.
NOTE: Clients who use the optional URL override functionality will not see any
change to their URL link or functionality, and their users will continue to be
taken to the home page rather than to the specific expense report. SAP
Concur encourages these customers to consider moving to the SAML 2.0 SSO
authentication method and removing the URL override.
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Configuration / Feature Activation
The feature is automatically available; there are no additional configuration or
activation steps.



For more information, refer to the Shared: Single Sign-on Overview Setup
Guide.
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Client Notifications
Accessibility
Accessibility Updates
SAP implements changes to better meet current Web Content Accessibility Guidelines
(WCAG). Information about accessibility-related changes made to SAP Concur
solutions is published on a quarterly basis. You can review the quarterly updates on
the Accessibility Updates page.

Subprocessors
SAP Concur Non-Affiliated Subprocessors
The list of non-affiliated subprocessors is available here: SAP Concur list of
Subprocessors
If you have questions or comments, please reach out to: PrivacyRequest@Concur.com

Supported Browsers
Supported Browsers and Changes to Support
For information about supported browsers and planned changes to supported
browsers, refer to the Concur Travel & Expense Supported Configurations guide.
When changes to browser support are planned, information about those changes will
also appear in the Shared Changes Release Notes.
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Additional Release Notes and Other Technical
Documentation
Online Help
Any user can access release notes, setup guides, user guides, admin summaries,
monthly browser certifications, supported configurations, and other resources via
online Help or directly on the SAP Help Portal.
Use the links in the Help menu in the app, or search for your SAP Concur product
(Concur Expense, Concur Invoice, Concur Request, or Concur Travel) on the SAP
Help Portal (https://help.sap.com) to view the full set of documentation for your
product.

SAP Concur Support Portal – Selected Users
Access release notes, webinars, and other technical documentation on the SAP
Concur support portal.
If you have the proper permissions, Contact Support appears on the Help menu.
Click to access the SAP Concur support portal, then click Resources.
•

Click Release/Tech Info for release notes, technical documents, etc.

•

Click Webinars for recorded and live webinars.
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Cases
Check Support Case Status
The steps in this procedure provide instructions for checking whether a case is
resolved.

 To check the status of a submitted case
1. Log on to https://concursolutions.com/portal.asp.
2. Click Help > Contact Support.

NOTE: If you do not have the option to contact SAP Concur support under the Help
menu, then your company has chosen to support the SAP Concur service
internally. Please contact your internal support desk for assistance.
3. Click Support > View Cases.
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4. In the table, view the desired type of cases based on the View list selection.

Search results are limited to each company's own cases.

SAP Concur Release Notes
Release Date: March 19, 2022
Initial Post: Friday, March 18, 2022

Page 25

Expense Professional / Premium
SAP Concur Client FINAL

© 2022 SAP SE or an SAP affiliate company. All rights
reserved.
No part of this publication may be reproduced or transmitted in any form or for any
purpose without the express permission of SAP SE or an SAP affiliate company.
SAP and other SAP products and services mentioned herein as well as their
respective logos are trademarks or registered trademarks of SAP SE (or an SAP
affiliate company) in Germany and other countries. Please see
http://global12.sap.com/corporate-en/legal/copyright/index.epx for additional
trademark information and notices.
Some software products marketed by SAP SE and its distributors contain proprietary
software components of other software vendors.
National product specifications may vary.
These materials are provided by SAP SE or an SAP affiliate company for
informational purposes only, without representation or warranty of any kind, and
SAP SE or its affiliated companies shall not be liable for errors or omissions with
respect to the materials. The only warranties for SAP SE or SAP affiliate company
products and services are those that are set forth in the express warranty
statements accompanying such products and services, if any. Nothing herein should
be construed as constituting an additional warranty.
In particular, SAP SE or its affiliated companies have no obligation to pursue any
course of business outlined in this document or any related presentation, or to
develop or release any functionality mentioned therein. This document, or any
related presentation, and SAP SE’s or its affiliated companies’ strategy and possible
future developments, products, and/or platform directions and functionality are all
subject to change and may be changed by SAP SE or its affiliated companies at any
time for any reason without notice. The information in this document is not a
commitment, promise, or legal obligation to deliver any material, code, or
functionality. All forward-looking statements are subject to various risks and
uncertainties that could cause actual results to differ materially from expectations.
Readers are cautioned not to place undue reliance on these forward-looking
statements, which speak only as of their dates, and they should not be relied upon in
making purchasing decisions.
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Legal Disclaimer
The information in this presentation is confidential and proprietary to SAP SE or an
SAP affiliate company and may not be disclosed without the permission of SAP SE or
the respective SAP affiliate company. This presentation is not subject to your license
agreement or any other service or subscription agreement with SAP SE or its
affiliated companies. SAP SE and its affiliated companies have no obligation to
pursue any course of business outlined in this document or any related presentation,
or to develop or release any functionality mentioned therein. This document, or any
related presentation and SAP SE or an SAP affiliate company’s strategy and possible
future developments, products and or platforms directions and functionality are all
subject to change and may be changed by SAP SE and its affiliated companies at any
time for any reason without notice. The information in this document is not a
commitment, promise or legal obligation to deliver any material, code or
functionality. This document is provided without a warranty of any kind, either
express or implied, including but not limited to, the implied warranties of
merchantability, fitness for a particular purpose, or non-infringement. This document
is for informational purposes and may not be incorporated into a contract. SAP SE
and its affiliated companies assume no responsibility for errors or omissions in this
document, except if such damages were caused by SAP SE or an SAP affiliate
company’s willful misconduct or gross negligence.
All forward-looking statements are subject to various risks and uncertainties that
could cause actual results to differ materially from expectations. Readers are
cautioned not to place undue reliance on these forward-looking statements, which
speak only as of their dates, and they should not be relied upon in making
purchasing decisions.
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Release Notes
This document contains the release notes for Concur Expense professional edition.
NOTE: Features and changes that apply to SAP Concur site-wide or to multiple
products/services are documented in the Shared Changes Release Notes. For
information about site-wide or shared changes in this release that might
impact your SAP Concur solutions, refer to the Shared Changes Release
Notes.

Audit Service
Policy and Receipt Audit Performance Improvement
Overview
Adjustments are being made to the audit process that will improve service efficiency
and turnaround times.
BUSINESS PURPOSE / CLIENT BENEFIT
Improved audit turnaround times.
What the Admin / Implementation / User Sees
There is no change to the admin or user experience.
Configuration / Feature Activation
The improvement is automatically available; there are no configuration or activation
steps.

Cards
Reauthentication of Linked Cards to Yodlee Required
Overview
With this release, Yodlee has configured their card handling to work with the new
Open Banking standards. This means that users who have linked their noncorporate, personal, or business cards via Yodlee will need to reauthenticate these
cards to ensure that transactions continue to be available within Concur Expense.
Banks will work with Yodlee to adopt the new functionality over time. This means the
card user in Concur Expense must first identify if their card is ready for
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reauthentication before doing so. As of this release, the following cards may now be
reauthenticated:
•

Chase

•

Capital One

•

Schwab

If your card is not on this list, refer to upcoming release notes to determine when
your card issuer is ready, and you may proceed with reauthentication.
BUSINESS PURPOSE / CLIENT BENEFIT
This update is required to ensure continued connectivity between the bank and
Yodlee within Concur Expense, allowing Concur Expense card users to benefit from
Yodlee's adoption of the Open Banking functionality.
What the Admin / Implementation / User Sees
There is no change to the admin or user experience.
Configuration / Feature Activation
The Concur Expense card user who has linked their non-corporate, personal, or
business cards to Yodlee should reauthenticate their cards using the following steps.
1. Open Profile > Profile Settings > Expense Credit Cards.
2. Find the link to your bank.
3. Choose Update Credentials / MFA.
4. Follow the authentication steps required by your bank.

Email Notifications
Update to Expense Report Link in Workflow Notifications Email
Overview
The URL link to Concur Expense within the workflow email notifications is updated to
a new format. The new link format allows any Concur Expense user who has access
to the expense report (via the normal UI path) to click the link to go directly to that
report. The new URL format provides improved handling for Single Sign-On (SSO)
configurations and allows customers using SSO (under SAML 2.0) to benefit from this
direct link.
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BUSINESS PURPOSE / CLIENT BENEFIT
This allows any user who is viewing the email to also use the link to access the
report IF they have authorization to view that report. The older style link is not
functional for delegates that might receive a copy of the same email.
For customers using SAML 2.0 SSO, this will provide better access and support for
users to go directly to the expense report rather than to the home page.
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What the Approver Sees
When approvers open their workflow email to approve an expense report, they will
see the same information as previously, and click View Report to access and
approve the employee’s expense report directly.

What the User Sees
When users open their workflow email, they will see the same information as
previously, but can now click the link to access their expense report directly.
NOTE: Clients who use the optional URL override functionality will not see any
change to their URL link or functionality, and their users will continue to be
taken to the home page rather than to the specific expense report. SAP
Concur encourages these customers to consider moving to the SAML 2.0 SSO
authentication method and removing the URL override.
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Configuration / Feature Activation
The feature is automatically available; there are no additional configuration or
activation steps.



For more information, refer to the Shared: Single Sign-on Overview Setup
Guide.

Expense Pay
Resend Card Batch Remittance File Feature
Overview
With this release, client admins can now resend a card batch remittance/allocation
file to the card company.
Corporate card banks (for example, Citi, Amex, or Bank of America) can request that
remittance/allocation details be re-sent for a received payment. With the new resend
button, the client can do this themselves when needed.
This feature is only available for the card companies listed in the description. It is
available for both Worldline and Convera payment providers when the card program
supports it.
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BUSINESS PURPOSE / CLIENT BENEFIT
This new feature streamlines the process for the client as these requests no longer
need to be completed by SAP Concur solutions.
What the Admin Sees

 To resend remittance/allocation details to a requesting card bank:
1. Go to Payment Manager > Monitor Batches.
2. On the Monitor Batches page, search and open the affected card batch.

3. Click View Batch Data.

NOTE: If the admin receives a message stating no batch data is available, this
indicates there is no separate remittance file for their card program
configuration.
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4. On the Batch Data tab, in the File Name section, click the remittance

transmission link.

NOTE: On the Batch Data tab, the remittance transmission link may appear
on the bottom half of the page, depending on which payment provider
the batch is using.
5. On the File Contents window, click Resend.

NOTE: The Resend button is only available if the card vendor allows it.
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The file has now been resent to the card company and the payment will be allocated
to the card holders' accounts (provided that the third-party payment provider has
completed the payment).
NOTE: Due to the variable timing of when the client sends the funds to the payment
provider and when the card company receives them, the card company may
request the allocation details be resent.
Configuration / Feature Activation
The feature is automatically available; there are no configuration or activation steps.



For general information about this functionality, refer to the Concur Expense:
Payment Manager for Expense Pay Global User Guide.

Japan Public Transport (JPT)
NextGen UI Migration
This change is part of the NextGen UI experience.
Overview
With this release, a new version of JPT is available for use with the NextGen UI.
NOTE: JPT on the current UI is not compatible with the NextGen UI.
BUSINESS PURPOSE / CLIENT BENEFIT
JPT on the NextGen UI provides the following benefits:
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•

A change to Ekispert as the route search engine provider extends the types of
public transportation to include bus stations

•

The expense form has been simplified to remove the dedicated route detail
tabs and use an individual expense per trip that encompasses single or
combined journey legs for overall transit

•

Four new Via fields are also added for commuter pass users who need not
create different passes for different stations. They can now add four stations
between their departure and arrival destinations.

•

For those with existing JPT users who are migrating from the current UI to
NextGen UI, customer admins must modify the audit rules for the expense
rules to work on both JPT in the current UI and JPT in the NextGen UI. In the
NextGen UI, only the event Entry Save is supported. Also, manual entry is
not valid; only IC Card and Route Search are supported in the
Source/Type Classification field.
NOTE: Support for Entry Submit and Report Submit are planned.

Configuration / Feature Activation
To begin using JPT with the NextGen UI, contact SAP Concur support or your SAP
implementation coach to open a change request case. Global clients can anticipate
the option to migrate to JPT on NextGen UI starting in April 2022; the date for Japan
clients begins in May 2022.

! IMPORTANT! Clients must transition to the new version of JPT and to the

NextGen UI at the same time. If clients do not take any action, they will
automatically be moved to the new JPT when they are automatically migrated
to the NextGen UI.



For more information on the steps required before and after the migration,
refer to the Concur Expense: Japan Public Transport (JPT) on NextGen UI
Migration Guide.
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NextGen UI
**Ongoing** Updated User Interface (UI) for Concur Expense End
Users
Information First Published

Information Last Modified

Automatic Transition Date

March 2018

April 23, 2022

Oct 1, 2022

Any changes since the previous monthly release are highlighted in yellow in this release note.

Overview
The continued evolution of the Concur Expense solution user interface experience is
the result of thoughtful design and research that provides a modern, intuitive, and
streamlined experience for creating and submitting expense reports.
Concur Expense customers are now strongly encouraged to preview and then move
to the NextGen UI well before the automatic transition date of October 1, 2022.
BUSINESS PURPOSE / CLIENT BENEFIT
The result is the next generation of the Concur Expense user interface designed to
provide a modern, consistent, and streamlined user experience. This technology not
only provides an enhanced user interface, but also allows us to react more quickly to
customer requests to meet changing needs as they happen.
Products and Users Affected
To take advantage of these improvements, Concur Expense customers who do not
move before October 1, 2022 will be automatically transitioned to the NextGen UI for
Concur Expense. The following provides information about the timeline and resources
available to ensure this process is smooth and efficient for all users.
These UI changes apply to:
•

Concur Expense (Professional/Premium and Standard) end users only
NOTE: There are no changes for approvers, processors, or admins.

IMPORTANT: Timeline and Milestones
There are four important milestones for Concur Expense customers as they transition
from the existing UI to the NextGen UI.
6. Early Access Period: March 2018 – July 2020

During this time, the updated UI was available to preview for customers
worldwide. We encouraged administrators/power users to use the Early
Access Period to preview the refreshed interface, update internal training
materials, and prepare the organization for the transition.
SAP Concur Release Notes
Release Date: April 23, 2022
Initial Post: Friday, April 22, 2022

Page 10

Expense Professional / Premium
SAP Concur Client FINAL

Release Notes: NextGen UI
7. Opt-In Period: July 2020 – September 2021

Following the Early Access Period was an open Opt-In Period. This milestone
was marked by the delivery of most planned features as well as further
overall product quality and stability.
Customers should use this period to plan their transition and move to the
NextGen UI for Concur Expense when it is right for your business priorities.
Some remaining features will become available throughout this period, so
customers should plan their roll out accordingly.
8. Active Move Period: October 2021 – September 2022

This is the 12-month notice period we committed to for customers to
complete the transition at their own pace before the automatic transition
date.
Customers are strongly encouraged to complete the tasks necessary to
ensure a smooth transition for their organization and then transition during
the Active Move Period.
9. Automatic Transition Date: October 1, 2022

All customers will be automatically transitioned to the NextGen UI.
This ensures that we continue to offer a consistent user experience for all
customers and allows for superior product innovation and support.
Transition Materials – Guides and Other Resources
We offer several guides, FAQs, release notes, and other resources to help in the
transition. All the information that an organization needs to get started is available
here:
•

Professional Edition

•

Standard Edition

The links above provide access to the following:
•

Admin guides, FAQs, transition resources: The admin guide provides
information about accessing the NextGen UI for Concur Expense and the
roles/permissions required.
Along with the admin guide, there are FAQs, other resources (such as e-mail
templates and other training materials), and a list of features that are not yet
available in the NextGen UI for Concur Expense. All of these materials can be
used to help customers prepare their users.
NOTE: To help with training needs, customers can use the admin guide and
end-user guide "as is" or they can use any part of them to create
training materials. Customers can cut, copy, paste, delete, or edit
either guide at will.

•

End-User guide: This guide compares the existing UI to the NextGen UI for
Concur Expense to help users become comfortable with the new experience.
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This guide will be updated as needed during the Opt-In Period as the NextGen
UI is being enhanced. Admins should review the guide often.
NOTE: Like the admin guide, the organization can cut, copy, paste, delete, or
edit this guide at will.
•

Release information: During the Active Move Period, the release of
enhancements will not be on the regular release schedule. Instead, we will
provide special information about features and enhancements that are
nearing release.
As of the May 2022 release, release notes for the NextGen UI can be found
within this release note document. The statement These changes are part of
the NextGen UI experience is displayed at the beginning of each NextGen UI
release note.

Get Started
Customers are encouraged to use the transition materials described above and
develop a plan for the transition.
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Planned Changes
The items in this section are targeted for future releases. SAP Concur reserves the
right to postpone implementation of – or completely remove – any
enhancement/change mentioned here.
NOTE: The planned changes listed in this document are specific to this product. For
information about planned site-wide or shared changes that might impact
your SAP Concur solutions, refer to the Shared Changes Release Notes.

There are no planned changes this month.
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Client Notifications
Accessibility
Accessibility Updates
SAP implements changes to better meet current Web Content Accessibility Guidelines
(WCAG). Information about accessibility-related changes made to SAP Concur
solutions is published on a quarterly basis. You can review the quarterly updates on
the Accessibility Updates page.

Subprocessors
SAP Concur Non-Affiliated Subprocessors
The list of non-affiliated subprocessors is available from the SAP Sub-processors /
Data Transfer Factsheets page.

 To access the SAP Concur Sub-processors List:
1. Click the following link to navigate to the SAP Sub-processors / Data Transfer

Factsheets page:
SAP Sub-processors / Data Transfer Factsheets
2. Sign in to the SAP Support Portal using your Support User ID (S-user) and

password.
NOTE: SAP customers must sign in to the SAP Support Portal using their
Support User ID (S-user) and password. For information about S-User
IDs, refer to Your New Support User ID (S-user).
3. On the SAP Sub-processors / Data Transfer Factsheets page, type "Concur" in

the Search field.
4. In the Title column, click SAP Concur Sub-processors List.

If you have questions or comments, please reach out to: PrivacyRequest@Concur.com
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Supported Browsers
Supported Browsers and Changes to Support
For information about supported browsers and planned changes to supported
browsers, refer to the Concur Travel & Expense Supported Configurations guide.
When changes to browser support are planned, information about those changes will
also appear in the Shared Changes Release Notes.
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Additional Release Notes and Other Technical
Documentation
Online Help
Any user can access release notes, setup guides, user guides, admin summaries,
monthly browser certifications, supported configurations, and other resources via
online Help or directly on the SAP Help Portal.
Use the links in the Help menu in the app, or search for your SAP Concur product
(Concur Expense, Concur Invoice, Concur Request, or Concur Travel) on the SAP
Help Portal (https://help.sap.com) to view the full set of documentation for your
product.

SAP Concur Support Portal – Selected Users
Access release notes, webinars, and other technical documentation on the SAP
Concur support portal.
If you have the proper permissions, Contact Support appears on the Help menu.
Click to access the SAP Concur support portal, then click Resources.
•

Click Release/Tech Info for release notes, technical documents, etc.

•

Click Webinars for recorded and live webinars.
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Cases
Check Support Case Status
The steps in this procedure provide instructions for checking whether a case is
resolved.

 To check the status of a submitted case
1. Log on to https://concursolutions.com/portal.asp.
2. Click Help > Contact Support.

NOTE: If you do not have the option to contact SAP Concur support under the Help
menu, then your company has chosen to support the SAP Concur service
internally. Please contact your internal support desk for assistance.
3. Click Support > View Cases.
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4. In the table, view the desired type of cases based on the View list selection.

Search results are limited to each company's own cases.
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© 2022 SAP SE or an SAP affiliate company. All rights
reserved.
No part of this publication may be reproduced or transmitted in any form or for any
purpose without the express permission of SAP SE or an SAP affiliate company.
SAP and other SAP products and services mentioned herein as well as their
respective logos are trademarks or registered trademarks of SAP SE (or an SAP
affiliate company) in Germany and other countries. Please see
http://global12.sap.com/corporate-en/legal/copyright/index.epx for additional
trademark information and notices.
Some software products marketed by SAP SE and its distributors contain proprietary
software components of other software vendors.
National product specifications may vary.
These materials are provided by SAP SE or an SAP affiliate company for
informational purposes only, without representation or warranty of any kind, and
SAP SE or its affiliated companies shall not be liable for errors or omissions with
respect to the materials. The only warranties for SAP SE or SAP affiliate company
products and services are those that are set forth in the express warranty
statements accompanying such products and services, if any. Nothing herein should
be construed as constituting an additional warranty.
In particular, SAP SE or its affiliated companies have no obligation to pursue any
course of business outlined in this document or any related presentation, or to
develop or release any functionality mentioned therein. This document, or any
related presentation, and SAP SE’s or its affiliated companies’ strategy and possible
future developments, products, and/or platform directions and functionality are all
subject to change and may be changed by SAP SE or its affiliated companies at any
time for any reason without notice. The information in this document is not a
commitment, promise, or legal obligation to deliver any material, code, or
functionality. All forward-looking statements are subject to various risks and
uncertainties that could cause actual results to differ materially from expectations.
Readers are cautioned not to place undue reliance on these forward-looking
statements, which speak only as of their dates, and they should not be relied upon in
making purchasing decisions.
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Legal Disclaimer
The information in this presentation is confidential and proprietary to SAP SE or an
SAP affiliate company and may not be disclosed without the permission of SAP SE or
the respective SAP affiliate company. This presentation is not subject to your license
agreement or any other service or subscription agreement with SAP SE or its
affiliated companies. SAP SE and its affiliated companies have no obligation to
pursue any course of business outlined in this document or any related presentation,
or to develop or release any functionality mentioned therein. This document, or any
related presentation and SAP SE or an SAP affiliate company’s strategy and possible
future developments, products and or platforms directions and functionality are all
subject to change and may be changed by SAP SE and its affiliated companies at any
time for any reason without notice. The information in this document is not a
commitment, promise or legal obligation to deliver any material, code or
functionality. This document is provided without a warranty of any kind, either
express or implied, including but not limited to, the implied warranties of
merchantability, fitness for a particular purpose, or non-infringement. This document
is for informational purposes and may not be incorporated into a contract. SAP SE
and its affiliated companies assume no responsibility for errors or omissions in this
document, except if such damages were caused by SAP SE or an SAP affiliate
company’s willful misconduct or gross negligence.
All forward-looking statements are subject to various risks and uncertainties that
could cause actual results to differ materially from expectations. Readers are
cautioned not to place undue reliance on these forward-looking statements, which
speak only as of their dates, and they should not be relied upon in making
purchasing decisions.
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Release Notes
This document contains the release notes for Concur Expense professional edition.
NOTE: Features and changes that apply to SAP Concur site-wide or to multiple
products/services are documented in the Shared Changes Release Notes. For
information about site-wide or shared changes in this release that might
impact your SAP Concur solutions, refer to the Shared Changes Release
Notes.

Cards
Reauthentication of Linked Cards to Yodlee Required
Overview
With this release, Yodlee has configured their card handling to work with the new
Open Banking standards. This means that users who have linked their noncorporate, personal, or business cards via Yodlee will need to reauthenticate these
cards to ensure that transactions continue to be available within Concur Expense.
Banks will work with Yodlee to adopt the new functionality over time. This means the
card user in Concur Expense must first identify if their card is ready for
reauthentication before doing so. As of this release, the following cards may now be
reauthenticated:
•

Bank of America (by June 25th, 2022)

•

Wells Fargo (by June 30th, 2022)

If your card is not on this (or prior) lists, refer to upcoming release notes to
determine when your card issuer is ready, and you may proceed with
reauthentication.
BUSINESS PURPOSE / CLIENT BENEFIT
This update is required to ensure continued connectivity between the bank and
Yodlee within Concur Expense, allowing Concur Expense card users to benefit from
Yodlee's adoption of the Open Banking functionality.
Admin Experience and End-User Experience
There is no change to the admin or user experience.
Configuration / Feature Activation
The Concur Expense card user who has linked their non-corporate, personal, or
business cards to Yodlee should reauthenticate their cards using the following steps.
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1. Open Profile > Profile Settings > Expense Credit Cards.
2. Find the link to your bank.
3. Choose Update Credentials / MFA.
4. Follow the authentication steps required by your bank.

Expense Pay – Flex Edition
Branch Codes and Bank Account Number for SGD Currency
Overview
Previously, when an SGD (Singapore Dollar) payment was sent to the payment
provider, and the beneficiary bank was HSBC or SBI, the branch code was
automatically included with the account number. Organizations contractually
domiciled outside of Singapore have different requirements; when branch codes are
appended, payments do not succeed for these beneficiary banks.
To better support SGD currency payments, SAP Concur will no longer automatically
include the branch code with the account number. SAP Concur will allow manual
entry of the 3-digit branch code before the account number when needed, so that
payments can succeed for all scenarios.
BUSINESS PURPOSE / CLIENT BENEFIT
This change supports successful payments to organizations contractually domiciled
inside or outside Singapore where the branch code prefix is or is not required.
Configuration / Feature Activation
If your organization is contractually domiciled in Singapore and has employees using
one of these specific beneficiary banks (i.e., HSBC, SBI, and OCBC Bank), the
employee must update the SGD bank account to include the branch code prefix. In
SAP Concur, the branch code must now be entered in the Branch Code field and in
the beginning of the Bank Account Number field.
If your organization is contractually domiciled outside of Singapore, the employee
should enter the bank account number without the branch code in SAP Concur.
If you are unsure if this applies to your organization, please reach out to your
payment provider.



For general information about this functionality, refer to the Concur Expense:
Expense Pay Flex Edition User Guide for Concur Professional/Premium.
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NextGen UI
**Ongoing** Updated User Interface (UI) for Concur Expense End
Users
Information First Published

Information Last Modified

Automatic Transition Date

March 2018

April 23, 2022

Oct 1, 2022

Any changes since the previous monthly release are highlighted in yellow in this release note.

Overview
The continued evolution of the Concur Expense solution user interface experience is
the result of thoughtful design and research that provides a modern, intuitive, and
streamlined experience for creating and submitting expense reports.
Concur Expense customers are now strongly encouraged to preview and then move
to the NextGen UI well before the automatic transition date of October 1, 2022.
BUSINESS PURPOSE / CLIENT BENEFIT
The result is the next generation of the Concur Expense user interface designed to
provide a modern, consistent, and streamlined user experience. This technology not
only provides an enhanced user interface, but also allows us to react more quickly to
customer requests to meet changing needs as they happen.
Products and Users Affected
To take advantage of these improvements, Concur Expense customers who do not
move before October 1, 2022 will be automatically transitioned to the NextGen UI for
Concur Expense. The following provides information about the timeline and resources
available to ensure this process is smooth and efficient for all users.
These UI changes apply to:
•

Concur Expense (Professional/Premium and Standard) end users only
NOTE: There are no changes for approvers, processors, or admins.

IMPORTANT: Timeline and Milestones
There are four important milestones for Concur Expense customers as they transition
from the existing UI to the NextGen UI.
1. Early Access Period: March 2018 – July 2020

During this time, the updated UI was available to preview for customers
worldwide. We encouraged administrators/power users to use the Early
Access Period to preview the refreshed interface, update internal training
materials, and prepare the organization for the transition.
SAP Concur Release Notes
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2. Opt-In Period: July 2020 – September 2021

Following the Early Access Period was an open Opt-In Period. This milestone
was marked by the delivery of most planned features as well as further
overall product quality and stability.
Customers should use this period to plan their transition and move to the
NextGen UI for Concur Expense when it is right for your business priorities.
Some remaining features will become available throughout this period, so
customers should plan their roll out accordingly.
3. Active Move Period: October 2021 – September 2022

This is the 12-month notice period we committed to for customers to
complete the transition at their own pace before the automatic transition
date.
Customers are strongly encouraged to complete the tasks necessary to
ensure a smooth transition for their organization and then transition during
the Active Move Period.
4. Automatic Transition Date: October 1, 2022

All customers will be automatically transitioned to the NextGen UI.
This ensures that we continue to offer a consistent user experience for all
customers and allows for superior product innovation and support.
Transition Materials – Guides and Other Resources
We offer several guides, FAQs, release notes, and other resources to help in the
transition. All the information that an organization needs to get started is available
here:
•

Professional Edition

•

Standard Edition

The links above provide access to the following:
•

Admin guides, FAQs, transition resources: The admin guide provides
information about accessing the NextGen UI for Concur Expense and the
roles/permissions required.
Along with the admin guide, there are FAQs, other resources (such as e-mail
templates and other training materials), and a list of features that are not yet
available in the NextGen UI for Concur Expense. All of these materials can be
used to help customers prepare their users.
NOTE: To help with training needs, customers can use the admin guide and
end-user guide "as is" or they can use any part of them to create
training materials. Customers can cut, copy, paste, delete, or edit
either guide at will.

•

End-User guide: This guide compares the existing UI to the NextGen UI for
Concur Expense to help users become comfortable with the new experience.
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Release Notes: Travel Allowance Service
This guide will be updated as needed during the Opt-In Period as the NextGen
UI is being enhanced. Admins should review the guide often.
NOTE: Like the admin guide, the organization can cut, copy, paste, delete, or
edit this guide at will.
•

Release information: During the Active Move Period, the release of
enhancements will not be on the regular release schedule. Instead, we will
provide special information about features and enhancements that are
nearing release.
As of the May 2022 release, release notes for the NextGen UI can be found
within this release note document. The statement These changes are part of
the NextGen UI experience is displayed at the beginning of each NextGen UI
release note.

Get Started
Customers are encouraged to use the transition materials described above and
develop a plan for the transition.

Travel Allowance Service
(Norway) Updated Calculation Rules for Meals and Compensation
Allowance
This change is part of the NextGen UI experience.
Overview
SAP Concur has changed the rule options for the following rate types:
Rate Type

Rule Name

Updated Rule Option

Meals

Deductions

Require deduction time

Compensation Allowance

Several domestic locations in a
domestic reimbursement
interval, foreign

Rate of the last location

BUSINESS PURPOSE / CLIENT BENEFIT
This configuration maintains best practices for statutory configuration.
Admin Experience
This change displays the updated rule options on the View calculation rules of
rate type: "Compensation Allowance" and View calculation rules of rate
type: "Meals" pages. To view the changes in the SAP_CONCUR_NO_STATE and
SAP_CONCUR_NO_TAXFREE statutory bundles, open the View Rate Bundle page,
SAP Concur Release Notes
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and navigate to Rate Types > View > View Rate Types page. Select the required
Meal or Compensation Allowance rate types.
Configuration / Feature Activation
The bundle is automatically updated; there are no configuration or activation steps.



For more information, refer to the Concur Expense: Travel Allowance Norway
Statutory Bundles Setup Guide.
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Planned Changes
The items in this section are targeted for future releases. SAP Concur reserves the
right to postpone implementation of – or completely remove – any
enhancement/change mentioned here.
NOTE: The planned changes listed in this document are specific to this product. For
information about planned site-wide or shared changes that might impact
your SAP Concur solutions, refer to the Shared Changes Release Notes.

Cards
**Planned Changes** AMEX GL1025: New Business Process Date
Replaces Posted Date
Information First Published

Information Last Modified

Feature Target Release Date

May 2022

--

TBD

Any changes since the previous monthly release are highlighted in yellow in this release note.

Overview
SAP Concur will adjust the AMEX GL1025 import in an upcoming release to match
changes by AMEX that will improve the accuracy of the transaction posted date.
WHAT WILL CHANGE IN THE IMPORT?
Currently, the GL1025's file creation date value is mapped to draw its value from the
Transaction Posted Date. Now, AMEX has introduced a new field, Business
Process Date, that is not only more accurate, but also retains its original value even
if the file is recreated. As a result, clients will notice that a more accurate date is
reflected and retained in their imports.
On this update, the File Creation Date field will act as a backup value for Posted
Date if the Business Process Date is absent for any reason.
BUSINESS PURPOSE / CLIENT BENEFIT
This planned change makes the GL1025 import more accurate for the Posted Date
value while ensuring a backup value is always present for the client's use.
Configuration / Feature Activation
The client using the GL1025 import file should consult with their SAP Concur
representative if they have questions or concerns regarding this update.
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Client Notifications
Accessibility
Accessibility Updates
SAP implements changes to better meet current Web Content Accessibility Guidelines
(WCAG). Information about accessibility-related changes made to SAP Concur
solutions is published on a quarterly basis. You can review the quarterly updates on
the Accessibility Updates page.

Subprocessors
SAP Concur Non-Affiliated Subprocessors
The list of non-affiliated subprocessors is available from the SAP Sub-processors /
Data Transfer Factsheets page.

 To access the SAP Concur Sub-processors List:
1. Click the following link to navigate to the SAP Sub-processors / Data Transfer

Factsheets page:
SAP Sub-processors / Data Transfer Factsheets
2. Sign in to the SAP Support Portal using your Support User ID (S-user) and

password.
NOTE: SAP customers must sign in to the SAP Support Portal using their
Support User ID (S-user) and password. For information about S-User
IDs, refer to Your New Support User ID (S-user).
3. On the SAP Sub-processors / Data Transfer Factsheets page, type "Concur" in

the Search field.
4. In the Title column, click SAP Concur Sub-processors List.

If you have questions or comments, please reach out to: PrivacyRequest@Concur.com

Supported Browsers
Supported Browsers and Changes to Support
For information about supported browsers and planned changes to supported
browsers, refer to the Concur Travel & Expense Supported Configurations guide.
SAP Concur Release Notes
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When changes to browser support are planned, information about those changes will
also appear in the Shared Changes Release Notes.
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Additional Release Notes and Other Technical
Documentation
Online Help
Any user can access release notes, setup guides, user guides, admin summaries,
monthly browser certifications, supported configurations, and other resources via
online Help or directly on the SAP Help Portal.
Use the links in the Help menu in the app, or search for your SAP Concur product
(Concur Expense, Concur Invoice, Concur Request, or Concur Travel) on the SAP
Help Portal (https://help.sap.com) to view the full set of documentation for your
product.

SAP Concur Support Portal – Selected Users
Access release notes, webinars, and other technical documentation on the SAP
Concur support portal.
If you have the proper permissions, Contact Support appears on the Help menu.
Click to access the SAP Concur support portal, then click Resources.
•

Click Release/Tech Info for release notes, technical documents, etc.

•

Click Webinars for recorded and live webinars.
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Cases: Check Support Case Status

Cases
Check Support Case Status
The steps in this procedure provide instructions for checking whether a case is
resolved.

 To check the status of a submitted case
1. Log on to https://concursolutions.com/portal.asp.
2. Click Help > Contact Support.

NOTE: If you do not have the option to contact SAP Concur support under the Help
menu, then your company has chosen to support the SAP Concur service
internally. Please contact your internal support desk for assistance.
3. Click Support > View Cases.
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4. In the table, view the desired type of cases based on the View list selection.

Search results are limited to each company's own cases.
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© 2022 SAP SE or an SAP affiliate company. All rights
reserved.
No part of this publication may be reproduced or transmitted in any form or for any
purpose without the express permission of SAP SE or an SAP affiliate company.
SAP and other SAP products and services mentioned herein as well as their
respective logos are trademarks or registered trademarks of SAP SE (or an SAP
affiliate company) in Germany and other countries. Please see
http://global12.sap.com/corporate-en/legal/copyright/index.epx for additional
trademark information and notices.
Some software products marketed by SAP SE and its distributors contain proprietary
software components of other software vendors.
National product specifications may vary.
These materials are provided by SAP SE or an SAP affiliate company for
informational purposes only, without representation or warranty of any kind, and
SAP SE or its affiliated companies shall not be liable for errors or omissions with
respect to the materials. The only warranties for SAP SE or SAP affiliate company
products and services are those that are set forth in the express warranty
statements accompanying such products and services, if any. Nothing herein should
be construed as constituting an additional warranty.
In particular, SAP SE or its affiliated companies have no obligation to pursue any
course of business outlined in this document or any related presentation, or to
develop or release any functionality mentioned therein. This document, or any
related presentation, and SAP SE’s or its affiliated companies’ strategy and possible
future developments, products, and/or platform directions and functionality are all
subject to change and may be changed by SAP SE or its affiliated companies at any
time for any reason without notice. The information in this document is not a
commitment, promise, or legal obligation to deliver any material, code, or
functionality. All forward-looking statements are subject to various risks and
uncertainties that could cause actual results to differ materially from expectations.
Readers are cautioned not to place undue reliance on these forward-looking
statements, which speak only as of their dates, and they should not be relied upon in
making purchasing decisions.
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Legal Disclaimer
The information in this presentation is confidential and proprietary to SAP SE or an
SAP affiliate company and may not be disclosed without the permission of SAP SE or
the respective SAP affiliate company. This presentation is not subject to your license
agreement or any other service or subscription agreement with SAP SE or its
affiliated companies. SAP SE and its affiliated companies have no obligation to
pursue any course of business outlined in this document or any related presentation,
or to develop or release any functionality mentioned therein. This document, or any
related presentation and SAP SE or an SAP affiliate company’s strategy and possible
future developments, products and or platforms directions and functionality are all
subject to change and may be changed by SAP SE and its affiliated companies at any
time for any reason without notice. The information in this document is not a
commitment, promise or legal obligation to deliver any material, code or
functionality. This document is provided without a warranty of any kind, either
express or implied, including but not limited to, the implied warranties of
merchantability, fitness for a particular purpose, or non-infringement. This document
is for informational purposes and may not be incorporated into a contract. SAP SE
and its affiliated companies assume no responsibility for errors or omissions in this
document, except if such damages were caused by SAP SE or an SAP affiliate
company’s willful misconduct or gross negligence.
All forward-looking statements are subject to various risks and uncertainties that
could cause actual results to differ materially from expectations. Readers are
cautioned not to place undue reliance on these forward-looking statements, which
speak only as of their dates, and they should not be relied upon in making
purchasing decisions.
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Release Notes: Amazon Business Integration

Release Notes
This document contains the release notes for Concur Expense professional edition.
NOTE: Features and changes that apply to SAP Concur site-wide or to multiple
products/services are documented in the Shared Changes Release Notes. For
information about site-wide or shared changes in this release that might
impact your SAP Concur solutions, refer to the Shared Changes Release
Notes.

Amazon Business Integration
Disconnection Process
Overview
There are now additional steps to take when disconnecting the Amazon Business
account from Concur Expense. The admin is redirected to the Amazon Business page
to confirm the disconnection from the Amazon Business application, after which the
application will no longer have access to the Concur Expense account. The
transactions before the disconnection process will be unaffected. The admin must
reconnect to Concur Expense to gain access to the Amazon application and its
services.
BUSINESS PURPOSE / CLIENT BENEFIT
This change ensures that the tokens associated with the connection are entirely
removed, and there are no issues while attempting to reconnect to Amazon
Business.
Admin Experience

 To disconnect from Amazon Business
1. On the Amazon Business Integration page, click Disconnect.
2. On the Confirm Disconnect dialog box, click Confirm to disconnect the

Concur Expense account from Amazon Business account.
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3. On the Disconnect from Amazon Business dialog box, click Continue, and

you will be redirected to Amazon Business to complete the disconnection
process from the Amazon Business application.

4. On the Amazon Business page, click Actions > Remove Access.

5. On the Remove Access? dialog box, click Remove. You should initiate the

connection process to gain access again.
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Release Notes: Amazon Business Integration
A confirmation message appears on-screen to confirm that the account access
is removed from the Amazon Business account.

6. Close the confirmation message window to complete the disconnection

process.
Configuration / Feature Activation
This change is automatically available.



For more information, refer to the How to Enable Amazon Business via the
SAP Concur App Center.

Payer Buyer Information
Overview
Concur Expense receives transaction details from Amazon Business with the email
address of the buyer and the payer. The email address should match a user within
Concur Expense to route the transaction details correctly. For this, the email address
should be verified. If the user has not verified their email address, Concur Expense
discards the transaction.
If both the payer’s and buyer’s email addresses are present, Concur Expense uses
the payer’s email address to route the user transaction.
There is an Amazon Business group account for shared payments where all users use
the same payment method for Amazon purchases. In this scenario, the payer’s email
address will always be present and is used to send all the transaction details. The
payer’s email address should be verified with SAP Concur.
BUSINESS PURPOSE / CLIENT BENEFIT
This update is required to ensure that the transaction details are routed to the
payer's email address for shared payment.
Configuration / Feature Activation
This change is automatically available.
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For more information, refer to How to Enable Amazon Business via the SAP
Concur App Center.

Cards
AMEX GL1025: New Business Process Date Replaces Posted Date
Overview
SAP Concur adjusted the AMEX GL1025 import in June to match changes by AMEX
that will improve the accuracy of the transaction posted date.
WHAT WILL CHANGE IN THE IMPORT?
Currently, the GL1025's file creation date value is mapped to draw its value from the
Transaction Posted Date. Now, AMEX has introduced a new field, Business
Process Date, that is not only more accurate, but also retains its original value even
if the file is recreated. As a result, clients will notice that a more accurate date is
reflected and retained in their imports.
The File Creation Date field now acts as a backup value for Posted Date if the
Business Process Date is absent for any reason.
BUSINESS PURPOSE / CLIENT BENEFIT
This change makes the GL1025 import more accurate for the Posted Date value
while ensuring a backup value is always present for the client's use.
Configuration / Feature Activation
The client using the GL1025 import file should consult with their SAP Concur
representative if they have questions or concerns regarding this update.

NextGen UI
**Ongoing** Updated User Interface (UI) for Concur Expense End
Users
Information First Published

Information Last Modified

Automatic Transition Date

March 2018

April 23, 2022

Oct 1, 2022

Any changes since the previous monthly release are highlighted in yellow in this release note.

Overview
The continued evolution of the Concur Expense solution user interface experience is
the result of thoughtful design and research that provides a modern, intuitive, and
streamlined experience for creating and submitting expense reports.
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Concur Expense customers are now strongly encouraged to preview and then move
to the NextGen UI well before the automatic transition date of October 1, 2022.
BUSINESS PURPOSE / CLIENT BENEFIT
The result is the next generation of the Concur Expense user interface designed to
provide a modern, consistent, and streamlined user experience. This technology not
only provides an enhanced user interface, but also allows us to react more quickly to
customer requests to meet changing needs as they happen.
Products and Users Affected
To take advantage of these improvements, Concur Expense customers who do not
move before October 1, 2022 will be automatically transitioned to the NextGen UI for
Concur Expense. The following provides information about the timeline and resources
available to ensure this process is smooth and efficient for all users.
These UI changes apply to:
•

Concur Expense (Professional/Premium and Standard) end users only
NOTE: There are no changes for approvers, processors, or admins.

IMPORTANT: Timeline and Milestones
There are four important milestones for Concur Expense customers as they transition
from the existing UI to the NextGen UI.
1. Early Access Period: March 2018 – July 2020

During this time, the updated UI was available to preview for customers
worldwide. We encouraged administrators/power users to use the Early
Access Period to preview the refreshed interface, update internal training
materials, and prepare the organization for the transition.
2. Opt-In Period: July 2020 – September 2021

Following the Early Access Period was an open Opt-In Period. This milestone
was marked by the delivery of most planned features as well as further
overall product quality and stability.
Customers should use this period to plan their transition and move to the
NextGen UI for Concur Expense when it is right for your business priorities.
Some remaining features will become available throughout this period, so
customers should plan their roll out accordingly.
3. Active Move Period: October 2021 – September 2022

This is the 12-month notice period we committed to for customers to
complete the transition at their own pace before the automatic transition
date.
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Customers are strongly encouraged to complete the tasks necessary to
ensure a smooth transition for their organization and then transition during
the Active Move Period.
4. Automatic Transition Date: October 1, 2022

All customers will be automatically transitioned to the NextGen UI.
This ensures that we continue to offer a consistent user experience for all
customers and allows for superior product innovation and support.
Transition Materials – Guides and Other Resources
We offer several guides, FAQs, release notes, and other resources to help in the
transition. All the information that an organization needs to get started is available
here:
•

Professional Edition

•

Standard Edition

The links above provide access to the following:
•

Admin guides, FAQs, transition resources: The admin guide provides
information about accessing the NextGen UI for Concur Expense and the
roles/permissions required.
Along with the admin guide, there are FAQs, other resources (such as e-mail
templates and other training materials), and a list of features that are not yet
available in the NextGen UI for Concur Expense. All of these materials can be
used to help customers prepare their users.
NOTE: To help with training needs, customers can use the admin guide and
end-user guide "as is" or they can use any part of them to create
training materials. Customers can cut, copy, paste, delete, or edit
either guide at will.

•

End-User guide: This guide compares the existing UI to the NextGen UI for
Concur Expense to help users become comfortable with the new experience.
This guide will be updated as needed during the Opt-In Period as the NextGen
UI is being enhanced. Admins should review the guide often.
NOTE: Like the admin guide, the organization can cut, copy, paste, delete, or
edit this guide at will.

•

Release information: During the Active Move Period, the release of
enhancements will not be on the regular release schedule. Instead, we will
provide special information about features and enhancements that are
nearing release.
As of the May 2022 release, release notes for the NextGen UI can be found
within this release note document. The statement These changes are part of
the NextGen UI experience is displayed at the beginning of each NextGen UI
release note.
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Get Started
Customers are encouraged to use the transition materials described above and
develop a plan for the transition.

Workflow: Cost Object Approver Approval Flow Details
This change is part of the NextGen UI experience.
Overview
With this release, detailed information for all Cost Object Approver steps associated
with an expense report are now shown in the Report Timeline page.

To access this view of the workflow, the user selects Report Details > Report
Timeline. The Report Timeline page appears with details such as the names of the
approvers and the status and dates for each step of the approval flow.
SAP Concur Release Notes
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BUSINESS PURPOSE / CLIENT BENEFIT
This feature provides clear and complete detail of the workflow approval steps for the
expense report.
Configuration / Feature Activation
The feature is automatically available; there are no additional configuration or
activation steps.



For more information, refer to the Concur Expense: Workflow – Cost Object
Approval Setup Guide.

Receipts
Receipt Digitalization (Paper into Digital) (Portugal)
Concur Expense now allows the conversion of paper receipts into digital copies with
probative value for Portugal. Receipt Digitalization provides clients the ability to
conform a paper receipt into a digital copy with the same probative value as the
paper original.
This feature is available to new and existing clients in Portugal and those who have
configurations in Portugal. Additional countries will be included in future releases.
The release for Portugal includes:



•

Offering a solution audited by our IT Law Experts Partners in Portugal (EY)

•

Enabling the conversion of paper receipts into digital copies with probative
value

•

Configuring audit rules that look for expenses with paper receipts

•

Viewing the "Certified" status of the digitized receipt in the NextGen UI for
Concur Expense
For information regarding legislation in Portugal, refer to the Diario de
República Electrónico website.

The Receipt Digitalization feature requires that users must be using the NextGen UI
for Concur Expense. It is required that clients migrate users that will use this feature
to the NextGen UI for Concur Expense before activating this service.
To digitalize original paper receipts, clients must also be using the latest version of
the SAP Concur mobile app and can use ExpenseIt with the mobile app, though
ExpenseIt is not required. The user takes a picture of the paper receipt within the
mobile app. Once the picture is taken, the digitalization process will be applied to the
image. Once the process is complete, a stamp displays on the digitalized receipt in
the mobile app confirming whether the receipt is certified or not.

SAP Concur Release Notes
Release Date: June 18, 2022
Initial Post: June 17, 2022

Page 8

Expense Professional / Premium
Client FINAL

Release Notes: Receipts

NOTE: Digitalized copies of original paper receipts can be captured with the SAP
Concur mobile app using Quick Expense, creating an expense report entry, or
ExpenseIt. The ability to digitalize a paper receipt captured at the report
header level is not yet available.
Digitalized receipts display for users in the NextGen UI in Available Expenses,
Available Receipts, and in the expense list, like any other receipt.
Approvers and processors will view the "Certified" receipt status in the expense
report and expense list in the existing version of Concur Expense. Audit rules can be
created that identify digitalized receipts on the expense line item. A new icon
displays for receipts that are digitalized.
E-Archiving Guidelines
Clients who want to go paperless with digitalized receipts in Portugal must also have
an e-archival process in place that complies with the local legislation. Having a
defined e-archiving process is a best practice for SAP Integration with Concur
Solutions (SAP ICS) for ERP integration and ensures compliance with the e-archiving
rules established by Portuguese authorities.
Non-SAP ERP clients can use this best practice process as a guide but will need to
adapt it to their specific ERP or e-archiving solutions. Clients that activate the receipt
digitalization process and follow the e-archiving best practices will be fully compliant
and can go paperless.



For more information, refer to the Expense: Receipt Handling – Digital
Receipts Setup Guide.

BUSINESS PURPOSE / CLIENT BENEFIT
This feature provides a paperless receipt option that adheres to requirements and
regulations in Portugal for paper into digital tax receipt processing.
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Configuration / Feature Activation
On the Group Configurations page, in the Digital Compliance Country Rule list,
admins need to select Spain to enable this feature for Portugal.

 To configure a group to use Receipt Digitalization:
1. On the Group Configurations page, select New. The Select Group window

appears.
NOTE: If you do not define a group, then it will inherit from the next level
that is defined. You always inherit the policy for undefined groups.
2. In the Select Group box, select the desired group.
3. Click Done. The Configuration for Group window appears.

4. On the Configuration for Group page, in the Group Name field, type in a

name for the group.
5. In the Digital Compliance Country Rule list, select Spain to enable this

feature for Portugal.
6. Click Save.
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For general information regarding Group Configuration settings, refer to the
Concur Expense: Group Configurations for Expense Setup Guide.



For more information, refer to the Concur Expense: Receipt Handling – Digital
Receipts Setup Guide.

Travel Allowance Service
Rate Calculation for Multiple Trips in One Day
This change is part of the NextGen UI experience.
Overview
Concur Expense supports a new option for rate calculation for multiple trips held in
one day. The business trip with the longest duration can be considered for
reimbursement during multiple trips in one day. You can now customize the
Configurable bundle to use this feature for rate calculation.
BUSINESS PURPOSE / CLIENT BENEFIT
This feature enhances the flexibility of configurable bundles.
Admin Experience
The admin sees the addition of a new rule option Use rate of itinerary with
longest duration for the rule Several itineraries in one day, reimbursement
rates. This rule is available on the View calculation rules of rate types pages.
Configuration / Feature Activation
The feature is automatically available; there are no additional configuration or
activation steps.



For general information about this functionality, refer to the Concur Expense:
Travel Allowance Generic Configurable Bundle Setup Guide.
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Planned Changes: There are no planned changes this month.

Planned Changes
The items in this section are targeted for future releases. SAP Concur reserves the
right to postpone implementation of – or completely remove – any
enhancement/change mentioned here.
NOTE: The planned changes listed in this document are specific to this product. For
information about planned site-wide or shared changes that might impact
your SAP Concur solutions, refer to the Shared Changes Release Notes.

There are no planned changes this month.
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Client Notifications
Accessibility
Accessibility Updates
SAP implements changes to better meet current Web Content Accessibility Guidelines
(WCAG). Information about accessibility-related changes made to SAP Concur
solutions is published on a quarterly basis. You can review the quarterly updates on
the Accessibility Updates page.

Subprocessors
SAP Concur Non-Affiliated Subprocessors
The list of non-affiliated subprocessors is available from the SAP Sub-processors /
Data Transfer Factsheets page.

 To access the SAP Concur Sub-processors List:
1. Click the following link to navigate to the SAP Sub-processors / Data Transfer

Factsheets page:
SAP Sub-processors / Data Transfer Factsheets
2. Sign in to the SAP Support Portal using your Support User ID (S-user) and

password.
NOTE: SAP customers must sign in to the SAP Support Portal using their
Support User ID (S-user) and password. For information about S-User
IDs, refer to Your New Support User ID (S-user).
3. On the SAP Sub-processors / Data Transfer Factsheets page, type "Concur" in

the Search field.
4. In the Title column, click SAP Concur Sub-processors List.

If you have questions or comments, please reach out to: PrivacyRequest@Concur.com

Supported Browsers
Supported Browsers and Changes to Support
For information about supported browsers and planned changes to supported
browsers, refer to the Concur Travel & Expense Supported Configurations guide.
SAP Concur Release Notes
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Client Notifications: Supported Browsers
When changes to browser support are planned, information about those changes will
also appear in the Shared Changes Release Notes.
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Additional Release Notes and Other Technical Documentation: Online Help

Additional Release Notes and Other Technical
Documentation
Online Help
Any user can access release notes, setup guides, user guides, admin summaries,
monthly browser certifications, supported configurations, and other resources via
online Help or directly on the SAP Help Portal.
Use the links in the Help menu in the app, or search for your SAP Concur product
(Concur Expense, Concur Invoice, Concur Request, or Concur Travel) on the SAP
Help Portal (https://help.sap.com) to view the full set of documentation for your
product.

SAP Concur Support Portal – Selected Users
Access release notes, webinars, and other technical documentation on the SAP
Concur support portal.
If you have the proper permissions, Contact Support appears on the Help menu.
Click to access the SAP Concur support portal, then click Resources.
•

Click Release/Tech Info for release notes, technical documents, etc.

•

Click Webinars for recorded and live webinars.
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Cases: Check Support Case Status

Cases
Check Support Case Status
The steps in this procedure provide instructions for checking whether a case is
resolved.

 To check the status of a submitted case
1. Log on to https://concursolutions.com/portal.asp.
2. Click Help > Contact Support.

NOTE: If you do not have the option to contact SAP Concur support under the Help
menu, then your company has chosen to support the SAP Concur service
internally. Please contact your internal support desk for assistance.
3. Click Support > View Cases.
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Cases: Check Support Case Status
4. In the table, view the desired type of cases based on the View list selection.

Search results are limited to each company's own cases.
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© 2022 SAP SE or an SAP affiliate company. All rights
reserved.
No part of this publication may be reproduced or transmitted in any form or for any
purpose without the express permission of SAP SE or an SAP affiliate company.
SAP and other SAP products and services mentioned herein as well as their
respective logos are trademarks or registered trademarks of SAP SE (or an SAP
affiliate company) in Germany and other countries. Please see
http://global12.sap.com/corporate-en/legal/copyright/index.epx for additional
trademark information and notices.
Some software products marketed by SAP SE and its distributors contain proprietary
software components of other software vendors.
National product specifications may vary.
These materials are provided by SAP SE or an SAP affiliate company for
informational purposes only, without representation or warranty of any kind, and
SAP SE or its affiliated companies shall not be liable for errors or omissions with
respect to the materials. The only warranties for SAP SE or SAP affiliate company
products and services are those that are set forth in the express warranty
statements accompanying such products and services, if any. Nothing herein should
be construed as constituting an additional warranty.
In particular, SAP SE or its affiliated companies have no obligation to pursue any
course of business outlined in this document or any related presentation, or to
develop or release any functionality mentioned therein. This document, or any
related presentation, and SAP SE’s or its affiliated companies’ strategy and possible
future developments, products, and/or platform directions and functionality are all
subject to change and may be changed by SAP SE or its affiliated companies at any
time for any reason without notice. The information in this document is not a
commitment, promise, or legal obligation to deliver any material, code, or
functionality. All forward-looking statements are subject to various risks and
uncertainties that could cause actual results to differ materially from expectations.
Readers are cautioned not to place undue reliance on these forward-looking
statements, which speak only as of their dates, and they should not be relied upon in
making purchasing decisions.
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Legal Disclaimer
The information in this presentation is confidential and proprietary to SAP SE or an
SAP affiliate company and may not be disclosed without the permission of SAP SE or
the respective SAP affiliate company. This presentation is not subject to your license
agreement or any other service or subscription agreement with SAP SE or its
affiliated companies. SAP SE and its affiliated companies have no obligation to
pursue any course of business outlined in this document or any related presentation,
or to develop or release any functionality mentioned therein. This document, or any
related presentation and SAP SE or an SAP affiliate company’s strategy and possible
future developments, products and or platforms directions and functionality are all
subject to change and may be changed by SAP SE and its affiliated companies at any
time for any reason without notice. The information in this document is not a
commitment, promise or legal obligation to deliver any material, code or
functionality. This document is provided without a warranty of any kind, either
express or implied, including but not limited to, the implied warranties of
merchantability, fitness for a particular purpose, or non-infringement. This document
is for informational purposes and may not be incorporated into a contract. SAP SE
and its affiliated companies assume no responsibility for errors or omissions in this
document, except if such damages were caused by SAP SE or an SAP affiliate
company’s willful misconduct or gross negligence.
All forward-looking statements are subject to various risks and uncertainties that
could cause actual results to differ materially from expectations. Readers are
cautioned not to place undue reliance on these forward-looking statements, which
speak only as of their dates, and they should not be relied upon in making
purchasing decisions.
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Release Notes: Bank Information

Release Notes
This document contains the release notes for Concur Expense professional edition.
NOTE: Features and changes that apply to SAP Concur site-wide or to multiple
products/services are documented in the Shared Changes Release Notes. For
information about site-wide or shared changes in this release that might
impact your SAP Concur solutions, refer to the Shared Changes Release
Notes.

Bank Information
(Norway) Bank Account Field Support for NOK (July/August)
Overview
To better support our Employee Banking Only feature along with the Standard
Accounting Extract (SAE), specific banking fields in Norway Krone are now required.
The following user bank account fields are affected:
Bank Account Field

Description

Bank Country/Region

The country or region where the bank is located.

Bank Currency

Set to Norway Krone.

SWIFT/BIC or Local Routing

Also known as SWIFT ID, a SWIFT/BIC code is a
standard format of Bank Identifier Codes. It is the
unique identification code of a particular bank.
The SWIFT code is 8 or 11 characters, made up of:
4 characters - bank code (only letters)
2 characters - country code (only letters)
2 characters - location code (letters and digits)
3 characters - branch code, optional ('XXX' for primary
office) (letters and digits)

Account Number or IBAN

The account number as specified on the bank
statement. Or the two-character country code, followed
by two check digits and then the bank identifier and
account number, typically derived from the domestic
account number.

Re-Type Account Number or IBAN

Re-type what was entered in the Account Number or
IBAN field.

Tax ID

Taxpayer Identification number used for tax purposes.

Bank Name

Name of the bank branch.

Branch Location

Bank branch location as defined by the bank.

SAP Concur Release Notes
Release Date: July 16, 2022
Initial Post: July 15, 2022

Page 1

Expense Professional / Premium
Client FINAL

Release Notes: Cards

Bank Account Field

Description

Account Type

Checking or Savings.

Status

Status of the account.

Active

Select the account status from the list.

Full Legal Name of Account Owner

The name of the original bank account holder.

Personal Address Line 1

The postal address that the employee provided for this
bank account.

City

The city for the postal address.

Region

The region for the postal address.

Postal Code

The postal code for the postal address.

BUSINESS PURPOSE / CLIENT BENEFIT
These field requirement changes ensure that necessary banking information is
collected and extracted so clients can successfully make payments to their
employees in Norway Krone currency outside of SAP Concur.
User Experience
The employee banking user interface for employees with Norway Bank Country
Region using Norway Krone currency will now see these field as required.
Configuration / Feature Activation
The feature is automatically available; there are no configuration or activation steps.



For general information about this functionality, refer to the Concur Expense:
Employee Banking Only for Expense Pay Factsheet.

Cards
Reauthentication of Linked Cards to Yodlee Required
Overview
With this release, Yodlee has configured their card handling to work with the new
Open Banking standards. This means that users who have linked their noncorporate, personal, or business cards via Yodlee will need to reauthenticate these
cards to ensure that transactions continue to be available within Concur Expense.
Banks will work with Yodlee to adopt the new functionality over time. This means the
card user in Concur Expense must first identify if their card is ready for
reauthentication before doing so. As of this release, the following cards may now be
reauthenticated:
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•

Citibank

If your card is not on this (or prior) lists, refer to upcoming release notes to
determine when your card issuer is ready, and you may proceed with
reauthentication.
BUSINESS PURPOSE / CLIENT BENEFIT
This update is required to ensure continued connectivity between the bank and
Yodlee within Concur Expense, allowing Concur Expense card users to benefit from
Yodlee's adoption of the Open Banking functionality.
What the Admin / Implementation / User Sees
There is no change to the admin or user experience.
Configuration / Feature Activation
The Concur Expense card user who has linked their non-corporate, personal, or
business cards to Yodlee should reauthenticate their cards using the following steps.
1. Open Profile > Profile Settings > Expense Credit Cards.
2. Find the link to your bank.
3. Choose Update Credentials / MFA.
4. Follow the authentication steps required by your bank.

Employee Import
SAP Global Identification Import Added as 315-Level Record Set
Overview
A new employee import record set, SAP Global Identification, is now added to the
employee import job at the 315-record level. The purpose of this new feature is to
support end-to-end access to the SAP Intelligent Enterprise suite through a common
identification attribute assigned to the user through this import.
The following fields are added through the 315-level import:
•

Field 1: Transaction Type
This is a static numeric value always equal to 315. It indicates the Record
Type.

•

Field 2: Employee ID
The Employee ID value that is being used for the employee at this time.

•

Field 3: SAP Global ID
The SAP Global ID value that is being used for the employee at this time.
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Release Notes: Expense Pay – Flex and Global Editions
•

Field 4 - 13: Future Use 1 – 10
Reserved for future use.

BUSINESS PURPOSE / CLIENT BENEFIT
This feature supports seamless access across products included in the SAP Intelligent
Enterprise suite.
Configuration / Feature Activation
The feature is automatically available; however, implementing this feature may
require consultation with your Expense product administrator.



For more information, refer to the Shared: Employee Import Specification
guide.

Expense Pay – Flex and Global Editions
Bank Account Field Updates for Several Currencies (July/August)
Overview
To better support several currencies in Expense Pay Flex and Expense Pay Global,
the following changes to existing fields have been implemented on the Bank
Information page and will be reflected in the Standard Accounting Extract (SAE):
Global or
Flex

Currency

Bank Account Field

Change Description

Flex

AUD

State / Territory

Now a required field

Bank Account Number

A 6 to 10 digit number is
allowed

Bank Name

Now a required field

Bank Account Number

A 7 to 12 digit number is
allowed

Flex
Flex and
Global

CAD

Flex

CHF

SWIFT/BIC Code

Now a required field

Flex

INR

State

Now a required field

Flex

JPY

Bank Account Number

A 7 to 10 digit number is
allowed

Flex

MXN

RFC

A 13 or 18 digit number
is allowed

Address Line 2

Not a required field

Flex

NZD

State

Now a required field

Flex

SEK

State/Province

Now a required field
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Release Notes: Expense Report
BUSINESS PURPOSE / CLIENT BENEFIT
These field requirement and format changes ensure that valid banking information is
collected from employees. This will help reduce data entry errors so payment
providers can successfully complete payments in these currencies for clients, with
less returned and rejected payments.
Admin Experience
The user interface will indicate these fields as required for the currencies listed in the
table. For account number and RFC/Tax ID digit changes, it will prevent users from
saving values that are of invalid length.
Configuration / Feature Activation
The feature is automatically available; there are no configuration or activation steps.



For general information about this functionality, refer to the Concur Expense:
Expense Pay Flex Edition User Guide for Concur Professional/Premium.

Expense Report
Expense Detail View
This change is part of the NextGen UI experience.
Overview
With this release, the Expense Admin has the option of adding an additional viewing
choice for their users when viewing their expense reports - the Detail view. If
configured, the user will now see a View menu and may select from the menu two
different views of their report – the new Detail or the default Standard view.

NOTE: This feature will release shortly after the full release of July 15.
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How it Works
Standard is the default view for the list of expenses, incorporating a table format
with no additional view selection. However, when the Expense admin configures the
addition of the Detail option and includes additional columns, a View menu appears,
with both choices available to the user with the selected details in each column.

BUSINESS PURPOSE / CLIENT BENEFIT
This feature lets the client add specific information in column format that may be
especially useful for their users, increasing the visibility of important information and
providing clarity and efficiency to the expense report workflow process.
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Release Notes: Expense Report
Configuration / Feature Activation
The View menu’s Detail option appears only if the form has been configured. Concur
Expense users will otherwise see the Standard view by default.



For more information, refer to the Concur Expense: Forms and Fields setup
guide.

New Comments Column Added to Expense List View
This change is part of the NextGen UI experience.
Overview
With this release, the Expense List table view will now include a new Comments
column. This column will display only when one or more comments created at the
expense-level of the report are detected.

NOTE: This feature will release shortly after the full release of July 15.
BUSINESS PURPOSE / CLIENT BENEFIT
This update gives greater visibility to alerts and comments that would normally only
appear after additional navigation, speeding the expense report submittal workflow.
Configuration / Feature Activation
This enhancement is automatically available in the UI; no activation steps are
needed to make it display.
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NextGen UI
**Ongoing** Updated User Interface (UI) for Concur Expense End
Users
Information First Published

Information Last Modified

Automatic Transition Date

March 2018

April 23, 2022

Oct 1, 2022

Any changes since the previous monthly release are highlighted in yellow in this release note.

Overview
The continued evolution of the Concur Expense solution user interface experience is
the result of thoughtful design and research that provides a modern, intuitive, and
streamlined experience for creating and submitting expense reports.
Concur Expense customers are now strongly encouraged to preview and then move
to the NextGen UI well before the automatic transition date of October 1, 2022.
BUSINESS PURPOSE / CLIENT BENEFIT
The result is the next generation of the Concur Expense user interface designed to
provide a modern, consistent, and streamlined user experience. This technology not
only provides an enhanced user interface, but also allows us to react more quickly to
customer requests to meet changing needs as they happen.
Products and Users Affected
To take advantage of these improvements, Concur Expense customers who do not
move before October 1, 2022 will be automatically transitioned to the NextGen UI for
Concur Expense. The following provides information about the timeline and resources
available to ensure this process is smooth and efficient for all users.
These UI changes apply to:
•

Concur Expense (Professional/Premium and Standard) end users only
NOTE: There are no changes for approvers, processors, or admins.

IMPORTANT: Timeline and Milestones
There are four important milestones for Concur Expense customers as they transition
from the existing UI to the NextGen UI.
1. Early Access Period: March 2018 – July 2020

During this time, the updated UI was available to preview for customers
worldwide. We encouraged administrators/power users to use the Early
Access Period to preview the refreshed interface, update internal training
materials, and prepare the organization for the transition.
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2. Opt-In Period: July 2020 – September 2021

Following the Early Access Period was an open Opt-In Period. This milestone
was marked by the delivery of most planned features as well as further
overall product quality and stability.
Customers should use this period to plan their transition and move to the
NextGen UI for Concur Expense when it is right for your business priorities.
Some remaining features will become available throughout this period, so
customers should plan their roll out accordingly.
3. Active Move Period: October 2021 – September 2022

This is the 12-month notice period we committed to for customers to
complete the transition at their own pace before the automatic transition
date.
Customers are strongly encouraged to complete the tasks necessary to
ensure a smooth transition for their organization and then transition during
the Active Move Period.
4. Automatic Transition Date: October 1, 2022

All customers will be automatically transitioned to the NextGen UI.
This ensures that we continue to offer a consistent user experience for all
customers and allows for superior product innovation and support.
Transition Materials – Guides and Other Resources
We offer several guides, FAQs, release notes, and other resources to help in the
transition. All the information that an organization needs to get started is available
here:
•

Professional Edition

•

Standard Edition

The links above provide access to the following:
•

Admin guides, FAQs, transition resources: The admin guide provides
information about accessing the NextGen UI for Concur Expense and the
roles/permissions required.
Along with the admin guide, there are FAQs, other resources (such as e-mail
templates and other training materials), and a list of features that are not yet
available in the NextGen UI for Concur Expense. All of these materials can be
used to help customers prepare their users.
NOTE: To help with training needs, customers can use the admin guide and
end-user guide "as is" or they can use any part of them to create
training materials. Customers can cut, copy, paste, delete, or edit
either guide at will.

•

End-User guide: This guide compares the existing UI to the NextGen UI for
Concur Expense to help users become comfortable with the new experience.
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Release Notes: Travel Allowance Service
This guide will be updated as needed during the Opt-In Period as the NextGen
UI is being enhanced. Admins should review the guide often.
NOTE: Like the admin guide, the organization can cut, copy, paste, delete, or
edit this guide at will.
•

Release information: During the Active Move Period, the release of
enhancements will not be on the regular release schedule. Instead, we will
provide special information about features and enhancements that are
nearing release.
As of the May 2022 release, release notes for the NextGen UI can be found
within this release note document. The statement These changes are part of
the NextGen UI experience is displayed at the beginning of each NextGen UI
release note.

Get Started
Customers are encouraged to use the transition materials described above and
develop a plan for the transition.

Travel Allowance Service
Add Additional Deduction Categories, Types, and Values for Rate
Bundle Deductions and Adjust Default Time for a Deduction
This change is part of the NextGen UI experience.
Overview
With this release, the Expense Admin may now create new deduction category types
using options on the Add or Edit Rate Bundle page. These custom deductions
appear alongside the default deductions (Breakfast; Lunch; etc.) for addition to any
rate bundle the admin is working with.
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Release Notes: Travel Allowance Service

For each deduction type, new or existing, the admin may also configure one or more
values for a deduction in the Deduction Types page. These appear to the user as a
single checkbox or a drop-down list with multiple choices.

Finally, on the same page under Default Time for Deduction, any deduction
category’s default time (for example, Breakfast = 7 a.m.) may now be adjusted for
the purpose of matching a specific 24-hour period or any other time interval
requirement.
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Admin Experience
ADDING A NEW DEDUCTION CATEGORY TYPE
The admin adds a new custom deduction category type when they add or edit a rate
bundle. This is done using the new Deduction Category Types feature on either
the Add or Edit Rate Bundle page.

 To add a deduction category type and value(s)
1. On the Travel Allowance Configuration page, click Rate Bundles.

2. The Rate Bundles page appears. Click ( ) once to open a rate bundle, and a

second time beside Deduction Category Types.

3. The Edit Deduction Category Types page appears. Click Add.
4. In the Code field, enter a code for the deduction type. Valid characters are A-

Z, 0-9, and underscore _.

5. In the Description field, enter a description for the deduction type.

NOTE: The Description field values should accommodate all language
requirements. These values are your company's custom (nontranslatable) labels that will be displayed to your users.
6. Click Save, or optionally, continue with the steps below to add values for the

deduction type.
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ADDING DEDUCTION CATEGORY VALUES
If values for a deduction category type are needed you may do this now following the
steps below. When done, values will appear on the Adjustments page to the user
as either a single check box or multiple choice if more than one value is used.

1. On the Edit Deduction Category Types page, click ( ) next to the new

deduction category type to add values for that type.
2. The Edit values of deduction category type page appears. In the

Deduction Type Code field, enter a code for the deduction type. Valid
characters are A-Z, 0-9, and underscore _.

3. In the Deduction Type Description field, enter a description for the

deduction type.
SAP Concur Release Notes
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NOTE: The Description field values should accommodate all language
requirements. These values are your company's custom (nontranslatable) labels that will be displayed to your users.
4. Click OK, then click Back twice to return to the Rate Bundles page.

ADJUSTING THE DEFAULT TIME FOR A DEDUCTION
Any deduction category type can have the default time adjusted from its default.
Two examples explain the adjustment of time based on a country’s requirements:
•

Calculation by 24-hour Interval: Any given 24-hour period of a trip
represents a travel day whose initial hour (11 a.m.) ends at the same hour on
the next day – if an 8 a.m. Breakfast and 1 p.m. Lunch is included these will
both fall within the “first” travel day.

•

Calculation by Foreign or Domestic: Separate calculations for travel
either foreign and domestic means the same 8 a.m. Breakfast and 1 p.m.
Lunch will be calculated based on where the event occurs during travel –
Breakfast during the Domestic leg, and Lunch during the Foreign leg of the
travel day.

 To adjust the time for a deduction category type

•

On the Deduction Types page, change the time under Default Time for
Deduction in one of two ways:


Edit the time directly in the HH:MM format



Open the Time Toggle control and adjust using the arrows, then click OK.

BUSINESS PURPOSE / CLIENT BENEFIT
This update provides increased flexibility for managing rate deductions and brings
additional features in parity to Classic Travel Allowance.
Configuration / Feature Activation
These enhancements are automatically available in the UI; no activation steps are
needed to make them display – and using them is optional configuration, not
required configuration.
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For more information, refer to the Concur Expense: Travel Allowance Generic
Configurable Bundle Setup Guide.

New SAP Concur-Managed Statutory Bundles for Italy for the
NextGen UI
This change is part of the NextGen UI experience.
Overview
Additional country bundles are available for NextGen UI for Concur Expense (NGE)
for Italy:

!

•

SAP_CONCUR_IT_FIXED

•

SAP_CONCUR_IT_REIMBURSABLE

IMPORTANT: The Travel Allowance (TA) Service solution is only available to net
new country implementations.

This solution is not an upgrade of the existing "classic" TA feature, but a completely
new solution. This NextGen UI new travel allowance feature for Concur Expense,
unlike its predecessor, includes a managed rate service whereby statutory rate
updates are maintained by SAP Concur.

!

IMPORTANT: The implementation of this TA solution is significantly different
from the implementation of our existing TA offering. This feature spans the
Concur Expense and Concur Request products, and its functionality cannot be
separated for use by one and not the other.

RELEASED SAP CONCUR-MANAGED STATUTORY RATE BUNDLES
•

Germany (Statutory) – July 2020

•

Portugal (Statutory) – July 2020

•

Spain (Statutory) – July 2020

•

Generic – Core functionality provided to all Concur Expense clients. SAP
Concur plans to expand the functionality of the generic template as additional
components (developed for statutory country templates) become available. –
– July 2020

•

Denmark (Statutory) – December 2020

•

Finland (Statutory) – December 2020

•

Norway (Statutory State and Statutory Tax-Free) – December 2020

•

Sweden (Statutory) – December 2020

•

Poland (Statutory) – July 2021

•

Russian Federation (Statutory) –December 2021
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•

Czech Republic (Statutory) –March 2022

•

Slovakia (Statutory) –March 2022

•

United States (Statutory) –March 2022

•

United States Joint Travel Regulations (Statutory) –March 2022

•

Italy (Statutory) –July 2022

IMPORTANT: The current "classic" TA solution remains in use by and fully
supported for existing clients and new clients who do not yet have a new TA
country-specific template. Clients can migrate to NextGen UI and continue to use
the legacy TA solution.

PLANNED ADDITIONAL COUNTRIES
Currently, SAP Concur plans to release statutory bundles in the future, that may
include (but are not limited to) the following:
•

Austria

BUSINESS PURPOSE/CLIENT BENEFIT
Clients can benefit from rates updated by SAP Concur as well as maintain bestpractice travel allowance functionality.
Configuration/Feature Activation
All users who access the Expense Admin page will see the Travel Allowance
Configuration link.



Additional product guides are available.
For Concur Expense, refer to the country-specific guides landing page.
For Concur Request, refer to the guides landing page.
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Planned Changes: There are no planned changes this month.

Planned Changes
The items in this section are targeted for future releases. SAP Concur reserves the
right to postpone implementation of – or completely remove – any
enhancement/change mentioned here.
NOTE: The planned changes listed in this document are specific to this product. For
information about planned site-wide or shared changes that might impact
your SAP Concur solutions, refer to the Shared Changes Release Notes.

There are no planned changes this month.
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Client Notifications
Accessibility
Accessibility Updates
SAP implements changes to better meet current Web Content Accessibility Guidelines
(WCAG). Information about accessibility-related changes made to SAP Concur
solutions is published on a quarterly basis. You can review the quarterly updates on
the Accessibility Updates page.

Subprocessors
SAP Concur Non-Affiliated Subprocessors
The list of non-affiliated subprocessors is available from the SAP Sub-processors /
Data Transfer Factsheets page.

 To access the SAP Concur Sub-processors List:
1. Click the following link to navigate to the SAP Sub-processors / Data Transfer

Factsheets page:
SAP Sub-processors / Data Transfer Factsheets
2. Sign in to the SAP Support Portal using your Support User ID (S-user) and

password.
NOTE: SAP customers must sign in to the SAP Support Portal using their
Support User ID (S-user) and password. For information about S-User
IDs, refer to Your New Support User ID (S-user).
3. On the SAP Sub-processors / Data Transfer Factsheets page, type "Concur" in

the Search field.
4. In the Title column, click SAP Concur Sub-processors List.

If you have questions or comments, please reach out to: PrivacyRequest@Concur.com

Supported Browsers
Supported Browsers and Changes to Support
For information about supported browsers and planned changes to supported
browsers, refer to the Concur Travel & Expense Supported Configurations guide.
SAP Concur Release Notes
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Client Notifications: Supported Browsers
When changes to browser support are planned, information about those changes will
also appear in the Shared Changes Release Notes.
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Additional Release Notes and Other Technical
Documentation
Online Help
Any user can access release notes, setup guides, user guides, admin summaries,
monthly browser certifications, supported configurations, and other resources via
online Help or directly on the SAP Help Portal.
Use the links in the Help menu in the app, or search for your SAP Concur product
(Concur Expense, Concur Invoice, Concur Request, or Concur Travel) on the SAP
Help Portal (https://help.sap.com) to view the full set of documentation for your
product.

SAP Concur Support Portal – Selected Users
Access release notes, webinars, and other technical documentation on the SAP
Concur support portal.
If you have the proper permissions, Contact Support appears on the Help menu.
Click to access the SAP Concur support portal, then click Resources.
•

Click Release/Tech Info for release notes, technical documents, etc.

•

Click Webinars for recorded and live webinars.
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Cases
Check Support Case Status
The steps in this procedure provide instructions for checking whether a case is
resolved.

 To check the status of a submitted case
1. Log on to https://concursolutions.com/portal.asp.
2. Click Help > Contact Support.

NOTE: If you do not have the option to contact SAP Concur support under the Help
menu, then your company has chosen to support the SAP Concur service
internally. Please contact your internal support desk for assistance.
3. Click Support > View Cases.
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Cases: Check Support Case Status
4. In the table, view the desired type of cases based on the View list selection.

Search results are limited to each company's own cases.
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© 2022 SAP SE or an SAP affiliate company. All rights
reserved.
No part of this publication may be reproduced or transmitted in any form or for any
purpose without the express permission of SAP SE or an SAP affiliate company.
SAP and other SAP products and services mentioned herein as well as their
respective logos are trademarks or registered trademarks of SAP SE (or an SAP
affiliate company) in Germany and other countries. Please see
http://global12.sap.com/corporate-en/legal/copyright/index.epx for additional
trademark information and notices.
Some software products marketed by SAP SE and its distributors contain proprietary
software components of other software vendors.
National product specifications may vary.
These materials are provided by SAP SE or an SAP affiliate company for
informational purposes only, without representation or warranty of any kind, and
SAP SE or its affiliated companies shall not be liable for errors or omissions with
respect to the materials. The only warranties for SAP SE or SAP affiliate company
products and services are those that are set forth in the express warranty
statements accompanying such products and services, if any. Nothing herein should
be construed as constituting an additional warranty.
In particular, SAP SE or its affiliated companies have no obligation to pursue any
course of business outlined in this document or any related presentation, or to
develop or release any functionality mentioned therein. This document, or any
related presentation, and SAP SE’s or its affiliated companies’ strategy and possible
future developments, products, and/or platform directions and functionality are all
subject to change and may be changed by SAP SE or its affiliated companies at any
time for any reason without notice. The information in this document is not a
commitment, promise, or legal obligation to deliver any material, code, or
functionality. All forward-looking statements are subject to various risks and
uncertainties that could cause actual results to differ materially from expectations.
Readers are cautioned not to place undue reliance on these forward-looking
statements, which speak only as of their dates, and they should not be relied upon in
making purchasing decisions.
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Legal Disclaimer
The information in this presentation is confidential and proprietary to SAP SE or an
SAP affiliate company and may not be disclosed without the permission of SAP SE or
the respective SAP affiliate company. This presentation is not subject to your license
agreement or any other service or subscription agreement with SAP SE or its
affiliated companies. SAP SE and its affiliated companies have no obligation to
pursue any course of business outlined in this document or any related presentation,
or to develop or release any functionality mentioned therein. This document, or any
related presentation and SAP SE or an SAP affiliate company’s strategy and possible
future developments, products and or platforms directions and functionality are all
subject to change and may be changed by SAP SE and its affiliated companies at any
time for any reason without notice. The information in this document is not a
commitment, promise or legal obligation to deliver any material, code or
functionality. This document is provided without a warranty of any kind, either
express or implied, including but not limited to, the implied warranties of
merchantability, fitness for a particular purpose, or non-infringement. This document
is for informational purposes and may not be incorporated into a contract. SAP SE
and its affiliated companies assume no responsibility for errors or omissions in this
document, except if such damages were caused by SAP SE or an SAP affiliate
company’s willful misconduct or gross negligence.
All forward-looking statements are subject to various risks and uncertainties that
could cause actual results to differ materially from expectations. Readers are
cautioned not to place undue reliance on these forward-looking statements, which
speak only as of their dates, and they should not be relied upon in making
purchasing decisions.
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Release Notes: Bank Information

Release Notes
This document contains the release notes for Concur Expense professional edition.
NOTE: Features and changes that apply to SAP Concur site-wide or to multiple
products/services are documented in the Shared Changes Release Notes. For
information about site-wide or shared changes in this release that might
impact your SAP Concur solutions, refer to the Shared Changes Release
Notes.

Bank Information
(Norway) Bank Account Field Support for NOK (July/August)
Overview
To better support our Employee Banking Only feature along with the Standard
Accounting Extract (SAE), specific banking fields in Norway Krone are now required.
The following user bank account fields are affected:
Bank Account Field

Description

Bank Country/Region

The country or region where the bank is located.

Bank Currency

Set to Norway Krone.

SWIFT/BIC or Local Routing

Also known as SWIFT ID, a SWIFT/BIC code is a
standard format of Bank Identifier Codes. It is the
unique identification code of a particular bank.
The SWIFT code is 8 or 11 characters, made up of:
4 characters - bank code (only letters)
2 characters - country code (only letters)
2 characters - location code (letters and digits)
3 characters - branch code, optional ('XXX' for primary
office) (letters and digits)

Account Number or IBAN

The account number as specified on the bank
statement. Or the two-character country code, followed
by two check digits and then the bank identifier and
account number, typically derived from the domestic
account number.

Re-Type Account Number or IBAN

Re-type what was entered in the Account Number or
IBAN field.

Tax ID

Taxpayer Identification number used for tax purposes.

Bank Name

Name of the bank branch.

Branch Location

Bank branch location as defined by the bank.
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Bank Account Field

Description

Account Type

Checking or Savings.

Status

Status of the account.

Active

Select the account status from the list.

Full Legal Name of Account Owner

The name of the original bank account holder.

Personal Address Line 1

The postal address that the employee provided for this
bank account.

City

The city for the postal address.

Region

The region for the postal address.

Postal Code

The postal code for the postal address.

BUSINESS PURPOSE / CLIENT BENEFIT
These field requirement changes ensure that necessary banking information is
collected and extracted so clients can successfully make payments to their
employees in Norway Krone currency outside of SAP Concur.
User Experience
The employee banking user interface for employees with Norway Bank Country
Region using Norway Krone currency will now see these field as required.
Configuration / Feature Activation
The feature is automatically available; there are no configuration or activation steps.



For general information about this functionality, refer to the Concur Expense:
Employee Banking Only for Expense Pay Factsheet.

Enhanced Payment Validation for Banking Fields with JPY
(Japanese) Katakana characters
Overview
For JPY Expense Pay - Flex edition payments, when any user banking field for an
employee payment contains Japanese Katakana characters, the payment details are
now validated to ensure that none of these characters exist in the data. Payments
with Katakana characters are automatically aborted from the batch, and the user will
need to resubmit their payment details without those characters.
BUSINESS PURPOSE / CLIENT BENEFIT
SAP Concur’s payment processing partners for Expense Pay - Flex do not accept
these or any other non-English characters in the payment data when processing
SAP Concur Release Notes
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Release Notes: Cards
payments. Any user banking text fields containing half or full width Katakana
characters will be first detected by SAP Concur and then aborted before it’s sent to
the payment provider. This will help reduce manual overhead, payment processing
cost, and shorten the turnaround time for the employee to get notified to update
their banking info to remove these characters.
User Experience
The user banking fields will be validated to check for unsupported Japanese Katakana
characters when the batch of payments is ready to be sent to the payment provider.
If an employee is impacted, they will receive an error message stating that their
banking did not succeed and their payment was unable to be paid. These users will
need to update their user banking details to use only English characters for all fields
on the form.
Configuration / Feature Activation
The feature is automatically available; there are no configuration or activation steps.

Cards
VISA: Processor Reference Number in VCF Specification Now
Masked
Overview
With this release, SAP Concur will mask account information found in the
CT_CREDIT_CARD_TRANSACTION_PROCESSOR_REF_NO (Processor Reference
Number) field.

BUSINESS PURPOSE / CLIENT BENEFIT
This change ensures compliance and security.
Configuration / Feature Activation
The feature is automatically available; there are no additional configuration or
activation steps.
SAP Concur Release Notes
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Expense Pay – Flex and Global Editions
Bank Account Field Updates for Several Currencies (July/August)
Overview
To better support several currencies in Expense Pay Flex and Expense Pay Global,
the following changes to existing fields have been implemented on the Bank
Information page and will be reflected in the Standard Accounting Extract (SAE):
Global or
Flex

Currency

Bank Account Field

Change Description

Flex

AUD

State / Territory

Now a required field

Bank Account Number

A 6-to-10-digit number is
allowed

Bank Name

Now a required field

Bank Account Number

A 7-to-12-digit number is
allowed

Flex
Flex and
Global

CAD

Flex

CHF

SWIFT/BIC Code

Now a required field

Flex

INR

State

Now a required field

Flex

JPY

Bank Account Number

A 7-to-10-digit number is
allowed

Flex

MXN

RFC

A 13- or 18-digit number
is allowed

Address Line 2

Not a required field

Flex

NZD

State

Now a required field

Flex

SEK

State/Province

Now a required field

BUSINESS PURPOSE / CLIENT BENEFIT
These field requirement and format changes ensure that valid banking information is
collected from employees. This will help reduce data entry errors so payment
providers can successfully complete payments in these currencies for clients, with
less returned and rejected payments.
Admin Experience
The user interface will indicate these fields as required for the currencies listed in the
table. For account number and RFC/Tax ID digit changes, it will prevent users from
saving values that are of invalid length.
Configuration / Feature Activation
The feature is automatically available; there are no configuration or activation steps.
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For general information about this functionality, refer to the Concur Expense:
Expense Pay Flex Edition User Guide for Concur Professional/Premium.

Expenses
Copy Down Attendees Information to Itemizations
This change is part of the NextGen UI experience.
Overview
The new NextGen user interface (UI) now matches the existing legacy functionality
to copy down attendee information from the parent expense to itemizations. This
helps streamline data entry for the employee creating the expense report.
NOTE: This feature was released July 12th of 2022.
BUSINESS PURPOSE / CLIENT BENEFIT
This update brings parity between the NextGen user interface and the legacy
interface for creating itemizations.
Configuration / Feature Activation
This feature requires no special configuration; this change is now available in the
NextGen UI and is configured identically between both UIs.



For more information, refer to the Concur Expense: Forms and Fields setup
guide.

Mileage Service
Standard Accounting Extract (SAE) Selected Car Mileage Data
Fields Now Activated
This change is part of the NextGen UI experience.
Overview
With this release, when using the Mileage Service feature in the NextGen UI,
selected Car Mileage Data fields in the Standard Accounting Extract (SAE) are now
populated with data from the mileage-related expense entries of an expense report.
The selected fields are:
•

Business Distance (CT_CAR_LOG_ENTRY.BUSINESS_DISTANCE)
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•

Personal Distance (CT_CAR_LOG_ENTRY.PERSONAL_DISTANCE)

•

Car Passenger Count (CT_CAR_LOG_ENTRY.PASSENGER_COUNT)

•

Vehicle ID (CT_CAR.VEHICLE_ID)

IMPORTANT: This feature applies to Mileage Service (new mileage) customers
only.
This change does NOT affect nor apply to current Concur Expense Professional
customers using the existing (Legacy) mileage.

BUSINESS PURPOSE / CLIENT BENEFIT
This update enhances the Mileage Service functionality and brings parity between the
NextGen and Legacy user interfaces by allowing users to extract car mileage data
from their expense entries.
Configuration / Feature Activation
This Mileage Service update is deployed automatically but does require an admin to
configure specific settings for the user.



For more information on configuration procedures for extracting data to the
Car Mileage fields in the Standard Accounting Extract (SAE) see your SAP
Concur administrator and the Concur Expense: Standard Accounting Extract
Version 4 specification.

NextGen UI
**Ongoing** Updated User Interface (UI) for Concur Expense End
Users
Information First Published

Information Last Modified

Automatic Transition Date

March 2018

April 23, 2022

Oct 1, 2022

Any changes since the previous monthly release are highlighted in yellow in this release note.

Overview
The continued evolution of the Concur Expense solution user interface experience is
the result of thoughtful design and research that provides a modern, intuitive, and
streamlined experience for creating and submitting expense reports.
Concur Expense customers are now strongly encouraged to preview and then move
to the NextGen UI well before the automatic transition date of October 1, 2022.
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BUSINESS PURPOSE / CLIENT BENEFIT
The result is the next generation of the Concur Expense user interface designed to
provide a modern, consistent, and streamlined user experience. This technology not
only provides an enhanced user interface, but also allows us to react more quickly to
customer requests to meet changing needs as they happen.
Products and Users Affected
To take advantage of these improvements, Concur Expense customers who do not
move before October 1, 2022 will be automatically transitioned to the NextGen UI for
Concur Expense. The following provides information about the timeline and resources
available to ensure this process is smooth and efficient for all users.
These UI changes apply to:
•

Concur Expense (Professional/Premium and Standard) end users only
NOTE: There are no changes for approvers, processors, or admins.

IMPORTANT: Timeline and Milestones
There are four important milestones for Concur Expense customers as they transition
from the existing UI to the NextGen UI.
1. Early Access Period: March 2018 – July 2020

During this time, the updated UI was available to preview for customers
worldwide. We encouraged administrators/power users to use the Early
Access Period to preview the refreshed interface, update internal training
materials, and prepare the organization for the transition.
2. Opt-In Period: July 2020 – September 2021

Following the Early Access Period was an open Opt-In Period. This milestone
was marked by the delivery of most planned features as well as further
overall product quality and stability.
Customers should use this period to plan their transition and move to the
NextGen UI for Concur Expense when it is right for your business priorities.
Some remaining features will become available throughout this period, so
customers should plan their roll out accordingly.
3. Active Move Period: October 2021 – September 2022

This is the 12-month notice period we committed to for customers to
complete the transition at their own pace before the automatic transition
date.
Customers are strongly encouraged to complete the tasks necessary to
ensure a smooth transition for their organization and then transition during
the Active Move Period.
SAP Concur Release Notes
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4. Automatic Transition Date: October 1, 2022

All customers will be automatically transitioned to the NextGen UI.
This ensures that we continue to offer a consistent user experience for all
customers and allows for superior product innovation and support.
Transition Materials – Guides and Other Resources
We offer several guides, FAQs, release notes, and other resources to help in the
transition. All the information that an organization needs to get started is available
here:
•

Professional Edition

•

Standard Edition

The links above provide access to the following:
•

Admin guides, FAQs, transition resources: The admin guide provides
information about accessing the NextGen UI for Concur Expense and the
roles/permissions required.
Along with the admin guide, there are FAQs, other resources (such as e-mail
templates and other training materials), and a list of features that are not yet
available in the NextGen UI for Concur Expense. All of these materials can be
used to help customers prepare their users.
NOTE: To help with training needs, customers can use the admin guide and
end-user guide "as is" or they can use any part of them to create
training materials. Customers can cut, copy, paste, delete, or edit
either guide at will.

•

End-User guide: This guide compares the existing UI to the NextGen UI for
Concur Expense to help users become comfortable with the new experience.
This guide will be updated as needed during the Opt-In Period as the NextGen
UI is being enhanced. Admins should review the guide often.
NOTE: Like the admin guide, the organization can cut, copy, paste, delete, or
edit this guide at will.

•

Release information: During the Active Move Period, the release of
enhancements will not be on the regular release schedule. Instead, we will
provide special information about features and enhancements that are
nearing release.
As of the May 2022 release, release notes for the NextGen UI can be found
within this release note document. The statement These changes are part of
the NextGen UI experience is displayed at the beginning of each NextGen UI
release note.

Get Started
Customers are encouraged to use the transition materials described above and
develop a plan for the transition.
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Planned Changes: There are no planned changes this month.

Planned Changes
The items in this section are targeted for future releases. SAP Concur reserves the
right to postpone implementation of – or completely remove – any
enhancement/change mentioned here.
NOTE: The planned changes listed in this document are specific to this product. For
information about planned site-wide or shared changes that might impact
your SAP Concur solutions, refer to the Shared Changes Release Notes.

There are no planned changes this month.
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Client Notifications
Accessibility
Accessibility Updates
SAP implements changes to better meet current Web Content Accessibility Guidelines
(WCAG). Information about accessibility-related changes made to SAP Concur
solutions is published on a quarterly basis. You can review the quarterly updates on
the Accessibility Updates page.

Subprocessors
SAP Concur Non-Affiliated Subprocessors
The list of non-affiliated subprocessors is available from the SAP Sub-processors /
Data Transfer Factsheets page.

 To access the SAP Concur Sub-processors List:
1. Click the following link to navigate to the SAP Sub-processors / Data Transfer

Factsheets page:
SAP Sub-processors / Data Transfer Factsheets
2. Sign in to the SAP Support Portal using your Support User ID (S-user) and

password.
NOTE: SAP customers must sign in to the SAP Support Portal using their
Support User ID (S-user) and password. For information about S-User
IDs, refer to Your New Support User ID (S-user).
3. On the SAP Sub-processors / Data Transfer Factsheets page, type "Concur" in

the Search field.
4. In the Title column, click SAP Concur Sub-processors List.

If you have questions or comments, please reach out to: PrivacyRequest@Concur.com
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Supported Browsers
Supported Browsers and Changes to Support
For information about supported browsers and planned changes to supported
browsers, refer to the Concur Travel & Expense Supported Configurations guide.
When changes to browser support are planned, information about those changes will
also appear in the Shared Changes Release Notes.
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Additional Release Notes and Other Technical
Documentation
Online Help
You can access release notes, setup guides, user guides, admin summaries,
supported configurations, and other resources via the in-product Help menu or on
the SAP Help Portal.
To access the full set of documentation for your product, use the links in the SAP
Concur Help menu, or search for your SAP Concur product (Concur Expense, Concur
Invoice, Concur Request, or Concur Travel) on the SAP Help Portal
(https://help.sap.com).

SAP Concur Support Portal – Selected Users
Access release notes, webinars, and other technical documentation on the SAP
Concur support portal.
If you have the required permissions, Contact Support is available on the SAP
Concur Help menu and in the SAP Concur page footer.

Click Contact Support to access the SAP Concur support portal, then click
Resources.
•

Click Release/Tech Info for release notes, technical documents, etc.

•

Click Webinars for recorded and live webinars.
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Cases: Check Support Case Status

Cases
Check Support Case Status
The steps in this procedure provide instructions for checking whether a case is
resolved.

 To check the status of a submitted case
1. Log on to https://concursolutions.com/portal.asp.
2. Click Help > Contact Support.

NOTE: If you do not have the option to contact SAP Concur support under the Help
menu, then your company has chosen to support the SAP Concur service
internally. Please contact your internal support desk for assistance.
3. Click Support > View Cases.
4. In the table, view the desired type of cases based on the View list selection.

Search results are limited to each company's own cases.
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products and services are those that are set forth in the express warranty
statements accompanying such products and services, if any. Nothing herein should
be construed as constituting an additional warranty.
In particular, SAP SE or its affiliated companies have no obligation to pursue any
course of business outlined in this document or any related presentation, or to
develop or release any functionality mentioned therein. This document, or any
related presentation, and SAP SE’s or its affiliated companies’ strategy and possible
future developments, products, and/or platform directions and functionality are all
subject to change and may be changed by SAP SE or its affiliated companies at any
time for any reason without notice. The information in this document is not a
commitment, promise, or legal obligation to deliver any material, code, or
functionality. All forward-looking statements are subject to various risks and
uncertainties that could cause actual results to differ materially from expectations.
Readers are cautioned not to place undue reliance on these forward-looking
statements, which speak only as of their dates, and they should not be relied upon in
making purchasing decisions.
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Legal Disclaimer
The information in this presentation is confidential and proprietary to SAP SE or an
SAP affiliate company and may not be disclosed without the permission of SAP SE or
the respective SAP affiliate company. This presentation is not subject to your license
agreement or any other service or subscription agreement with SAP SE or its
affiliated companies. SAP SE and its affiliated companies have no obligation to
pursue any course of business outlined in this document or any related presentation,
or to develop or release any functionality mentioned therein. This document, or any
related presentation and SAP SE or an SAP affiliate company’s strategy and possible
future developments, products and or platforms directions and functionality are all
subject to change and may be changed by SAP SE and its affiliated companies at any
time for any reason without notice. The information in this document is not a
commitment, promise or legal obligation to deliver any material, code or
functionality. This document is provided without a warranty of any kind, either
express or implied, including but not limited to, the implied warranties of
merchantability, fitness for a particular purpose, or non-infringement. This document
is for informational purposes and may not be incorporated into a contract. SAP SE
and its affiliated companies assume no responsibility for errors or omissions in this
document, except if such damages were caused by SAP SE or an SAP affiliate
company’s willful misconduct or gross negligence.
All forward-looking statements are subject to various risks and uncertainties that
could cause actual results to differ materially from expectations. Readers are
cautioned not to place undue reliance on these forward-looking statements, which
speak only as of their dates, and they should not be relied upon in making
purchasing decisions.
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Release Notes
This document contains the release notes for Concur Expense professional edition.
NOTE: Features and changes that apply to SAP Concur site-wide or to multiple
products/services are documented in the Shared Changes Release Notes. For
information about site-wide or shared changes in this release that might
impact your SAP Concur solutions, refer to the Shared Changes Release
Notes.

Accessibility
Alert Popup Redesigned to Meet Accessibility Requirements
This change is part of the NextGen UI experience.
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Release Notes: Employee Taxability and Corporate Deductibility
Overview
The new NextGen user interface (UI) now features a redesigned popup of the alert
message detailing errors in an expense report. This update conforms to accessibility
requirements for all users of Expense.

BUSINESS PURPOSE / CLIENT BENEFIT
This update improves the user experience by more clearly detailing the errors
blocking the creation of an expense report.
Configuration / Feature Activation
The feature is automatically available; there are no additional configuration or
activation steps using an updated design that meets accessibility needs.

Employee Taxability and Corporate Deductibility
This change is part of the NextGen UI experience.
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Mileage Taxability
Overview
Mileage taxability is now supported for countries with variable rate vehicle criteria by
distance, additional rates and accumulation period, in addition to countries with fixed
rate criteria.
BUSINESS PURPOSE / CLIENT BENEFIT
The configurations for mileage enable the system to identify amounts that exceed a
statutory tax-free limit and can be reimbursed to the user based on the company
policy.
Admin Experience
The list for mileage configuration now includes countries with variable rate vehicle
criteria for the admin to choose.
Configuration / Feature Activation
The feature is automatically available; there are no additional configuration or
activation steps.

Expenses
Enhancements to the Hotel Itemization Wizard
This change is part of the NextGen UI experience.
Overview
With this release, several usability enhancements are now added to the Hotel
Itemization wizard. They include:
•

General Accessibility Improvements: Overall, Tax fields are now more
clearly displayed and labeled for quick identification and entry, reducing
confusion, and increasing the accuracy for this complex task

•

Default Tax Field Display Based on Location: Initial display of tax fields is
now based on location to display the ‘expected’ fields for that location

•

VAT Itemization: Handling for VAT configuration of FULL tax, where the
result is an itemization for the VAT amount

•

Add Tax Fields During Itemization: Additional tax fields may optionally be
added by the user when working within locations with many local taxes
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Release Notes: Expenses
User Experience
GENERAL ACCESSIBILITY IMPROVEMENTS
With this update, the Hotel Itemization wizard functionality is enhanced by improving
the layout of tax fields for the user and adding additional tax fields they can
configure to match the anticipated tax-related data contained in the hotel folio.

These improvements match the functionality of the legacy user interface and
combine to make the task of entering a hotel expense type more logical and the
identification and entry of specific tax types easier for the traveler.
DEFAULT TAX FIELD DISPLAY BASED ON LOCATION
Logic included in this update recognizes the regional location (Country/Region and
State/Province) of the expense and offers the expected tax entry fields for clear
identification, guidance, and increased accuracy when entering taxes.
In the example below, the user lodging in France would see Room Rate as the only
field in the initial view.
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Release Notes: Expenses
The same traveler lodging in Switzerland, however, would see the addition of the
Tax (per night) field beside the Room Rate field for their stay:

Tax Field Display with Differing Nightly Lodging Accommodations
For travelers reconciling different lodging for their nightly stays, the Not the Same
tab is selected to display all 5 Tax fields which will display VAT-specific labels where
appropriate.

SAP Concur Release Notes
Release Date: September 17, 2022
Initial Post: September 16, 2022

Page 6

Expense Professional / Premium
Client FINAL

Release Notes: Expenses

Adding Tax Fields While Itemizing
In all instances the user may optionally add additional tax fields (Tax 4 and Tax 5)
to their report using the Add Tax Fields link. This is useful when a location has
numerous daily local taxes on the hotel folio that must be accounted for.
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Release Notes: Expenses
As before the changes included in this update, once the user saves their
itemizations, the selected expense types are displayed in a list in the Itemizations
tab for clarity and easy review prior to submitting the report.

VAT TAX FIELD ITEMIZATION
The user entering VAT values is now supported in this task in the NextGen user
interface (UI) to match the legacy UI. When configured for VAT, the system replaces
the first one or two Tax fields with VAT-specific fields correctly labeled to match the
location and intent.

SAP Concur Release Notes
Release Date: September 17, 2022
Initial Post: September 16, 2022

Page 8

Expense Professional / Premium
Client FINAL

Release Notes: Expenses

In the example below, the Provincial Sales Tax (PST) and the Goods and Services
Tax (GST) tax fields appear for the traveler lodging in Canada. The Tax 3, 4 and 5
fields may be used for the local city taxes as needed.

The Harmonized Sales Tax (HST) supports the combined GST and PST taxes:
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Release Notes: Expenses
BUSINESS PURPOSE / CLIENT BENEFIT
This update brings parity to the NextGen user interface and improves the user
experience by making the entry of hotel tax easier and more accurate.
Configuration / Feature Activation
The feature is automatically available; there are no additional configuration or
activation steps using an updated design that meets accessibility needs.

Personal Expense Now Labeled as Personal on the Expense List
Requested Column
This change is part of the NextGen UI experience.
Overview
The new NextGen user interface (UI) will now show a Personal label on the expense
list screen if the user has selected the Personal Expense (do not reimburse)
option when creating an expense for their expense report.

The label appears under the Requested column for each expense type with this
designation.
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Release Notes: Expenses
BUSINESS PURPOSE / CLIENT BENEFIT
This update clarifies the status of an expense type at the expense list level.
Configuration / Feature Activation
The feature is automatically available; there are no additional configuration or
activation steps.

Prompt to Register Car When Using Mileage Expense Type
This change is part of the NextGen UI experience.
Overview
The new NextGen user interface (UI) will now, under certain conditions, display a
prompt to register a car when a user enters a Mileage expense type in their expense
report. This message only appears when the conditions require that a Personal or
Company car be registered by the user, and they have not yet done so.
User Experience
When a user first attempts to use a Mileage expense type, the system will determine
if an unregistered car condition for either a Personal or Company car exists for the
user and then display the prompt.
USER EXPERIENCE - PERSONAL CAR
If a Personal car registration requirement is associated with the user’s configuration,
a message will appear to the user explaining the requirement and including a link to
perform the task of car registration.
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Release Notes: Itemizations
USER EXPERIENCE - COMPANY CAR
For a Company car, the message is similar, including the message and a link.

In both scenarios the user must register the car before they can continue entering
the Mileage-related expense types.
BUSINESS PURPOSE / CLIENT BENEFIT
This update prevents the user from completing a Mileage expense type when the
company has configured Expense to require car registration by that user.
Configuration / Feature Activation
The feature is automatically available; there are no additional configuration or
activation steps.

Itemizations
Display Itemizations in the Expense Report Page
This change is part of the NextGen UI experience.
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Release Notes: Itemizations
Overview
With this release, the user may now review their itemizations by opening them
directly within the expense report page view.
User Experience
To open this view, the user clicks the arrow ( ) to open the single-line parent entry
to a multi-line view that lists all the itemizations contained in the parent entry.

If required, a scroll bar allows the user to move through the rows to view all the
itemizations related to the open report.
BUSINESS PURPOSE / CLIENT BENEFIT
This update adds another viewing method to the display of the expense report,
improving the user’s experience by making itemizations easily accessible for review
prior to submitting the expense report.
Configuration / Feature Activation
The feature is automatically available; there are no configuration or activation steps.
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NextGen UI
**Ongoing** Updated User Interface (UI) for Concur Expense End
Users
Information First Published

Information Last Modified

Automatic Transition Date

Mar 2018

Sep 16, 2022

Oct 1, 2022

Any changes since the previous monthly release are highlighted in yellow in this release note.

Overview
The continued evolution of the Concur Expense solution user interface experience is
the result of thoughtful design and research that provides a modern, intuitive, and
streamlined experience for creating and submitting expense reports.
Concur Expense customers are now strongly encouraged to preview and then move
to the NextGen UI well before the automatic transition that begins October 1,
2022.
BUSINESS PURPOSE / CLIENT BENEFIT
The result is the next generation of the Concur Expense user interface designed to
provide a modern, consistent, and streamlined user experience. This technology not
only provides an enhanced user interface, but also allows us to react more quickly to
customer requests to meet changing needs as they happen.
Products and Users Affected
To take advantage of these improvements, Concur Expense customers who do not
move before October 1, 2022 will be automatically transitioned to the NextGen UI for
Concur Expense beginning October 1, 2022. The following provides information
about the timeline and resources available to ensure this process is smooth and
efficient for all users.
These UI changes apply to:
•

Concur Expense (Professional/Premium and Standard) end users only
NOTE: There are no changes for approvers, processors, or admins.

IMPORTANT: Timeline and Milestones
There are four important milestones for Concur Expense customers as they transition
from the existing UI to the NextGen UI.
1. Early Access Period: March 2018 – July 2020

During this time, the updated UI was available to preview for customers
worldwide. We encouraged administrators/power users to use the Early
SAP Concur Release Notes
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Release Notes: NextGen UI
Access Period to preview the refreshed interface, update internal training
materials, and prepare the organization for the transition.
2. Opt-In Period: July 2020 – September 2021

Following the Early Access Period was an open Opt-In Period. This milestone
was marked by the delivery of most planned features as well as further
overall product quality and stability.
Customers should use this period to plan their transition and move to the
NextGen UI for Concur Expense when it is right for your business priorities.
Some remaining features will become available throughout this period, so
customers should plan their roll out accordingly.
3. Active Move Period: October 2021 – September 2022

This is the 12-month notice period we committed to for customers to
complete the transition at their own pace before the automatic transition
date.
Customers are strongly encouraged to complete the tasks necessary to
ensure a smooth transition for their organization and then transition during
the Active Move Period.
4. Automatic Transition Date: Beginning October 1, 2022

All customers will be automatically transitioned to the NextGen UI
beginning October 1, 2022. This ensures that we continue to offer a
consistent user experience for all customers and allows for superior product
innovation and support.
Transition Materials – Guides and Other Resources
We offer several guides, FAQs, release notes, and other resources to help in the
transition. All the information that an organization needs to get started is available
here:
•

Professional Edition

•

Standard Edition

The links above provide access to the following:
•

Admin guides, FAQs, transition resources: The admin guide provides
information about accessing the NextGen UI for Concur Expense and the
roles/permissions required.
Along with the admin guide, there are FAQs, other resources (such as e-mail
templates and other training materials), and a list of features that are not yet
available in the NextGen UI for Concur Expense. All of these materials can be
used to help customers prepare their users.
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NOTE: To help with training needs, customers can use the admin guide and
end-user guide "as is" or they can use any part of them to create
training materials. Customers can cut, copy, paste, delete, or edit
either guide at will.
•

End-User guide: This guide compares the existing UI to the NextGen UI for
Concur Expense to help users become comfortable with the new experience.
This guide will be updated as needed during the Opt-In Period as the NextGen
UI is being enhanced. Admins should review the guide often.
NOTE: Like the admin guide, the organization can cut, copy, paste, delete, or
edit this guide at will.

•

Release information: During the Active Move Period, the release of
enhancements will not be on the regular release schedule. Instead, we will
provide special information about features and enhancements that are
nearing release.

As of the May 2022 release, release notes for the NextGen UI can be found within
this release note document. The statement These changes are part of the NextGen
UI experience is displayed at the beginning of each NextGen UI release note.

Travel Allowance Service
Enhancement to Single Day Travel in U.S. Rate Bundle
This change is part of the NextGen UI experience.
Overview
With the release of the new U.S. rate bundle, trips may now be configured in
minutes. This update supports users whose travel spans two calendar days (for
example, over Midnight) during a trip exceeding 12, but not 24, total hours, without
accommodation.
User Experience
The user will automatically draw on the highest Meal rate per day under this scenario
by simply entering their trip and itinerary as usual – the rate is honored
systematically without any additional work by the traveler.
Admin Experience
The Travel Allowance Service admin will see two new configuration values for
existing rules which add parameters for minimum and maximum length of trip in
minutes where, prior to this change, the length of trip was determined in days.
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The two new value configurations are included in the existing rules as follows:
•

Several locations in a reimbursement interval, Domestic: Rate of the
last location, but highest rate of all locations in case of a 2-day trip without
overnight.

•

Several locations in a reimbursement interval, Foreign: Rate of the last
location, but giving preference to the last foreign location, but highest rate of
all locations in case of a trip less than 24 hours without overnight

BUSINESS PURPOSE / CLIENT BENEFIT
This update provides increased flexibility for travel under a single day.
Configuration / Feature Activation
These enhancements are automatically available in the Rate Bundle; no activation is
required.
For more information, refer to the Concur Expense: Travel Allowance Generic
Configurable Bundle setup guide.
SAP Concur Release Notes
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New Itinerary Coverage Option for First and Last Day of Trip
This change is part of the NextGen UI experience.
Overview
With the release, a new option is available that applies when the admin is configuring
start and end times that, when applied, allow or disallow allowances based on an
itinerary’s overlap of these set times.
Admin Experience
The Travel Allowance Service admin working with a rate bundle (Add; Edit) may elect
to set a start and end time, in minutes, using options in the Time Spent on Trip in
a Day section of the page.

This time range is measured systematically by Expense against the traveler’s
itinerary for any overlap which, depending on the overlap, results in an allowance
being allowed or disallowed based on the selection of an option under Itinerary
Coverage.
A New Option
With this release, a new option, The itinerary must not cover any part of the period
between start and end time, is available under Itinerary Coverage.

SAP Concur Release Notes
Release Date: September 17, 2022
Initial Post: September 16, 2022

Page 19

Expense Professional / Premium
Client FINAL

Release Notes: Travel Allowance Service

When in effect, if the itinerary overlaps any time within the range, the allowance is
not honored. As an example, if the set times are 12:00 and 19:00, the itinerary must
not fall within these times for the allowance to be honored.
BUSINESS PURPOSE / CLIENT BENEFIT
This update provides increased flexibility for first and last days of travel.
Configuration / Feature Activation
These enhancements are automatically available in the Rate Bundle; no activation is
required.
For more information, refer to the Concur Expense: Travel Allowance Generic
Configurable Bundle setup guide.
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Planned Changes: There are no planned changes this month.

Planned Changes
The items in this section are targeted for future releases. SAP Concur reserves the
right to postpone implementation of – or completely remove – any
enhancement/change mentioned here.
NOTE: The planned changes listed in this document are specific to this product. For
information about planned site-wide or shared changes that might impact
your SAP Concur solutions, refer to the Shared Changes Release Notes.

There are no planned changes this month.
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Client Notifications
Accessibility
Accessibility Updates
SAP implements changes to better meet current Web Content Accessibility Guidelines
(WCAG). Information about accessibility-related changes made to SAP Concur
solutions is published on a quarterly basis. You can review the quarterly updates on
the Accessibility Updates page.

Subprocessors
SAP Concur Non-Affiliated Subprocessors
The list of non-affiliated subprocessors is available from the SAP Sub-processors /
Data Transfer Factsheets page.

 To access the SAP Concur Sub-processors List:
1. Click the following link to navigate to the SAP Sub-processors / Data Transfer

Factsheets page:
SAP Sub-processors / Data Transfer Factsheets
2. Sign in to the SAP Support Portal using your Support User ID (S-user) and

password.
NOTE: SAP customers must sign in to the SAP Support Portal using their
Support User ID (S-user) and password. For information about S-User
IDs, refer to Your New Support User ID (S-user).
3. On the SAP Sub-processors / Data Transfer Factsheets page, type "Concur" in

the Search field.
4. In the Title column, click SAP Concur Sub-processors List.

If you have questions or comments, please reach out to: PrivacyRequest@Concur.com
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Supported Browsers
Supported Browsers and Changes to Support
For information about supported browsers and planned changes to supported
browsers, refer to the Concur Travel & Expense Supported Configurations guide.
When changes to browser support are planned, information about those changes will
also appear in the Shared Changes Release Notes.
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Additional Release Notes and Other Technical
Documentation
Online Help
You can access release notes, setup guides, user guides, admin summaries,
supported configurations, and other resources via the in-product Help menu or on
the SAP Help Portal.
To access the full set of documentation for your product, use the links in the SAP
Concur Help menu, or search for your SAP Concur product (Concur Expense, Concur
Invoice, Concur Request, or Concur Travel) on the SAP Help Portal
(https://help.sap.com).

SAP Concur Support Portal – Selected Users
Access release notes, webinars, and other technical documentation on the SAP
Concur support portal.
If you have the required permissions, Contact Support is available on the SAP
Concur Help menu and in the SAP Concur page footer.

Click Contact Support to access the SAP Concur support portal, then click
Resources.
•

Click Release/Tech Info for release notes, technical documents, etc.

•

Click Webinars for recorded and live webinars.
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Cases
Check Support Case Status
The steps in this procedure provide instructions for checking whether a case is
resolved.

 To check the status of a submitted case
1. Log on to https://concursolutions.com/portal.asp.
2. Click Help > Contact Support.

NOTE: If you do not have the option to contact SAP Concur support under the Help
menu, then your company has chosen to support the SAP Concur service
internally. Please contact your internal support desk for assistance.
3. Click Support > View Cases.
4. In the table, view the desired type of cases based on the View list selection.

Search results are limited to each company's own cases.
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© 2022 SAP SE or an SAP affiliate company. All rights
reserved.
No part of this publication may be reproduced or transmitted in any form or for any
purpose without the express permission of SAP SE or an SAP affiliate company.
SAP and other SAP products and services mentioned herein as well as their
respective logos are trademarks or registered trademarks of SAP SE (or an SAP
affiliate company) in Germany and other countries. Please see
http://global12.sap.com/corporate-en/legal/copyright/index.epx for additional
trademark information and notices.
Some software products marketed by SAP SE and its distributors contain proprietary
software components of other software vendors.
National product specifications may vary.
These materials are provided by SAP SE or an SAP affiliate company for
informational purposes only, without representation or warranty of any kind, and
SAP SE or its affiliated companies shall not be liable for errors or omissions with
respect to the materials. The only warranties for SAP SE or SAP affiliate company
products and services are those that are set forth in the express warranty
statements accompanying such products and services, if any. Nothing herein should
be construed as constituting an additional warranty.
In particular, SAP SE or its affiliated companies have no obligation to pursue any
course of business outlined in this document or any related presentation, or to
develop or release any functionality mentioned therein. This document, or any
related presentation, and SAP SE’s or its affiliated companies’ strategy and possible
future developments, products, and/or platform directions and functionality are all
subject to change and may be changed by SAP SE or its affiliated companies at any
time for any reason without notice. The information in this document is not a
commitment, promise, or legal obligation to deliver any material, code, or
functionality. All forward-looking statements are subject to various risks and
uncertainties that could cause actual results to differ materially from expectations.
Readers are cautioned not to place undue reliance on these forward-looking
statements, which speak only as of their dates, and they should not be relied upon in
making purchasing decisions.
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Legal Disclaimer
The information in this presentation is confidential and proprietary to SAP SE or an
SAP affiliate company and may not be disclosed without the permission of SAP SE or
the respective SAP affiliate company. This presentation is not subject to your license
agreement or any other service or subscription agreement with SAP SE or its
affiliated companies. SAP SE and its affiliated companies have no obligation to
pursue any course of business outlined in this document or any related presentation,
or to develop or release any functionality mentioned therein. This document, or any
related presentation and SAP SE or an SAP affiliate company’s strategy and possible
future developments, products and or platforms directions and functionality are all
subject to change and may be changed by SAP SE and its affiliated companies at any
time for any reason without notice. The information in this document is not a
commitment, promise or legal obligation to deliver any material, code or
functionality. This document is provided without a warranty of any kind, either
express or implied, including but not limited to, the implied warranties of
merchantability, fitness for a particular purpose, or non-infringement. This document
is for informational purposes and may not be incorporated into a contract. SAP SE
and its affiliated companies assume no responsibility for errors or omissions in this
document, except if such damages were caused by SAP SE or an SAP affiliate
company’s willful misconduct or gross negligence.
All forward-looking statements are subject to various risks and uncertainties that
could cause actual results to differ materially from expectations. Readers are
cautioned not to place undue reliance on these forward-looking statements, which
speak only as of their dates, and they should not be relied upon in making
purchasing decisions.
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Release Notes
This document contains the release notes for Concur Expense professional edition.
NOTE: Features and changes that apply to SAP Concur site-wide or to multiple
products/services are documented in the Shared Changes Release Notes. For
information about site-wide or shared changes in this release that might
impact your SAP Concur solutions, refer to the Shared Changes Release
Notes.

Cards
VISA: Reduction of Required Attributes for Generating Rich Data for
Cards
Overview
With this release, the attributes required to generate rich data output for company
cards is now reduced in number for all import formats (except in the CDF3 format
where this requirement was already present). This change allows for all card import
formats to have more transactions flagged as rich data in Expense.
The attribute Arrival Date is now removed from the list of required attributes in the
Visa format. Clients should consider if this feature change impacts the way they work
with their receipts.
BUSINESS PURPOSE / CLIENT BENEFIT
This change will result in a more consistent rich data experience and more card
transactions rendered in rich data format.
Configuration / Feature Activation
The feature is automatically available; there are no additional configuration or
activation steps.

Japan Public Transport (JPT)
Support End Notice for Legacy JPT
All Concur Expense customers using legacy JPT (JPT 1.0) will be automatically
migrated to JPT on NextGen UI (NUI) effective October 1. Support for legacy JPT
ends on September 30, 2022. The team will no longer investigate or fix issues
reported by CRMC tickets if the issue is reproduced on legacy JPT but not on JPT on
NUI. If updates are required on the existing legacy JPT expenses, we recommend
that you create new expenses on JPT on NUI and delete the old ones.
SAP Concur Release Notes
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For any JPT on NUI support, authorized support contacts can submit a support case
through the Customer Support portal.

NextGen UI
**Ongoing** Updated User Interface (UI) for Concur Expense End
Users
Information First Published

Information Last Modified

Automatic Transition Date

Mar 2018

Oct 7, 2022

Oct 1, 2022

Any changes since the previous monthly release are highlighted in yellow in this release note.

Overview
The continued evolution of the Concur Expense solution user interface experience is
the result of thoughtful design and research that provides a modern, intuitive, and
streamlined experience for creating and submitting expense reports.
Concur Expense customers were strongly encouraged to preview and then move to
the NextGen UI well before the automatic transition that began October 1, 2022.
BUSINESS PURPOSE / CLIENT BENEFIT
The result is the next generation of the Concur Expense user interface designed to
provide a modern, consistent, and streamlined user experience. This technology not
only provides an enhanced user interface, but also allows us to react more quickly to
customer requests to meet changing needs as they happen.
Products and Users Affected
To take advantage of these improvements, Concur Expense customers who did move
before October 1, 2022 are being automatically transitioned to the NextGen UI for
Concur Expense beginning October 1, 2022. The following provides information
about the timeline and resources available to ensure this process is smooth and
efficient for all users.
These UI changes apply to:
•

Concur Expense (Professional/Premium and Standard) end users only
NOTE: There are no changes for approvers, processors, or admins.

IMPORTANT: Timeline and Milestones
There are four important milestones for Concur Expense customers as they transition
from the existing UI to the NextGen UI.
1. Early Access Period: March 2018 – July 2020
SAP Concur Release Notes
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During this time, the updated UI was available to preview for customers
worldwide. We encouraged administrators/power users to use the Early
Access Period to preview the refreshed interface, update internal training
materials, and prepare the organization for the transition.
2. Opt-In Period: July 2020 – September 2021

Following the Early Access Period was an open Opt-In Period. This milestone
was marked by the delivery of most planned features as well as further
overall product quality and stability.
Customers should use this period to plan their transition and move to the
NextGen UI for Concur Expense when it is right for your business priorities.
Some remaining features will become available throughout this period, so
customers should plan their roll out accordingly.
3. Active Move Period: October 2021 – September 2022

This is the 12-month notice period we committed to for customers to
complete the transition at their own pace before the automatic transition
date.
Customers are strongly encouraged to complete the tasks necessary to
ensure a smooth transition for their organization and then transition during
the Active Move Period.
4. Automatic Transition Date: Began October 1, 2022

All customers are being automatically transitioned to the NextGen UI
beginning October 1, 2022. This ensures that we continue to offer a
consistent user experience for all customers and allows for superior product
innovation and support.
Transition Materials – Guides and Other Resources
We offer several guides, FAQs, release notes, and other resources to help in the
transition. All the information that an organization needs to get started is available
here:
•

Professional Edition

•

Standard Edition

The links above provide access to the following:
•

Admin guides, FAQs, transition resources: The admin guide provides
information about accessing the NextGen UI for Concur Expense and the
roles/permissions required.
Along with the admin guide, there are FAQs, other resources (such as e-mail
templates and other training materials), and a list of features that are not yet
available in the NextGen UI for Concur Expense. All of these materials can be
used to help customers prepare their users.
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NOTE: To help with training needs, customers can use the admin guide and
end-user guide "as is" or they can use any part of them to create
training materials. Customers can cut, copy, paste, delete, or edit
either guide at will.
•

End-User guide: This guide compares the existing UI to the NextGen UI for
Concur Expense to help users become comfortable with the new experience.
This guide will be updated as needed during the Opt-In Period as the NextGen
UI is being enhanced. Admins should review the guide often.
NOTE: Like the admin guide, the organization can cut, copy, paste, delete, or
edit this guide at will.

•

Release information: During the Active Move Period, the release of
enhancements will not be on the regular release schedule. Instead, we will
provide special information about features and enhancements that are
nearing release.
As of the May 2022 release, release notes for the NextGen UI can be found
within this release note document. The statement These changes are part of
the NextGen UI experience is displayed at the beginning of each NextGen UI
release note.

Travel Allowance Service
JTR Statutory Bundle Enhancement: Actual Expense Authorized
This change is part of the NextGen UI experience.
Overview
With this release, the Joint Travel Regulations (JTR) statutory bundle is now updated
with Actual Expense Authorized functionality (aka Actuals vs. Limits, Percentage rule,
or 300% rule). Actuals vs. Limits is the Travel Allowance Service equivalent to the
reimbursable allowances in the legacy Travel Allowance product.
ABOUT ACTUAL EXPENSE AUTHORIZED
Actual Expense Authorized (AEA) is a regulation in the U.S. market wherein travelers
are allowed to exceed the travel allowance limit up to a defined percentage on
certain days of their itinerary, while still receiving actuals up to the limit on other
days of their itinerary.
In general, AEA is split into two categories:
•

No Itemization: This sets Meals and Incidentals as daily allowances and
Lodging as an actual expense, establishing the multiplier percentage using a
specialized calculation.
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•

Itemization: (Most common scenario) Lodging and Meals are set as actual
expenses that are calculated independently and may be configured as actual
expenses or daily allowances in this scenario.

How It Works
Actual vs Limits applies only to the Lodging, Meals, and Incidentals rate categories.
Depending on configuration, each may be independently configured from the other
as follows:
•

Daily Allowance: Current functionality where the user is paid no more than
the capped limit based on travel allowance calculations.

•

Up to (the) Limit: Reimbursement is capped at the limit or, if less, the
actual expense.

•

Over Limit (with) Tracking: Reimbursement may exceed the limit and, if
more, is paid out at the actual expense.

•

Not Used: The rate category is not active in the bundle.

NOTE: Meal and Incidental rate category types must share the same
configuration – this is enforced by Expense on selection.
COMBINING THE ACTUALS VS. LIMITS CALCULATIONS
The admin may combine rate categories so that calculations are performed on two or
more categories within an expense report. For example, if the traveler’s itinerary is
configured as Up to (the) Limit and their combined expenses exceed their daily
limits, the system will pro-rate the expense. This is done by calculating the expense
amount’s percentage of the expense category amount and applying that percentage
as a pro-ration.
•

Meals and Incidentals / Meals, Incidentals, and Lodging: The sum of
the allowances acts as a daily limit on the sum of the expenses.

•

None: Default – no combining of expenses.
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User Experience
For the user, the configuration guides the reimbursement logic, but they are
provided the key capability of exceeding their limit and invoking the actual expense
by selecting the Actual Expense Authorized check box for each expense they want
considered. This is done in the Adjustments page.
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The user may view the summary of the actual expense amounts, allowance limit
amounts, overage amounts and finally the reimbursement amounts by selecting the
Reimbursable Allowances Summary item from the Travel Allowance menu.
Note the selection above for Tuesday the 11 th, and the resulting calculation for that
day’s expenses.

Admin Experience
While the admin may customize several options for this feature, the logic and
systematic calculations are embedded in the statutory rate bundle itself. The choice
of the rate bundle will depend on the choice of itemization vs. no itemization.

Suppression of Expected Expenses in Request
To avoid duplicate lodgings, meals, and incidental expense types, these “expected”
expenses will be suppressed in the Request product when the Actuals vs. Limits
functionality is enabled in the Expense product.
BUSINESS PURPOSE / CLIENT BENEFIT
These updates bring parity in functionality between the Travel Allowance Service and
the legacy Travel Allowance.
Configuration / Feature Activation
The Travel Allowance admin will need to work with the Configuration Codes
functionality to implement the Actuals vs Limits feature.
SAP Concur Release Notes
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For more information, refer to the Expense: Travel Allowance setup guide and
the Concur Expense: Travel Allowance Generic Configurable Bundle setup
guide.
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Planned Changes
The items in this section are targeted for future releases. SAP Concur reserves the
right to postpone implementation of – or completely remove – any
enhancement/change mentioned here.
NOTE: The planned changes listed in this document are specific to this product. For
information about planned site-wide or shared changes that might impact
your SAP Concur solutions, refer to the Shared Changes Release Notes.

Bank Information
**Planned Changes** Western Union Business Solutions
Rebranding to Convera
Information First Published
Information Last Modified
Feature Target Release Date
October 2022
-January 2023
Any changes since the previous monthly release are highlighted in yellow in this release note.

Overview
Expense Pay payment provider Western Union Business Solutions (WUBS) was
acquired in 2021. They have now officially rebranded as Convera.
BUSINESS PURPOSE / CLIENT BENEFIT
To support SAP Concur’s payment processing partner Convera, the Expense Pay,
Global Pay, and Payment Manager user interfaces and documentation will be updated
to reflect the most current rebranded name.
User Experience
User interface components such as labels, messages, and documentation that show
Western Union or Western Union Business Solutions will be now display Convera.
Configuration / Feature Activation
The change will be automatically available; there are no configuration or activation
steps.

SAP Concur Release Notes
Release Date: October 15, 2022
Initial Post: October 14, 2022

Page 9

Concur Expense Professional / Premium
Client FINAL

Client Notifications: Accessibility

Client Notifications
Accessibility
Accessibility Updates
SAP implements changes to better meet current Web Content Accessibility Guidelines
(WCAG). Information about accessibility-related changes made to SAP Concur
solutions is published on a quarterly basis. You can review the quarterly updates on
the Accessibility Updates page.

Subprocessors
SAP Concur Non-Affiliated Subprocessors
The list of non-affiliated subprocessors is available from the SAP Sub-processors /
Data Transfer Factsheets page.

 To access the SAP Concur Sub-processors List:
1. Click the following link to navigate to the SAP Sub-processors / Data Transfer

Factsheets page:
SAP Sub-processors / Data Transfer Factsheets
2. Sign in to the SAP Support Portal using your Support User ID (S-user) and

password.
NOTE: SAP customers must sign in to the SAP Support Portal using their
Support User ID (S-user) and password. For information about S-User
IDs, refer to Your New Support User ID (S-user).
3. On the SAP Sub-processors / Data Transfer Factsheets page, type "Concur" in

the Search field.
4. In the Title column, click SAP Concur Sub-processors List.

If you have questions or comments, please reach out to: PrivacyRequest@Concur.com
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Supported Browsers
Supported Browsers and Changes to Support
For information about supported browsers and planned changes to supported
browsers, refer to the Concur Travel & Expense Supported Configurations guide.
When changes to browser support are planned, information about those changes will
also appear in the Shared Changes Release Notes.
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Additional Release Notes and Other Technical
Documentation
Online Help
You can access release notes, setup guides, user guides, admin summaries,
supported configurations, and other resources via the in-product Help menu or on
the SAP Help Portal.
To access the full set of documentation for your product, use the links in the SAP
Concur Help menu, or search for your SAP Concur product (Concur Expense, Concur
Invoice, Concur Request, or Concur Travel) on the SAP Help Portal
(https://help.sap.com).

SAP Concur Support Portal – Selected Users
Access release notes, webinars, and other technical documentation on the SAP
Concur support portal.
If you have the required permissions, Contact Support is available on the SAP
Concur Help menu and in the SAP Concur page footer.

Click Contact Support to access the SAP Concur support portal, then click
Resources.
•

Click Release/Tech Info for release notes, technical documents, etc.

•

Click Webinars for recorded and live webinars.
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Cases
Check Support Case Status
The steps in this procedure provide instructions for checking whether a case is
resolved.

 To check the status of a submitted case
1. Log on to https://concursolutions.com/portal.asp.
2. Click Help > Contact Support.

NOTE: If you do not have the option to contact SAP Concur support under the Help
menu, then your company has chosen to support the SAP Concur service
internally. Please contact your internal support desk for assistance.
3. Click Support > View Cases.
4. In the table, view the desired type of cases based on the View list selection.

Search results are limited to each company's own cases.
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© 2022 SAP SE or an SAP affiliate company. All rights
reserved.
No part of this publication may be reproduced or transmitted in any form or for any
purpose without the express permission of SAP SE or an SAP affiliate company.
SAP and other SAP products and services mentioned herein as well as their
respective logos are trademarks or registered trademarks of SAP SE (or an SAP
affiliate company) in Germany and other countries. Please see
http://global12.sap.com/corporate-en/legal/copyright/index.epx for additional
trademark information and notices.
Some software products marketed by SAP SE and its distributors contain proprietary
software components of other software vendors.
National product specifications may vary.
These materials are provided by SAP SE or an SAP affiliate company for
informational purposes only, without representation or warranty of any kind, and
SAP SE or its affiliated companies shall not be liable for errors or omissions with
respect to the materials. The only warranties for SAP SE or SAP affiliate company
products and services are those that are set forth in the express warranty
statements accompanying such products and services, if any. Nothing herein should
be construed as constituting an additional warranty.
In particular, SAP SE or its affiliated companies have no obligation to pursue any
course of business outlined in this document or any related presentation, or to
develop or release any functionality mentioned therein. This document, or any
related presentation, and SAP SE’s or its affiliated companies’ strategy and possible
future developments, products, and/or platform directions and functionality are all
subject to change and may be changed by SAP SE or its affiliated companies at any
time for any reason without notice. The information in this document is not a
commitment, promise, or legal obligation to deliver any material, code, or
functionality. All forward-looking statements are subject to various risks and
uncertainties that could cause actual results to differ materially from expectations.
Readers are cautioned not to place undue reliance on these forward-looking
statements, which speak only as of their dates, and they should not be relied upon in
making purchasing decisions.
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Legal Disclaimer
The information in this presentation is confidential and proprietary to SAP SE or an
SAP affiliate company and may not be disclosed without the permission of SAP SE or
the respective SAP affiliate company. This presentation is not subject to your license
agreement or any other service or subscription agreement with SAP SE or its
affiliated companies. SAP SE and its affiliated companies have no obligation to
pursue any course of business outlined in this document or any related presentation,
or to develop or release any functionality mentioned therein. This document, or any
related presentation and SAP SE or an SAP affiliate company’s strategy and possible
future developments, products and or platforms directions and functionality are all
subject to change and may be changed by SAP SE and its affiliated companies at any
time for any reason without notice. The information in this document is not a
commitment, promise or legal obligation to deliver any material, code or
functionality. This document is provided without a warranty of any kind, either
express or implied, including but not limited to, the implied warranties of
merchantability, fitness for a particular purpose, or non-infringement. This document
is for informational purposes and may not be incorporated into a contract. SAP SE
and its affiliated companies assume no responsibility for errors or omissions in this
document, except if such damages were caused by SAP SE or an SAP affiliate
company’s willful misconduct or gross negligence.
All forward-looking statements are subject to various risks and uncertainties that
could cause actual results to differ materially from expectations. Readers are
cautioned not to place undue reliance on these forward-looking statements, which
speak only as of their dates, and they should not be relied upon in making
purchasing decisions.
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Release Notes
This document contains the release notes for Concur Expense professional edition.
NOTE: Features and changes that apply to SAP Concur site-wide or to multiple
products/services are documented in the Shared Changes Release Notes. For
information about site-wide or shared changes in this release that might
impact your SAP Concur solutions, refer to the Shared Changes Release
Notes.

Exchange Rates
Foreign Exchange Rate Enhancements for Regulatory Compliance
Overview
SAP Concur Expense is providing a new configuration option that will allow the
Expense admin to set the foreign currency exchange rates to now be assessed based
on one of the following three settings options:
•

Transaction Date (Default): Date the expense was incurred

•

Report Start Date: Trip start date as entered in the Report header

•

Report End Date: Trip end date as entered in the Report header

Once the setting is configured in Group Configurations it is the default for all Expense
users working within that group, for all reports that contain foreign currency
transactions, and cannot be changed by the user.
USER EXPERIENCE
If the default Transaction Date setting is used, users under this option will not
notice any change in Concur Expense and exchange rates will continue to default
based on the date the expense transaction was incurred.
If either the Report Start Date or Report End Date option is selected for an
Expense Group, users will notice the following behavior:
Report Status
When the report is
being created

Behavior Based on Start or End Date Setting Configuration
• Once an impacted foreign currency transaction is added to the

report, a notification message is displayed to the user informing
them that the exchange rate is subject to change and will be
finalized on report submission
• The initial exchange rate for an expense will be based on the

transaction date
• Updating the Report Start Date or Report End Date value will

not result in real-time re-calculations of the exchange rate
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Report Status
When the report is
submitted

Behavior Based on Start or End Date Setting Configuration
• Exchange rates are calculated and updated in the submit preview

screen, and reflected on the Report Totals page with that
process
• A notification will be displayed informing the user that the

exchange rates may change
After the report is
submitted

• Report will show the updated exchange rate and the result in the

Report Totals
No notifications will be displayed regarding the exchange rate
calculation basis.

EXCLUSIONS TO THESE CHANGES
The Group setting will not affect the behavior of the following transaction types
which will continue to use the default Transaction Date for foreign currency
exchange rates:
•

Linked Credit Card transactions (Corporate or Personal)

•

Daily (fixed) Travel Allowance Expenses

•

Expenses without conversions

NOTE: Linked Credit Card transactions only covers transactions on credit cards that
are registered with Concur Expense for a specific user, with transaction
information that is passed electronically by the card provider to Concur
Expense. Manually entered expenses that are paid for with an unlinked credit
card will be subject to the Report Start Date or Report End Date date
basis rate calculation.
EFFECTIVE DATES FOR THIS CHANGE
The changes described in this release note will take effect in two stages:
•

Configuration Setting Ready December 2nd: The Expense admin may
adjust this setting for all users in a group using the new options in Group
Configurations starting on December 2nd

•

User Will See Change December 12th: The functional changes, including
updated messaging for the Report Start Date and Report End Date
settings, will be in effect staring on December 12th for all users working in a
Group configured to use the new settings

BUSINESS PURPOSE / CLIENT BENEFIT
Certain countries mandate that the exchange rate used for expense reporting is
based on a date choice defined in their federal regulatory rules. This enhancement to
Concur Expense provides configurable options to base this date on Report Start
Date, Report End Date or Transaction Date.
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Configuration / Feature Activation
This feature requires configuration to take advantage of the new options. If no
configuration is performed the employees will see no changes to current behavior.
Use the procedure below to change from the default Transaction Date setting to an
alternative date choice.

 To configure Group Configuration for this setting:
1. Click Administration > Expense > Group Configurations.

2. Click a group then click Modify to open Configuration for Group -

<Name>.
3. Scroll to Foreign currency exchange rate basis date and change the

configuration as required.

4. Click Save.
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SAP/SAP Concur Integrations
**Ongoing** SAP Integration with Concur Solutions (ICS) for SAP
ECC and SAP S/4HANA On-Premise Required Authentication Update
Information First Published

Information Last Modified

Cutoff Date

Nov 2022

N/A

Dec 31, 2023

Any changes since the previous monthly release are highlighted in yellow in this release note.

Overview
SAP ICS customers are using two different authentication methods:
•

Legacy authentication (without gateway)

•

New gateway authentication based on Company JSON Web Token (JWT)

SAP Concur has now consolidated the different methods into one target method: the
new gateway authentication based on the company JWT (aka Oauth2.0). Currently,
we are using both, the old user and password-based legacy authentication for most
of the API calls and a company JWT-based authentication via the API gateway for
some dedicated APIs.
To ensure there's no disruption for connections between SAP ECC or SAP S/4HANA
on-premise and SAP Concur, we have defined a transition period that allows a
transformation from legacy authentication to company JWT-based authentication at
your own pace. All customers must be using the company JWT-based authentication
by December 31, 2023. After December 31, 2023, the legacy authentication will stop
working.
You must enable your SAP ECC or SAP S/4HANA on-premise system to perform this
transformation, including updating to a supported release/support package if
necessary. Please refer to the following information for details about supported
releases/support packages and configuration steps:
•

SAP Note 2914977 - FAQ: Concur Certificates, Authentication, and
Connectivity
NOTE: All customers should sign up for the ICS newsletter following the
instructions in this note.

•

Knowledge base Article 3079239 - Connection: Transformation to New
Gateway

•

Knowledge base Article 3097704 - SAP ICS: Transformation to New Gateway
is Failing
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Production Sandbox Environments
Customers with Production Sandbox Environment (PSE) entities that are using legacy
authentication with ICS will need to perform maintenance to their authentication
information ASAP to continue using ICS. Customers using the company JWT-based
authentication are exempt from this maintenance.



For more information, refer to the **Ongoing** Production Sandbox
Environment Login Updates release note in the SAP Concur Shared Changes
Release Notes.

BUSINESS PURPOSE / CLIENT BENEFIT
This authentication update provides improved security over the legacy authentication
method.
Configuration / Feature Activation
Please refer to the latest SAP Integration with Concur Solutions newsletter for more
information about the configuration process:
SAP Integration with SAP Concur Solutions Edition 2202 10.pdf
If you don´t have access to the JAM Page, send an email with the subject “Jam
Access” to sapconcurintegration@sap.com.

Travel Allowance Service
(Norway) Updated Calculation Rules for Compensation Allowance
Overview
SAP Concur has changed the rule options for the following rate types:
Rate Type

Rule Name

Updated Rule Option

Compensation Allowance

Several domestic locations in a
domestic reimbursement
interval, foreign

No special handling for
domestic locations

Admin Experience
This change displays the updated rule option on the View calculation rules of rate
type: "Compensation Allowance" page. To view the change in the
SAP_CONCUR_NO_STATE and SAP_CONCUR_NO_TAXFREE statutory bundles, open
the View Rate Bundle page, and navigate to Rate Types > View > View Rate
Types page. Select the required Compensation Allowance rate type.
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Release Notes: User Interface Changes
BUSINESS PURPOSE / CLIENT BENEFIT
This configuration maintains best practices for statutory configuration.
Configuration / Feature Activation
The bundle is automatically updated; there are no configuration or activation steps.



For more information, refer to the Concur Expense: Travel Allowance Norway
Statutory Bundles Setup Guide.

User Interface Changes
Miscellaneous Changes to the User Interface
Overview

The following minor usability changes are part of the ongoing continuous
improvement process for the user experience:
•

Receipts: All instances of Receipt Affidavit are now changed to Receipt
Declaration for the Missing Receipt Declaration function

•

Report Attachment Viewer: To improve usability of button labels and
messaging when working with attachments, the label Append is now
replaced by Add, and Detach now replaced by Remove

SAP Concur Release Notes
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Release Notes: User Interface Changes
•

Delegate Permissions: A delegate with permissions to prepare, but not
submit, expense reports may now edit or change the redirect funds data in
either the Report Details (menu) > Report Totals page (below), or during
the report submission step when the redirect funds feature is enabled.

BUSINESS PURPOSE / CLIENT BENEFIT
These changes improve the user experience in Concur Expense.
Configuration / Feature Activation
The feature is automatically available; there are no additional configuration or
activation steps.
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Planned Changes: Cards

Planned Changes
The items in this section are targeted for future releases. SAP Concur reserves the
right to postpone implementation of – or completely remove – any
enhancement/change mentioned here.
NOTE: The planned changes listed in this document are specific to this product. For
information about planned site-wide or shared changes that might impact
your SAP Concur solutions, refer to the Shared Changes Release Notes.

Cards
**Planned Changes** AMEX: Reauthorization of AMEX Business
Cards Required Starting November 28th and Ending January 31st
Feature Target End Authorization
Date
November 2022
-January 31st 2023
Any changes since the previous monthly release are highlighted in yellow in this release note.

Information First Published

Information Last Modified

Overview
AMEX will be updating the Application Programming Interface (API) which will affect
the use of AMEX business cards for their customers. Specifically, this action will
replace the existing APIs currently supporting, among other things, the import and
use of transactions within the SAP Concur Expense product.
USER EXPERIENCE
For SAP Concur Expense users, once completed, this change will provide continued
connectivity when using the AMEX business cards. However, to ensure a seamless
transition, selected clients using this business card may need to reauthorize their
cards within Expense. This requirement is based on the date they originally
authorized their card.
The following table shows which clients must reauthorize their card:
Client Definition

Required Action Nov 28th, 2022 – Jan 31st, 2023

Any user whose card
was authorized before
November 28th, 2022

Reauthorize your AMEX business card within Expense within the dates
specified in this release note.

Any client authorizing
their card after
November 28th, 2022

No action is required. The updated APIs will be adopted by default for
all cards authorized after this date.

SAP Concur Release Notes
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Planned Changes: ExpensePay Payment Provider Rebranding
Failure to reauthorize the AMEX business card within the specified date range does
not mean the card cannot be reauthorized following January 31st. However, the client
may experience a disruption in transaction activities following January 31st because
all cards authorized under the older APIs will be incompatible with the newer APIs.
ADMIN EXPERIENCE
The admin responsible for use of AMEX business cards at their site should plan their
actions, especially notification of all applicable users, based on this release note. If in
doubt for any given card user, performing the reauthorization task itself will not
result in adverse results and may benefit a client site seeking simplicity in messaging
their users.
BUSINESS PURPOSE / CLIENT BENEFIT
This update is required to ensure continued connectivity for AMEX business cards
within SAP Concur Expense, allowing Expense AMEX card users to enjoy the adoption
of continued API services.

ExpensePay Payment Provider Rebranding
**Planned Changes** Bambora Rebranding to Worldline
Information First Published
Information Last Modified
Feature Target Release Date
November 2022
-January 2023
Any changes since the previous monthly release are highlighted in yellow in this release note.

Overview
Digital payments provider Worldline acquired Bambora in 2021. Instances of
Bambora in the Expense Pay, Global Pay, and Payment Manger screens will be
updated accordingly to support the rebrand to Worldline.
BUSINESS PURPOSE / CLIENT BENEFIT
To support SAP Concur’s payment processing partner Wordline, the Expense Pay,
Global Pay, and Payment Manager user interfaces and documentation will be updated
to reflect the rebranded company name.
User Experience
User interface components such as labels, email addresses, logos and notifications
that show Bambora will be renamed to Worldline over the next few months.
Configuration / Feature Activation
The feature will be automatically available; there are no configuration or activation
steps.
SAP Concur Release Notes
Release Date: November 12, 2022
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**Planned Changes** Western Union Business Solutions
Rebranding to Convera
Information First Published
Information Last Modified
Feature Target Release Date
October 2022
-January 2023
Any changes since the previous monthly release are highlighted in yellow in this release note.

Overview
Expense Pay payment provider Western Union Business Solutions (WUBS) was
acquired in 2021. They have now officially rebranded as Convera.
BUSINESS PURPOSE / CLIENT BENEFIT
To support SAP Concur’s payment processing partner Convera, the Expense Pay,
Global Pay, and Payment Manager user interfaces and documentation will be updated
to reflect the most current rebranded name.
User Experience
User interface components such as labels, messages, and documentation that show
Western Union or Western Union Business Solutions will be now display Convera.
Configuration / Feature Activation
The change will be automatically available; there are no configuration or activation
steps.
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Client Notifications
Accessibility
Accessibility Updates
SAP implements changes to better meet current Web Content Accessibility Guidelines
(WCAG). Information about accessibility-related changes made to SAP Concur
solutions is published on a quarterly basis. You can review the quarterly updates on
the Accessibility Updates page.

Subprocessors
SAP Concur Non-Affiliated Subprocessors
The list of non-affiliated subprocessors is available from the SAP Sub-processors /
Data Transfer Factsheets page.

 To access the SAP Concur Sub-processors List:
1. Click the following link to navigate to the SAP Sub-processors / Data Transfer

Factsheets page:
SAP Sub-processors / Data Transfer Factsheets
2. Sign in to the SAP Support Portal using your Support User ID (S-user) and

password.
NOTE: SAP customers must sign in to the SAP Support Portal using their
Support User ID (S-user) and password. For information about S-User
IDs, refer to Your New Support User ID (S-user).
3. On the SAP Sub-processors / Data Transfer Factsheets page, type "Concur" in

the Search field.
4. In the Title column, click SAP Concur Sub-processors List.

If you have questions or comments, please reach out to: PrivacyRequest@Concur.com
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Client Notifications: Supported Browsers

Supported Browsers
Supported Browsers and Changes to Support
For information about supported browsers and planned changes to supported
browsers, refer to the Concur Travel & Expense Supported Configurations guide.
When changes to browser support are planned, information about those changes will
also appear in the Shared Changes Release Notes.
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Additional Release Notes and Other Technical Documentation: Online Help

Additional Release Notes and Other Technical
Documentation
Online Help
You can access release notes, setup guides, user guides, admin summaries,
supported configurations, and other resources via the in-product Help menu or on
the SAP Help Portal.
To access the full set of documentation for your product, use the links in the SAP
Concur Help menu, or search for your SAP Concur product (Concur Expense, Concur
Invoice, Concur Request, or Concur Travel) on the SAP Help Portal
(https://help.sap.com).

SAP Concur Support Portal – Selected Users
Access release notes, webinars, and other technical documentation on the SAP
Concur support portal.
If you have the required permissions, Contact Support is available on the SAP
Concur Help menu and in the SAP Concur page footer.

Click Contact Support to access the SAP Concur support portal, then click
Resources.
•

Click Release/Tech Info for release notes, technical documents, etc.

•

Click Webinars for recorded and live webinars.
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Cases: Check Support Case Status

Cases
Check Support Case Status
The steps in this procedure provide instructions for checking whether a case is
resolved.

 To check the status of a submitted case
1. Log on to https://concursolutions.com/portal.asp.
2. Click Help > Contact Support.

NOTE: If you do not have the option to contact SAP Concur support under the Help
menu, then your company has chosen to support the SAP Concur service
internally. Please contact your internal support desk for assistance.
3. Click Support > View Cases.
4. In the table, view the desired type of cases based on the View list selection.

Search results are limited to each company's own cases.
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© 2022 SAP SE or an SAP affiliate company. All rights
reserved.
No part of this publication may be reproduced or transmitted in any form or for any
purpose without the express permission of SAP SE or an SAP affiliate company.
SAP and other SAP products and services mentioned herein as well as their
respective logos are trademarks or registered trademarks of SAP SE (or an SAP
affiliate company) in Germany and other countries. Please see
http://global12.sap.com/corporate-en/legal/copyright/index.epx for additional
trademark information and notices.
Some software products marketed by SAP SE and its distributors contain proprietary
software components of other software vendors.
National product specifications may vary.
These materials are provided by SAP SE or an SAP affiliate company for
informational purposes only, without representation or warranty of any kind, and
SAP SE or its affiliated companies shall not be liable for errors or omissions with
respect to the materials. The only warranties for SAP SE or SAP affiliate company
products and services are those that are set forth in the express warranty
statements accompanying such products and services, if any. Nothing herein should
be construed as constituting an additional warranty.
In particular, SAP SE or its affiliated companies have no obligation to pursue any
course of business outlined in this document or any related presentation, or to
develop or release any functionality mentioned therein. This document, or any
related presentation, and SAP SE’s or its affiliated companies’ strategy and possible
future developments, products, and/or platform directions and functionality are all
subject to change and may be changed by SAP SE or its affiliated companies at any
time for any reason without notice. The information in this document is not a
commitment, promise, or legal obligation to deliver any material, code, or
functionality. All forward-looking statements are subject to various risks and
uncertainties that could cause actual results to differ materially from expectations.
Readers are cautioned not to place undue reliance on these forward-looking
statements, which speak only as of their dates, and they should not be relied upon in
making purchasing decisions.
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** DRAFT **
The enhancements and changes described in this document may or may not be
included in this release. SAP Concur reserves the right to postpone implementation
of—or completely remove—any enhancement/change mentioned here.
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Legal Disclaimer
The information in this presentation is confidential and proprietary to SAP SE or an
SAP affiliate company and may not be disclosed without the permission of SAP SE or
the respective SAP affiliate company. This presentation is not subject to your license
agreement or any other service or subscription agreement with SAP SE or its
affiliated companies. SAP SE and its affiliated companies have no obligation to
pursue any course of business outlined in this document or any related presentation,
or to develop or release any functionality mentioned therein. This document, or any
related presentation and SAP SE or an SAP affiliate company’s strategy and possible
future developments, products and or platforms directions and functionality are all
subject to change and may be changed by SAP SE and its affiliated companies at any
time for any reason without notice. The information in this document is not a
commitment, promise or legal obligation to deliver any material, code or
functionality. This document is provided without a warranty of any kind, either
express or implied, including but not limited to, the implied warranties of
merchantability, fitness for a particular purpose, or non-infringement. This document
is for informational purposes and may not be incorporated into a contract. SAP SE
and its affiliated companies assume no responsibility for errors or omissions in this
document, except if such damages were caused by SAP SE or an SAP affiliate
company’s willful misconduct or gross negligence.
All forward-looking statements are subject to various risks and uncertainties that
could cause actual results to differ materially from expectations. Readers are
cautioned not to place undue reliance on these forward-looking statements, which
speak only as of their dates, and they should not be relied upon in making
purchasing decisions.
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Release Notes: Amazon Business Integration

Release Notes
This document contains the release notes for Concur Expense professional edition.
NOTE: Features and changes that apply to SAP Concur site-wide or to multiple
products/services are documented in the Shared Changes Release Notes. For
information about site-wide or shared changes in this release that might
impact your SAP Concur solutions, refer to the Shared Changes Release
Notes.

Amazon Business Integration
Expansion and Enhancements (UK and US)
Overview
With this release, SAP Concur extends its Amazon Business Integration services to
the UK marketplace. As part of the update, you can now choose your marketplace,
block certain payment types, and decide who receives the shared pay transaction
details. For UK customers, SAP Concur also supports the inclusion of VAT receipts
along with expense details.
Business Purpose / Client Benefit
This update enables Amazon Business Integration support for the UK along with the
US customers.
Admin Experience
The admin can configure or edit certain options while connecting to Amazon
Business.
CHOOSING MARKETPLACE
The admins can now choose the marketplace while connecting to Amazon Business.
The option to choose the marketplace is available only for new customers. For
existing customers, the US marketplace is set by default.
NOTE: The admin can only connect to one marketplace at a time, either UK or US. To
connect to a different marketplace, the admin should disconnect from the
connected marketplace.
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Release Notes: Amazon Business Integration

CONFIGURING PAYMENT TYPES
Admins can block certain payment types from creating an expense entry in Concur
Expense.
For example, if the Pay by Invoice is moved to the Not Allowed payment
category, transactions made on the connected Amazon business site, where the
payment type is Pay by Invoice, will not be posted to Concur.
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Release Notes: Amazon Business Integration

ROUTING SHARED PAYMENT TRANSACTIONS TO ADMIN OR REQUISITIONER
Earlier, the shared payment transactions were posted to the Amazon Business
admin’s email address.
Now the admin can decide if the shared payment transactions should be routed to
the person who places the transaction or to the Amazon Business admin. They can
enable the Route transaction to admin for shared payments option to send the
transactions to the admin. If this option is disabled, the transaction will be posted to
the requisitioner (the person who places the transaction).
NOTE: For existing customers, the shared payment transactions are posted to the
Amazon Business admin’s email address and this setting is enabled by
default. Admins can change the setting if required.
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Release Notes: Exchange Rates

VAT Receipts Availability
For UK customers, tax information or Value-added Tax (VAT) details are required for
business expenses. Amazon now provides VAT receipts for all purchases made by UK
customers. These receipts will be attached to the Amazon Business expenses created
in Concur Expense.
NOTE: The VAT receipt from Amazon is only available for UK customers. For US
customers, an SAP Concur-generated receipt is attached with the expense
details.
Configuration / Feature Activation
The feature is automatically available; there are no additional configuration or
activation steps.



For more information, refer to the How to Enable Amazon Business via the
SAP Concur App Center Guide.

Exchange Rates
Foreign Exchange Rate Enhancements for Regulatory Compliance
Overview
SAP Concur Expense is providing a configuration option that allows the Expense
admin to set the foreign currency exchange rates to be assessed based on one of the
following three settings options:
•

Transaction Date (Default): Date the expense was incurred

•

Report Start Date: Trip start date as entered in the Report header

•

Report End Date: Trip end date as entered in the Report header

Once the setting is configured in Group Configurations it is the default for all Expense
users working within that group, for all reports that contain foreign currency
transactions, and cannot be changed by the user.
SAP Concur Release Notes
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USER EXPERIENCE
If the default Transaction Date setting is used, users under this option will not
notice any change in Concur Expense and exchange rates will continue to default
based on the date the expense transaction was incurred.
If either the Report Start Date or Report End Date option is selected for an
Expense Group, users will notice the following behavior:
Report Status
When the report is
being created

Behavior Based on Start or End Date Setting Configuration
• Once an impacted foreign currency transaction is added to the

report, a notification message is displayed to the user informing
them that the exchange rate is subject to change and will be
finalized on report submission

• The initial exchange rate for an expense will be based on the

transaction date
• Updating the Report Start Date or Report End Date value will

not result in real-time re-calculations of the exchange rate

When the report is
submitted

• Exchange rates are calculated and updated in the submit preview

screen, and reflected on the Report Totals page with that
process

• A notification will be displayed informing the user that the

exchange rates may change

After the report is
submitted

• Report will show the updated exchange rate and the result in the

Report Totals

No notifications will be displayed regarding the exchange rate
calculation basis.

EXCLUSIONS TO THESE CHANGES
The Group setting does not affect the behavior of the following transaction types
which use the default Transaction Date for foreign currency exchange rates:
•

Linked Credit Card transactions (Corporate or Personal)

•

Daily (fixed) Travel Allowance Expenses

•

Expenses without conversions

NOTE: Linked Credit Card transactions only covers transactions on credit cards that
are registered with Concur Expense for a specific user, with transaction
information that is passed electronically by the card provider to Concur
Expense. Manually entered expenses that are paid for with an unlinked credit
card will be subject to the Report Start Date or Report End Date date
basis rate calculation.
EFFECTIVE DATES FOR THIS CHANGE
The changes described in this release note took effect in two stages:
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•

Configuration Setting In Effect December 2nd: The Expense admin may
adjust this setting for all users in a group using the options in Group
Configurations

•

User Sees Change December 12th: The functional changes, including
updated messaging for the Report Start Date and Report End Date
settings, are in effect December 12th for all users working in a Group
configured to use the new settings

BUSINESS PURPOSE / CLIENT BENEFIT
Certain countries mandate that the exchange rate used for expense reporting is
based on a date choice defined in their federal regulatory rules. This enhancement to
Concur Expense provides configurable options to base this date on Report Start
Date, Report End Date or Transaction Date.
Configuration / Feature Activation
This feature requires configuration to take advantage of the new options. If no
configuration is performed the employees will see no changes to current behavior.
Use the procedure below to change from the default Transaction Date setting to an
alternative date choice.

 To configure Group Configuration for this setting:
1. Click Administration > Expense > Group Configurations.
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Release Notes: Japan Public Transport (JPT)
2. Click a group then click Modify to open Configuration for Group -

<Name>.

3. Scroll to Foreign currency exchange rate basis date and change the

configuration as required.

4. Click Save.

Japan Public Transport (JPT)
Round Trip Icon Added for Favorite Routes
Overview
Previously it was not possible to distinguish between a round trip and a one-way trip
in the Favorite Route section. In this release, a new icon is added to identify round
trips that are registered on favorite routes.
BUSINESS PURPOSE / CLIENT BENEFIT
This update will help enhance the user experience of the favorite route page.
What the User Sees
On the Favorite Routes page, the
SAP Concur Release Notes
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Configuration / Feature Activation
The feature is automatically available; there are no additional configuration or
activation steps.



For more information, refer to the Concur Expense: JPT on NextGen UI User
Guide.

Suica IC Card Integration
Overview
The IC Card Integration (ICCI) is an option provided by Japan Public Transport (JPT)
that integrates the Suica IC card by JR East with SAP Concur. This option enables
Concur Expense to draw all the trip transaction details directly from the railway
company’s source data. This integration eliminates the need for third-party card
readers and labor to scan IC cards.
Previously, third-party card readers were installed at fixed locations, and you needed
to go to the office in person to post transactions. IC cards could only store 20
transaction details, and regular office visits were required to preserve the journey
history and not have to manually recreate the expenses.
NOTE: This service is only available for employees of companies that are based in
Japan.
BUSINESS PURPOSE / CLIENT BENEFIT
This feature ensures seamless integration and enhanced user experience for clients
using IC cards for travel in Japan.
Configuration / Feature Activation
To enable this feature, contact SAP Concur support.
SAP Concur Release Notes
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For more information, refer to the Concur Expense: Japan IC Card Integration
for Suica User Guide.

Receipts
Drag and Drop Multiple Receipts to Expense
Overview
With this release, users adding receipts to their expense reports may now drag and
drop one or more receipts when performing this action.
The following areas within Expense are now updated to support this feature:
•

Available Receipts - Expense home page: Move selected files directly
from a folder on the computer to the Available Receipts section of the home
page of Expense.

SAP Concur Release Notes
Release Date: December 17, 2022
Initial Post: December 9, 2022

Page 9

Concur Expense Professional / Premium
Client DRAFT

Release Notes: Receipts
•

Attach Receipt pop-up Window: Move selected files directly from a folder
on the computer to the Attach Receipt section by clicking the Receipt
column icon associated with the expense entry.

•

Inside an opened expense: With a single expense open, the user can move
the selected files directly from a folder on the computer to the expense’s
receipt window.
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Release Notes: SAP/SAP Concur Integrations
BUSINESS PURPOSE / CLIENT BENEFIT
These changes improve the user experience in Concur Expense.
Configuration / Feature Activation
The feature is automatically available; there are no additional configuration or
activation steps.

SAP/SAP Concur Integrations
**Ongoing** SAP Integration with Concur Solutions (ICS) for SAP
ECC and SAP S/4HANA On-Premise Required Authentication Update
(March 2022)
Information First Published

Information Last Modified

Cutoff Date

Nov 2022

N/A

Dec 31, 2023

Any changes since the previous monthly release are highlighted in yellow in this release note.

Overview
SAP ICS customers are using two different authentication methods:
•

Legacy authentication (without gateway)

•

New gateway authentication based on Company JSON Web Token (JWT)

SAP Concur has now consolidated the different methods into one target method: the
new gateway authentication based on the company JWT (aka Oauth2.0). Currently,
we are using both, the old user and password-based legacy authentication for most
of the API calls and a company JWT-based authentication via the API gateway for
some dedicated APIs.
To ensure there's no disruption for connections between SAP ECC or SAP S/4HANA
on-premise and SAP Concur, we have defined a transition period that allows a
transformation from legacy authentication to company JWT-based authentication at
your own pace. All customers must be using the company JWT-based authentication
by December 31, 2023. After December 31, 2023, the legacy authentication will stop
working.
You must enable your SAP ECC or SAP S/4HANA on-premise system to perform this
transformation, including updating to a supported release/support package if
necessary. Please refer to the following information for details about supported
releases/support packages and configuration steps:
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•

SAP Note 2914977 - FAQ: Concur Certificates, Authentication, and
Connectivity
NOTE: All customers should sign up for the ICS newsletter following the
instructions in this note.

•

Knowledge base Article 3079239 - Connection: Transformation to New
Gateway

•

Knowledge base Article 3097704 - SAP ICS: Transformation to New Gateway
is Failing

Production Sandbox Environments
Customers with Production Sandbox Environment (PSE) entities that are using legacy
authentication with ICS will need to perform maintenance to their authentication
information ASAP to continue using ICS. Customers using the company JWT-based
authentication are exempt from this maintenance.



For more information, refer to the **Ongoing** Production Sandbox
Environment Login Updates release note in the SAP Concur Shared Changes
Release Notes.

BUSINESS PURPOSE / CLIENT BENEFIT
This authentication update provides improved security over the legacy authentication
method.
Configuration / Feature Activation
Please refer to the latest SAP Integration with Concur Solutions newsletter for more
information about the configuration process:
SAP Integration with SAP Concur Solutions Edition 2202 10.pdf
If you don´t have access to the JAM Page, send an email with the subject “Jam
Access” to sapconcurintegration@sap.com.

User Interface Changes
Miscellaneous Changes to the User Interface
Overview
The following minor usability changes are part of the ongoing continuous
improvement process for the user experience:
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Release Notes: User Interface Changes
•

Report Title Page: Improvements include replacing the original Trash icon
with the Delete Report button and adding the report’s number, which may
be clicked directly to open the report header

•

Expense Entry Page: The trash icon is now replaced with the Delete
Expense button.
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Release Notes: User Interface Changes
•

Itemizations: The trash icon is now replaced with the Delete Expense
button.

BUSINESS PURPOSE / CLIENT BENEFIT
These changes improve the user experience in Concur Expense.
Configuration / Feature Activation
The feature is automatically available; there are no additional configuration or
activation steps.
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Planned Changes: ExpensePay Payment Provider Rebranding

Planned Changes
The items in this section are targeted for future releases. SAP Concur reserves the
right to postpone implementation of – or completely remove – any
enhancement/change mentioned here.
NOTE: The planned changes listed in this document are specific to this product. For
information about planned site-wide or shared changes that might impact
your SAP Concur solutions, refer to the Shared Changes Release Notes.

ExpensePay Payment Provider Rebranding
**Planned Changes** Bambora Rebranding to Worldline
Information First Published
Information Last Modified
Feature Target Release Date
November 2022
-January 2023
Any changes since the previous monthly release are highlighted in yellow in this release note.

Overview
Digital payments provider Worldline acquired Bambora in 2021. Instances of
Bambora in the Expense Pay, Global Pay, and Payment Manger screens will be
updated accordingly to support the rebrand to Worldline.
BUSINESS PURPOSE / CLIENT BENEFIT
To support SAP Concur’s payment processing partner Wordline, the Expense Pay,
Global Pay, and Payment Manager user interfaces and documentation will be updated
to reflect the rebranded company name.
User Experience
User interface components such as labels, email addresses, logos and notifications
that show Bambora will be renamed to Worldline over the next few months.
Configuration / Feature Activation
The feature will be automatically available; there are no configuration or activation
steps.

**Planned Changes** Western Union Business Solutions
Rebranding to Convera
Information First Published
Information Last Modified
Feature Target Release Date
October 2022
-January 2023
Any changes since the previous monthly release are highlighted in yellow in this release note.
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Planned Changes: ExpensePay Payment Provider Rebranding
Overview
Expense Pay payment provider Western Union Business Solutions (WUBS) was
acquired in 2021. They have now officially rebranded as Convera.
BUSINESS PURPOSE / CLIENT BENEFIT
To support SAP Concur’s payment processing partner Convera, the Expense Pay,
Global Pay, and Payment Manager user interfaces and documentation will be updated
to reflect the most current rebranded name.
User Experience
User interface components such as labels, messages, and documentation that show
Western Union or Western Union Business Solutions will be now display Convera.
Configuration / Feature Activation
The change will be automatically available; there are no configuration or activation
steps.
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Client Notifications: Accessibility

Client Notifications
Accessibility
Accessibility Updates
SAP implements changes to better meet current Web Content Accessibility Guidelines
(WCAG). Information about accessibility-related changes made to SAP Concur
solutions is published on a quarterly basis. You can review the quarterly updates on
the Accessibility Updates page.

Subprocessors
SAP Concur Non-Affiliated Subprocessors
The list of non-affiliated subprocessors is available from the SAP Sub-processors /
Data Transfer Factsheets page.

 To access the SAP Concur Sub-processors List:
1. Click the following link to navigate to the SAP Sub-processors / Data Transfer

Factsheets page:
SAP Sub-processors / Data Transfer Factsheets
2. Sign in to the SAP Support Portal using your Support User ID (S-user) and

password.
NOTE: SAP customers must sign in to the SAP Support Portal using their
Support User ID (S-user) and password. For information about S-User
IDs, refer to Your New Support User ID (S-user).
3. On the SAP Sub-processors / Data Transfer Factsheets page, type "Concur" in

the Search field.
4. In the Title column, click SAP Concur Sub-processors List.

If you have questions or comments, please reach out to: PrivacyRequest@Concur.com
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Client Notifications: Supported Browsers

Supported Browsers
Supported Browsers and Changes to Support
For information about supported browsers and planned changes to supported
browsers, refer to the Concur Travel & Expense Supported Configurations guide.
When changes to browser support are planned, information about those changes will
also appear in the Shared Changes Release Notes.
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Additional Release Notes and Other Technical Documentation: Online Help

Additional Release Notes and Other Technical
Documentation
Online Help
You can access release notes, setup guides, user guides, admin summaries,
supported configurations, and other resources via the in-product Help menu or on
the SAP Help Portal.
To access the full set of documentation for your product, use the links in the SAP
Concur Help menu, or search for your SAP Concur product (Concur Expense, Concur
Invoice, Concur Request, or Concur Travel) on the SAP Help Portal
(https://help.sap.com).

SAP Concur Support Portal – Selected Users
Access release notes, webinars, and other technical documentation on the SAP
Concur support portal.
If you have the required permissions, Contact Support is available on the SAP
Concur Help menu and in the SAP Concur page footer.

Click Contact Support to access the SAP Concur support portal, then click
Resources.
•

Click Release/Tech Info for release notes, technical documents, etc.

•

Click Webinars for recorded and live webinars.
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Cases: Check Support Case Status

Cases
Check Support Case Status
The steps in this procedure provide instructions for checking whether a case is
resolved.

 To check the status of a submitted case
1. Log on to https://concursolutions.com/portal.asp.
2. Click Help > Contact Support.

NOTE: If you do not have the option to contact SAP Concur support under the Help
menu, then your company has chosen to support the SAP Concur service
internally. Please contact your internal support desk for assistance.
3. Click Support > View Cases.
4. In the table, view the desired type of cases based on the View list selection.

Search results are limited to each company's own cases.

SAP Concur Release Notes
Release Date: December 17, 2022
Initial Post: December 9, 2022

Page 20

Concur Expense Professional / Premium
Client DRAFT

© 2022 SAP SE or an SAP affiliate company. All rights
reserved.
No part of this publication may be reproduced or transmitted in any form or for any
purpose without the express permission of SAP SE or an SAP affiliate company.
SAP and other SAP products and services mentioned herein as well as their
respective logos are trademarks or registered trademarks of SAP SE (or an SAP
affiliate company) in Germany and other countries. Please see
http://global12.sap.com/corporate-en/legal/copyright/index.epx for additional
trademark information and notices.
Some software products marketed by SAP SE and its distributors contain proprietary
software components of other software vendors.
National product specifications may vary.
These materials are provided by SAP SE or an SAP affiliate company for
informational purposes only, without representation or warranty of any kind, and
SAP SE or its affiliated companies shall not be liable for errors or omissions with
respect to the materials. The only warranties for SAP SE or SAP affiliate company
products and services are those that are set forth in the express warranty
statements accompanying such products and services, if any. Nothing herein should
be construed as constituting an additional warranty.
In particular, SAP SE or its affiliated companies have no obligation to pursue any
course of business outlined in this document or any related presentation, or to
develop or release any functionality mentioned therein. This document, or any
related presentation, and SAP SE’s or its affiliated companies’ strategy and possible
future developments, products, and/or platform directions and functionality are all
subject to change and may be changed by SAP SE or its affiliated companies at any
time for any reason without notice. The information in this document is not a
commitment, promise, or legal obligation to deliver any material, code, or
functionality. All forward-looking statements are subject to various risks and
uncertainties that could cause actual results to differ materially from expectations.
Readers are cautioned not to place undue reliance on these forward-looking
statements, which speak only as of their dates, and they should not be relied upon in
making purchasing decisions.
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